<table>
<thead>
<tr>
<th>Title</th>
<th>Advanced quark xpress for newspapers : 13-15 March 1995, Singapore : [contents]</th>
</tr>
</thead>
<tbody>
<tr>
<td>Author(s)</td>
<td></td>
</tr>
<tr>
<td>Citation</td>
<td></td>
</tr>
<tr>
<td>Date</td>
<td>1995</td>
</tr>
<tr>
<td>URL</td>
<td><a href="http://hdl.handle.net/10220/1234">http://hdl.handle.net/10220/1234</a></td>
</tr>
<tr>
<td>Rights</td>
<td></td>
</tr>
</tbody>
</table>
AMIC-IFRA ADVANCED QUARK XPRESS TUTORIAL FOR NEWSPAPERS, SINGAPORE, MAR 13-15, 1995
This document provides background information for the course and helps with any demo software used during the tutorial.
WORKSHOP

ADVANCED Quark for Newspapers

Guided by Tim Judd

13 - 15 March 1995
Singapore
<table>
<thead>
<tr>
<th>Monday 13th</th>
<th>Tuesday 14th</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.00-9.30 Registration</td>
<td>9.00-9.30 Page Dummying Basics</td>
</tr>
<tr>
<td>9.30-10.00 Registration</td>
<td>9.30-10.00 Advanced Page Dummy</td>
</tr>
<tr>
<td>10.00-10.30 Introduction Aims and</td>
<td>10.00-10.30 Get Text</td>
</tr>
<tr>
<td>10.30-11.00 Preferences / Serevrs</td>
<td>10.30-11.00 Advanced text</td>
</tr>
<tr>
<td>11.00-11.30 Libraries</td>
<td>11.00-11.30 Get Picture</td>
</tr>
<tr>
<td>11.30-12.00 Tools and Automation</td>
<td>11.30-12.00 Advanced Picture Handling</td>
</tr>
<tr>
<td>12.00-12.30 Tools and Automation</td>
<td>12.00-12.30 OPI what is it and perils</td>
</tr>
<tr>
<td>12.30-1.00 Lunch</td>
<td>12.30-1.00 Lunch</td>
</tr>
<tr>
<td>1.00-1.30 Lunch</td>
<td>1.00-1.30 Lunch</td>
</tr>
<tr>
<td>1.30-2.00 Lunch</td>
<td>1.30-2.00 Lunch</td>
</tr>
<tr>
<td>2.00-2.30 Tools and Automation</td>
<td>2.00-2.30 Zones and Editions</td>
</tr>
<tr>
<td>2.30-3.00 Design Basics</td>
<td>2.30-3.00 Zones and Editions</td>
</tr>
<tr>
<td>3.00-3.30 Basic Style Sheets</td>
<td>3.00-3.30 Stocks and Sports</td>
</tr>
<tr>
<td>3.30-4.00 Basic Masterpages</td>
<td>3.30-4.00 Stocks and Sports</td>
</tr>
<tr>
<td>4.00-4.30 Control Master Pages</td>
<td>4.00-4.30 Stocks and Sports</td>
</tr>
<tr>
<td>4.30-5.00 Control Libraries</td>
<td>4.30-5.00 H&amp;J Advanced Style Sheets</td>
</tr>
</tbody>
</table>
**Wednesday 15th**

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.00-9.30</td>
<td>Xtensions</td>
</tr>
<tr>
<td>9.30-10.00</td>
<td>Xtensions</td>
</tr>
<tr>
<td>10.00-10.30</td>
<td>Basic Colour Handling</td>
</tr>
<tr>
<td>10.30-11.00</td>
<td>More Colour</td>
</tr>
<tr>
<td>11.00-11.30</td>
<td>Libraries</td>
</tr>
<tr>
<td>11.30-12.00</td>
<td>Proof and Output</td>
</tr>
<tr>
<td>12.00-12.30</td>
<td>Focus Session</td>
</tr>
<tr>
<td>12.30-1.00</td>
<td>Focus Session</td>
</tr>
<tr>
<td>1.00-1.30</td>
<td>Lunch</td>
</tr>
<tr>
<td>1.30-2.00</td>
<td>Lunch</td>
</tr>
</tbody>
</table>
Welcome

The focus for the course

Technique

Implementation

Integration
Technique

Not just tips and tricks ..... Using Quark in a productive way. We focus on what is useful in our business.

Implementation......

Taking what we cover in this course into production.

Integration...........

Quark is more of a platform than a solution in its own right. How does it all together.
What's new in 3.3.....
is it of any use for newspapers

Variable shaped text boxes
Draw a text box

Item Tool  Select Box shape this gives a choice of polygon shapes.

Or select reshape polygon to pull handles
Or add additional handles by hold down the
command key and click.

Auto import of EPS Spot Colour

Spot colour specified in a graphics program are automatically added to the
palette.
Using get picture open the EPS file 'Spot Colours' from your samples baske and look at the Quark colours palette. You will see the other colours added your palette.

Multiple item delete undo
At last you can delete multiple items and undo those changes.

Two character tab leaders
In the tabs menu you can now specify two character leaders or fill character

JPEG Import
JPEG and PC equivalent PCX files will now import without decompression.

OPI 1.3 Compatibility
Interactive Text Resizing

Hold down the command key and drag a text box, the text stretches as the I changes shape.
Hold down the Command Option Shift and the text scales in proportion.

The XTensions that come with the Latest Quark

Notes

This allows users to put notes within a story. Access it through the utilities menu.
Jabberwocky


Bobzilla

Pop and Go
Allows you to navigate through pages. Click and hold on the page indicator marker on the left choose your page and let go.

Line Checking
Access under utilities, this allows you to search for occurrences of problem such as Loose lines, Widows orphans etc.

Full Resolution Tiff
Select a picture and modify under the item tool. This allows you to print images at a sharper resolution
Star Burst
This adds a star burst tool to the tool bar, control it by double clicking on the tool.

Custom Under lines
Access through the edit menu and applied through styles allows you more control over the thickness and style of underlines.

Other Less Useful XTs

Page Maker Import
Quark Print
Quark Presents
Quick Time
Preferences and Servers

The Basics

The Network

Nothing we look at is in isolation. You must be able to share files with other users. Even if you have never looked at the network before let's do a few basic things.

What network are you on?

Ethernet or local talk.
Go to the chooser .....can you see anything under networks or Servers. If no check under the control panels to make sure that you have the right network protocol system.

Is File sharing turned on?
Go to the control panels and turn file sharing on.
Create a folder on your machine top level
Select sharing from the file menu and share the folder.

In Users and groups disable appropriate functions such as see entire disc and make changes to specify what sort of access you want to have for the folder.

What's in the Quark Folder

The XTensions folder
Anything in this (or the main Quark folder) will load on Quark boot.

Other XTensions
This contains inactive XTensions. To load and unload XTensions simply switch XTensions between these and restart Quark.

Make an alias for your Quark and put it in the apple menus folder in the system. You can duplicate and reconfigure various Quark sessions (one for editorial, one for advertising for e.g.) and easily switch them on and off through the Apple menu.
Create a folder which you will share with others.

If it is to contain items which you want shared but locked make sure that the folder is locked.

Working From a Server

In order to maintain fidelity and ensure that the right version of a page gets published you should all work from a server.

Advantages....
Pages are locked whilst in use.
Anyone can find your work if you go ill.
Pages ready for print can be separated from those in progress.
Simple and cost effective control of page progress.
Drawbacks
Slow speed to save and down load docs.
Heavy traffic drops speed even more.....so
People Cheat and work locally, then all bets are off.

One good solution.
ROpenXT
This new neat and cheap bit of software lets you Get a file under the utilities menu and put it back when you have finished. You work locally but the file locked on the server. You can even create a new remote file without ever singing on your machine.

Let's run a quick ROpenXT session.

Whilst still on the subject of file management open file hunter. This is like a much enhanced finder search combined with something like words finder, a once the file has been found it can be click imported simple.
Basic Quark Preferences.

Networked Quark.....how does it work.

XTLoad.....what does it do and how can I beat it?

So if you want to control the preferences on a global basis and you have a worked Quark version then set one master and then redistribute.

Most parameters can be locked in at an application level....so do it. Any parameter not set on a document will be over ridden by the application.

Let’s start by designing a basic master template
The first big issue..... margins or not?

How do you work...what does the print department want and what do you need in terms of registration marks etc. Let's put margins on for the time being. It should be enough. Experiment with guide colours etc. till you are happy. Note and save the document.

Now without the document open lets go through the prefs in turn and sort our defaults.

Now any document created will automatically take on these attributes. Existing documents will not.

We can automate the procedure simply using Quick keys one for each parameter or strung together.

Now set the defaults for the tool bar, again without any document open.
Now let's open our existing document and add some 'mechanical' furniture to make it more familiar to more traditional users.

Now save that document as your master template.

Are you clear on making changes to that template and the differences between documents and templates. Open it and make some change to prove that.

Libraries

What are libraries?

Did you know that they are really only Quark documents in disguise.

Create a new library. It will only be saved when you quit Quark, so if you are doing a lot of library building have auto save selected from the application preferences.....or you will be sorry.
We need to share libraries, let’s go back to the network. Open one of the standard libraries you can see there.

You only have a local copy, the original is intact and can’t be added to or amended.

First create a library. Each library can contain up to 2000 items!

I don’t recommend it. Much past 20-30 you will find it gets slow and unrelia

Are you familiar with naming library objects. Practice show all / show un labelled

Did you know about dragging between libraries. Create another Library and give it go.

On your standard layout create a full page design with text and picture box

Now group the object. Apple A, Apple G

Now select the object and drag it into the library. You will not be able to do
if it contains links to objects outside the selected area.

Now clear the page.

Now drag the object back from the library.

Position it by specifying 10,0 (or whatever) as the X,Y off set.

This technique lets you store and place entire pages as one lib object and put them back on the page at the right place.

Now share your library by putting it in your shared folder.

One irritation is that grouped objects are frozen and can not be resized as a group, only individual components, we will look at solutions to this later but for the time being you will need to ungroup and re-group.

Do you want gutter rules on your story? Experiment with lines and frames. Then store your object.
Tools and Automation

There is only so much you can do with standard Quark Quick keys

The first 91 short cuts hurt the most.

You must know

Select All    C A
Border       C B
Copy         C C
Duplicate    C D
Get Text     C E
Find/Change  C F
Group        C G
Suggested    C H
Show Invisible C I
Go to Page   C J
Delete       C K
So let's look at some of the main ones....you should know most of these by heart and the * ones in your sleep.

**Basic Type Styles**

<table>
<thead>
<tr>
<th>Style</th>
<th>C</th>
<th>S</th>
<th>P</th>
<th>B</th>
<th>I</th>
<th>U</th>
<th>W</th>
<th>Q</th>
<th>O</th>
<th>S</th>
<th>K</th>
<th>H</th>
<th>Plus</th>
<th>Hyphen</th>
<th>V</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plain</td>
<td>C</td>
<td>S</td>
<td>P*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Bold</td>
<td>C</td>
<td>S</td>
<td>B*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Italic</td>
<td>C</td>
<td>S</td>
<td>I*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Underline</td>
<td>C</td>
<td>S</td>
<td>U*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word Underline</td>
<td>C</td>
<td>S</td>
<td>W</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Strike Thru</td>
<td>C</td>
<td>S</td>
<td>Q</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Outline</td>
<td>C</td>
<td>S</td>
<td>O</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shadow</td>
<td>C</td>
<td>S</td>
<td>S</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>All Caps</td>
<td>C</td>
<td>S</td>
<td>K</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Small Caps</td>
<td>C</td>
<td>S</td>
<td>H</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Super Script</td>
<td>C</td>
<td>S</td>
<td>Plus</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Sub Script</td>
<td>C</td>
<td>S</td>
<td>Hyphen</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Superior</td>
<td>C</td>
<td>S</td>
<td>V</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Alignment

<table>
<thead>
<tr>
<th></th>
<th>C</th>
<th>S</th>
<th>L*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Right</td>
<td></td>
<td></td>
<td>R*</td>
</tr>
<tr>
<td>Centred</td>
<td></td>
<td></td>
<td>C*</td>
</tr>
<tr>
<td>Justified</td>
<td></td>
<td></td>
<td>J*</td>
</tr>
<tr>
<td>Force</td>
<td></td>
<td></td>
<td>O</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>J</td>
</tr>
</tbody>
</table>

### Point size

<table>
<thead>
<tr>
<th></th>
<th>C</th>
<th>S</th>
<th>&gt;</th>
<th>&lt;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

One point increments and reversed (<) for down

### Character parameters

<table>
<thead>
<tr>
<th></th>
<th>C</th>
<th>S</th>
<th>D*</th>
</tr>
</thead>
</table>

### Format parameters

<table>
<thead>
<tr>
<th></th>
<th>C</th>
<th>S</th>
<th>F*</th>
</tr>
</thead>
</table>

### Copy paragraph formats

<table>
<thead>
<tr>
<th></th>
<th>O</th>
<th>S</th>
<th>Click</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rules</td>
<td>C</td>
<td>S</td>
<td>N*</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------</td>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>Tabs info</td>
<td>C</td>
<td>S</td>
<td>T*</td>
</tr>
<tr>
<td>Remove all tabs</td>
<td>O</td>
<td>Click on tab ruler</td>
<td></td>
</tr>
<tr>
<td>Kerning / Tracking</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Increase 10/200 em</td>
<td>C</td>
<td>S</td>
<td>}*</td>
</tr>
<tr>
<td>Increase by 1/200 em</td>
<td>C</td>
<td>S</td>
<td>O</td>
</tr>
<tr>
<td>Decrease 10/200 em</td>
<td>C</td>
<td>S</td>
<td>{*}</td>
</tr>
<tr>
<td>Decrease by 1/2000 em</td>
<td>C</td>
<td>S</td>
<td>O</td>
</tr>
<tr>
<td>Leading</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Show custom leading</td>
<td>C</td>
<td>S</td>
<td>E</td>
</tr>
<tr>
<td>Increase by one point</td>
<td>C</td>
<td>S</td>
<td>&quot;*</td>
</tr>
<tr>
<td>Increase by 1/10 point</td>
<td>C</td>
<td>S</td>
<td>O</td>
</tr>
<tr>
<td>Decrease by one point</td>
<td>C</td>
<td>S</td>
<td>Colon*</td>
</tr>
<tr>
<td>Decrease by 1/10 point</td>
<td>C</td>
<td>S</td>
<td>O</td>
</tr>
</tbody>
</table>
Base Line Shift

Up one point     C O S +
Down one point   C O S Hyphen

Selecting Text

Word              2 clicks
line              3 clicks
Paragraph         4 clicks
Linked story      5 clicks

Working with Items

Open modify box   2 clicks
Activate hidden item C O S Click on overlap
Bring Item to front F5
Send Item to back  S F5
Send back one layer S O F5
Lock / Unlock     F6
Working with Pictures

| Centre in box | C | S | M |
| Fit in box    | C | S | F |
| Fit in box maintain a/r | C | S | O | F |

Scaling Pictures

| Increase 5% | C | S | O | > |
| Decrease 5% | C | S | O | < |

Moving picture around inside box

| Left / Right 1 point | Left/ Right Arrows |
| Left / Right 1/10 point | O  Left/ Right Arrows |
| Up / Down 1 point     | Up/ Down Arrows |
| Up / Down 1/10 point  | O  Up/ Down Arrows |
Resizing Pictures

Constrain box shape
Maintain a/r
Scale box and Pfc
Scale IC cons box
Scale IC maintain a/r
of both pic and box

S Drag
O S Drag
C Drag
C S Drag
C S O Drag
Mechanising Text Box Sizing

Start recording a quick key

Select Option M

Tab through to the right measurement

Enter correct value

Save Quick Key

Duplicate and rename Quick key changing value

Do the same for wrap on column

Now build quick keys to add or subtract one line and 10 lines.

Do you want keys to define common depths. Now map your new keys to key overlay.
So Are there any tools to make this easier?

Kitchen Sink

One of the best XTensions yet written.

For those who can't remember short cuts this one is for you!

Co Pilot

Very useful for large documents.
Design Basics

It's more than likely that rather than designing you will be executing an existing design within Quark.

Don't guess......
get the type styles and design specifications from the original designers.

If you have a design executed on a 'traditional system' don't try to figure out what the formats on that system do.

Get the type styles as far as possible and measure them then keep testing for look and feel.

Don't befooled into using strange variables such as space band values.
between two different systems. Do what looks right.

If you are trying to match an existing look then get hold of the matching font.

If you want to match exactly tune the AFM table to match the CAWT on the existing system.

Buy high quality fonts from a recognised font vendor.

Buy type 1 adobe hinted fonts.

Scaling and compressing fonts much beyond their original specifications unless used for dramatic effect) will make you paper hard to read.

Control the use of fonts.

Restrict Access to fonts

Be brutal.
To grid or not to grid.

Going non gridded has advantages, it’s easier to get copy onto the page and handle that copy. But it tends to leave unfortunate gaps and tends to look amateur.

Gridding is harder to do but looks better.

The descender Problem........

Drop initials

A nice touch and cheap trick

Applying a drop initial gives a default gap between the first and second chapters. You might want to open this up a bit. Use C, S, O to adjust this. The news is that this change can’t be saved in a style sheet.
The Run Round Drop initial.

To run copy around the shape of a Drop Initial, for e.g. up to an A do the following.

Create a normal piece of text the same size as the required drop with no run around value.

Now make a polygon mask the to fit the shape with a small run around.

Use the polygon to displace the copy in the story.

Now position the letter inside the mask and check alignment.....Definitely a job to be stored in a library

Designing with Style Sheets.

First work out the names of the styles you are going to use and figure out a coherent naming system. Spend some time over this since these will be used by people who may not have your expertise of knowledge. Be logical.
Making Style Sheets.

It's always easier to make the copy look good on the page then select over the copy and create a style sheet rather than attempting to dial in the values (you will get them wrong).

Use duplicate to copy styles and rename then change a minor parameter.

Or create a style 'based on' another existing style again modifying parameters.

Don't (routinely) use the next style option. This should be set to be the same as the previous style. If you don't do this if you start typing after an applied style your new copy will take on the appearance of the ‘Next Style’ chosen.

Use the key pad assign a key to the style. You can use C,S,O,Ctrl and the keypad or Fkeys. Make sure that you are not over lapping other Quick keys you have written. (Quick keys will win).
Edit Append styles

When creating new templates you must add to them the styles already in use by the publication. To do this simply use the edit append feature in edit style sheets. This will let you pick up all the styles from another style sheet in one go. It is very good practice to have all of the master styles on a readily accessible style sheet so that if people must create their own pages then at least the styles are consistent.

Now build a series of styles and link them to Keyboard short cuts.

Apply them through the pull down menu. (Slow and cumbersome)

The style sheets window. (Gets in the way but does show the short cuts)

The keyboard. By far the best approach fast and easy (if your structure is coherent).
Master Pages

It really isn't that difficult, but people always struggle with this feature.

What do they allow you to do.

A master page can contain any kind of text picture rule or guide used in a normal page. The difference is that these features can be dropped all at once or any given page.

You can have a large number of these pages. They can have differing value for everything except page size and base line grid value.

Using the show document layout window select the master page. Now copy and paste objects you want on that master from your document.

Create several master pages with the same objects by duplicating the origin. Re-name them as you go.
On each master page make changes such as the number of columns and the size of the various guides.

Make your various master pages 2,3,4 col add rules etc.

You can add more pages by simply dragging more to the document layout window and or using the insert pages command.

You can view several pages side by side typically 3 or 4 depending on their width.

Set The zero point where you wish.

Insert guides on the page.

Insert non printing locked lines or areas.

Make sure that you have the column count in if you intend to use it.

Set automatic page numbers if you wish C+3.
More options through Libraries

Shared master libraries and templates are your most important control mechanisms. But you must control who has access to them and who makes changes to them. They should always be locked and read only except to system managers.

Put as much as possible into standing objects in the libraries, include colour components and standing graphic components.

Apply style sheets to linked containers so that when copy flow in it takes up the style of the containers.
Enhanced Master Pages

There are XTensions which allow you to create and manage a wide variety of different page sizes. This can be useful when dealing with a variety of page parameters and recalcitrant designers.

File Manager XTension

Two Key features
The ability to build and maintain a customised library of page start sizes. This can be created and maintained specifying margins sizes etc. This is especially useful if the Quark defaults for the application have been set so as to contain all of the type styles which are required for your publication.
Controlling Through Libraries

The use of master Libraries which are shared through a server structure is key to controlling the rapid design of pages.

Put as much as possible into the library objects, including all colour objects and standing graphics.

Enhanced Master Pages

Complex Page Creation Option

Using XTension File Manager.

First make sure that all the styles etc. are built in as Quark Application defaults.

Page Manager Gives a wide range of sizes as defaults.

Add your own to this through the edit module set options.
Document Manager
Allows you to create a header for files reflecting their status who has them what's etc.

It then lets you search for them on the network either on a specific folder or a wider basis.

Estimating Story Length

A part of the design process involves knowing how much copy is going to fit the spaces. Let's look at LineCount as a way of finding this out.
The Add list. A Paper print out of add booking showing info of ad size position colour etc.

Manually lay that out on the page using a library of standard add sizes.

Create a library or use Quick keys to size them.

Now use Get Picture.
Slightly more sophisticated approach.

As above but use an import tool to get the graphics for you when they are ready. The artwork should be supplied as ss EPSF files.

Use the import Utility.

Advanced Page Dummying

A can demo of Ad director illustrates the most advanced standard dummyin packages.
Get Text

Standard text handling using normal Quark Text import filters.

Using @: Styling to make Quark read incoming text flags.

Key XTensions to make life easy.

Overset

Editor

Line Count To allow you to estimate a size reservation
Advanced Get Text

XTags to allow complex file import translation.

Create a new folder in Prefs folder.

Make that XTags

Create a file using Teach Text. Xtags.cnv

now you can translate anything to anything (256 either way)
Decimal, Binary and Hex.

Complex Import Strategies

MEXT

Copy Flow Xtension

Multi-User Strategy
Get Picture

Let's go over the picture handling short cuts again.

Working with Pictures
- Centre in box: C
- Fit in box: S
- Fit in box maintain a/r: M

Scaling Pictures
- Increase 5%: O
- Decrease 5%: O
Moving picture around inside box

<table>
<thead>
<tr>
<th>Action</th>
<th>Arrows</th>
</tr>
</thead>
<tbody>
<tr>
<td>Left / Right 1 point</td>
<td>Left/ Right Arrows</td>
</tr>
<tr>
<td>Left / Right 1/10 point</td>
<td>O Left/ Right Arrows</td>
</tr>
<tr>
<td>Up / Down 1 point</td>
<td>Up/ Down Arrows</td>
</tr>
<tr>
<td>Up / Down 1/10 point</td>
<td>O Up/ Down Arrows</td>
</tr>
</tbody>
</table>

Resizing Pictures

<table>
<thead>
<tr>
<th>Action</th>
<th>Actions</th>
</tr>
</thead>
<tbody>
<tr>
<td>Constrain box shape</td>
<td>S Drag</td>
</tr>
<tr>
<td>Maintain a/r</td>
<td>O S Drag</td>
</tr>
<tr>
<td>Scale box and Pfc</td>
<td>C Drag</td>
</tr>
<tr>
<td>Scale IC cons box</td>
<td>C S Drag</td>
</tr>
<tr>
<td>Scale IC maintain a/r of both pic and box</td>
<td>C S O Drag</td>
</tr>
</tbody>
</table>
Where do pictures come from and what tolerance do we have?

What happens if we mess with the resolution.

Should we even care about things like resolution and screen angles.

Picture management approaches

Design pages have different options from News Pages.

Let's look at some solutions which work.
DCS

What is it how does it works. It puts the load onto the Macintosh.

Scitex APR Style

In this case the high resolution images are handled by the Colour Imager.

OPI

In this case the swap occurs on a separate server. Typically these are UNIX boxes.
Important points

Separate your high and low resolution networks.

Clarify the tolerances allowed in design.

Ensure that you do all this in conjunction with the print department.

Automation options for Picture import using Picture Manager, import Xtensi Copy Flow MEXT etc.
Zones and Editions

Let's look at page sections and numbering.

What is the concept of zones and editions

What are the problems.

What are the simplest solutions using only basic file management.

Start with the ad stack. Are they different or the same between differing zones and editions
One idea

Produce a master page and a version of it and swap the adds around accordingly. This is simple and can be quite effective but can lead to a confusing array of similar page editions.

Use a high power ad dummy Xtension to generate different add stacks and positions. A more robust solution to the same problem.

Persisting problems

If two editions using the same stories in similar layouts who is in charge.
Stocks and Sports

Everyone hates this area. Tabbing in Quark is dreadful.

You can buy the data pre cooked ready to put on the page but it tends to be expensive and There are XTS which help a bit.

The questions are.

Where does my data come from.

Can I get to it.

Is it in a useful form.....if not can I pre-cook it on a server.
If I can't improve it on a server can I improve it on the Mac via XTags.

How long do I have.

Start with the design and layout you want to achieve.

Then get the raw data and flow it in.

Now add rough tabs.

If it doesn’t all fit truncate the data or change/reduce the point size or find room!

Now fine tune the tabs so that they fit in all circumstances and look nice.

Now Save that style.

The next time you import the data either call it through an @ command or see it all and apply.....then tidy up.
Use flags on the incoming data stream to add style tags or commands such as \textit{\textbf{\texttt{\textbackslash b}}\textit{\textbf{\texttt{\textbackslash b}}}} for next box. Use XTags to substitute markers for Quark commands.

You will be amazed at how much you can achieve without recourse to additional expense.

You could use one of several XTs which help a little ..... look at Table works.
H&J Advanced Style Sheets

What do h&j's control and how do we get at them.

What do each of the values mean and what happens if we change them.

How do we add these values to style sheets.

They should be added to the system defaults on day one and must be on all style sheets.

You can edit append if you wish in just the same way as other styles. Do the h&j's first then do the styles.

Xceptions dictionaries, how do we add to them and how does that help us.
Alternate H&J Engines

There are problems with Quark H&J and you might like to look at a better option. Let's look at DiHyph.

Colour Management

You can not do this on your own. You must work with the process and print departments. They are not your enemies, if you alienate them they have the ability to stop your progress.

Colour in newspapers more so than in most print environments is about what the presses are able to reproduce not what you think looks nice on screen.

You must design and use colour which works well on your press and paper. The only people who can help you here are the press department.
EFI Colour and other device independant systems are for the most part inappropriate and will help you little.

**Half tone colour.**

Typically this is controlled by the picture desk or process department. They scan and process colour leaving you with just the positioning image.

They control minimum and maximum dot screen angles etc. Typically specifying them in Quark will not affect a pre-processed image. So don’t try.

Only work from print swatches, make your own up and agree between everyone involved which ranges of tints are acceptable.

Can you build a master style sheet which contains corporate colours.

Lock it onto your master template and train the users to use it.

If you can’t do that then try to come to an agreement on tint ranges or a total value and enforce it.
Spot Colour

Except in exceptional circumstances such as advertising features Spot colo
does not exist. If you are sent it remove it.

It may come in from many strange sources as may weird and unprintable
ranges of colours so you will need to check where you suspect there may b
strange colours about.

You can do this by hand.

Or you can use an XTension to help.

Let's try it both ways using Visions Edge Utility and by hand.
Trapping

What is it and do you need to bother.

Again be guided by your print department, they were trapping (or not) when Quark was in short pants.

Let's look briefly at over printing and knock outs.

What controls do you have over trapping in Quark.

Trap Preferences

Auto Method  Use proportional unless told otherwise.

Amounts  Lets you specify the default maximum Trap value (it's too small out of the box).

Overprint Limit.  If you have set colours to over print this controls what %
that colour has to hit to overprint.

At the object level

Using the trapping palette you can over ride the defaults and specify how each object traps........if you insist. Let's look at those options.

**Smart Libraries**

This session focuses on maximising the productivity of Libraries by

a. Making them modular and logical
b. Using specialist XTensions to make the objects scalable once in the Libr

For details on these XTensions, consult your XTensive Documentation.

**Proofing**

This can be a major bottle neck. One good way to alleviate them is to get the fastest printer you can afford.
PPD PDF

Postscript Printer Drivers
Page Description Files.

They are essentially similar but the Quark derived PDF will win if both exist. The live in the system folder and the Quark PDF folders respectively.

Yo can edit PPDs nd this can be of some use, eg default font.

Lets go through a standard page set up and print set up.

Now mechanise it and over ride the Quark Hot keys with your own.....

Crops and Registration.

Again you need to work with your printers.

Establish what you want to put on the finl page and where it should go. Do
the Quark generic set give you enough or do you need to use an XTension to help out.

Let's look at Crop it and Reg it.

Out Put Problems

To avoid delays near deadline go through your page to check for the followi

Clean up

Can you pre size crop and rotate graphics

No short cut masking an no white boxes.

Paste inside masks can be a problem.

Avoid embedding Fonts in EPS files.

Avoid True Type fonts and Pict format graphics.
Don't use hairlines.....they vary and are meaningless.

Avoid nesting EPSF if you want to print.

Check for spot and impossible colour.
Dear Delegate

This documentation is provided as background information for the course and to help you work with any demo software you take with you from the course.

You do not need to buy any or all of these XTensions in order to improve your productivity within Quark......but some of them will help you significantly.

Above all ‘Ya Gota Practice’.

Good Luck and Best wishes

Tim Judd

Contents

Jabberwocky
Notes
Stars and Stripes
Thing-A-Ma-Bob
Bobzilla
ROpenXT
File Hunter
Kitchen Sink
Line Count
Jump Document
AdDirector
Editor
XTags
MultiUser
TableWorks
Vision Utilities
ScaleIt
SmartShapes
Crop and Reg It
Jabberwocky

Quick Look

Jabberwocky is a designers’ tool to generate random text for dummying up pages. With this XTension, you can:

• fill the entire current text chain with almost random words in a variety of styles

• choose what language the random text will use and whether the jabbering style will be prose or verse

• add completely new languages or change the words in the dictionary for the predefined languages so that all the words are your own choice. Jabberwocky has three predefined language styles — English, Latinesque, and Politicspeak.

Getting started

Press Command - 2 to find out how to move around the document.

Horizontal scroll bar Click the right arrow on the horizontal scroll bar to jump to “Using This Document.” This is one way to move between chapters. As you move, the chapter indicator (lower lefthand corner of the screen) will tell you where you are.

Vertical scroll bar Use the vertical scroll bar (if available) to read more information within a chapter.

Installing Jabberwocky

Quit QuarkXPress®. Then, drag-copy the XTension into the same folder as QuarkXPress. When you launch QuarkXPress, you’ll have access to Jabberwocky’s features. The XTension works with QuarkXPress v3.1 or later.
Using This Document

Table of contents, chapters, and topics

Use the Table of Contents to see chapters and topics. Use the topic list to “jump” to a specific topic.

Note: The horizontal scroll bar doesn’t actually scroll; use it to jump forward to the next chapter or jump backward to the previous chapter.

<table>
<thead>
<tr>
<th>Task</th>
<th>choose an option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Table of Contents</td>
<td>Choose Contents from Menu bar.</td>
</tr>
<tr>
<td></td>
<td>Or, use Cmd - K.</td>
</tr>
<tr>
<td>Go to chapter</td>
<td>Click chapter indicator (lower lefthand corner of the screen), then choose from list.</td>
</tr>
<tr>
<td>Go to topic (bullet items)</td>
<td>Double-click on choice from Table of Contents.</td>
</tr>
<tr>
<td>Move from chapter to chapter</td>
<td>Click Horizontal scroll bar.</td>
</tr>
<tr>
<td></td>
<td>Or, use Right/Left Arrow keys.</td>
</tr>
</tbody>
</table>

Moving around inside chapters

<table>
<thead>
<tr>
<th>To move ...</th>
<th>press/click</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line by line</td>
<td>Down/Up Arrow</td>
</tr>
<tr>
<td></td>
<td>Or, Vertical scroll bar</td>
</tr>
<tr>
<td>Up one window</td>
<td>Page Up</td>
</tr>
<tr>
<td>Down one window</td>
<td>Page Down</td>
</tr>
<tr>
<td>Beginning of a chapter</td>
<td>Home</td>
</tr>
<tr>
<td>End of a chapter</td>
<td>End</td>
</tr>
</tbody>
</table>
Creating and Editing Jabberwocky Sets

Creating a set

Operate just like Edit Style Sheets in QuarkXPress. However, sets do not travel with the document; you can import/export them to other documents (see, Importing and Exporting Jabberwocky Sets).

1. Choose Edit —> Jabberwocky Sets to see the Edit Jabberwocky Sets dialog box:

![Edit Jabberwocky Sets dialog box]

3. To create a new Jabberwocky Set, choose New.

4. Select the part of speech you need from the Part of Speech popup menu (when you do, the list of existing words will appear). The definition of that part of speech will appear in the Notes field.

5. Enter the word you want to add to the dictionary in the field. Click Add.

6. Continue adding words to the dictionary. When you are finished, click Save.

Editing a set

You can easily change the pool of words that the random text is drawn from.

Jabberwocky assumes a basically English grammar. To achieve the most realistic gibberish when creating your own Jabbering Sets, bear in mind the basic rules of grammar. Notes on how each part of speech is used are displayed at the bottom of
1. Click on a Set to edit.

2. Click Edit to see the Jabberwocky Dictionary dialog box:

3. Select a word from the scroll list. Do one or more of the following:
   - To remove the word from the list, click Delete.
   - To change the spelling of an existing word, enter the correct spelling in the text entry field, then click Add. Delete the word you misspelled.
   - To change a word’s part of speech, add the word again in the correct part of speech group, then delete the one with the incorrect part of speech.

4. Click Save.
Importing and Exporting Jabberwocky Sets

Importing a set

1. Choose Edit —> Jabberwocky Sets to see the Edit Jabberwocky Sets dialog box.
2. Click Import to see the Import Jabberwocky Set dialog box.
3. Choose a set to import. The file will have the suffix, "Jabbering."
4. Click Open to import the set.

Exporting a set

1. Choose Edit —> Jabberwocky Sets to see the Edit Jabberwocky Sets dialog box.
2. Click Export.
3. Choose a set to export. The name will appear in the Save Jabberwocky set as field with the suffix, "Jabbering."

Note: You can change the name of this file. However, if you import a file with a different name containing the same data, you will see the following alert:
This file contains a Jabberwocky set called Food Squirms, which already exists. Do you want to replace the current set with the imported data?
Generating Random Text

1. Select the Text tool and activate a text box.

2. Choose Utilities —> Jabber to generate some random text.

Note: The length of time the jabbering takes will depend upon how much text has to be generated to fill the text box(es).

Jabberwocky Preferences

You can choose which "jabbering set" (English, Politicspeak, Latinesque, or ones you've created/imported) and what "jabbering style" (Prose or Verse) will be used.

1. Choose Edit —> Preferences —> Jabberwocky to see the Jabberwocky Preferences dialog box:

2. Use the popup menus to choose a jabbering set and a jabbering style.

3. Click OK.
Technical Notes

Here is how Jabberwocky strings words together to form paragraphs:

- Items enclosed in [parentheses] are optional and may or may not appear.
- An '*' implies repetition a random number of times (which may be zero); A 'l' implies an either/or option.

<paragraph> ::= <TAB><sentence>.[<sentence>.]*<RETURN>
<sentence> ::= <clause>[,<subsidiary_clause>]*
<subsidiary_clause> ::= <conjunction><clause>
<clause> ::= <noun_phrase><transitive_verbphrase><noun_phrase> | <noun_phrase><intransitive_verbphrase>
<noun_phrase> ::= <article>[<adjective_phrase>]<noun_word> | <proper_noun>
<noun_word> ::= <noun> | <plural_noun>
<plural_noun> ::= <noun> followed by 's' or 'es' as appropriate
<adjective_phrase> ::= [<qualifier>]<adjective>
<transitive_verbphrase> ::= [<adverb_phrase>]<transitive_verb>
<intransitive_verbphrase> ::= <intransitive_verb>[<adverb_phrase>]
<adverb_phrase> ::= [<qualifier>]<adverb>
The Notes XTension

Quick Look

The Notes XTension displays a notes palette so you can enter and display non-printing notes in a QuarkXPress document. You can

- Enter a note up to 255 characters
- Cut/Copy and Paste text back and forth between notes and documents
- Show or hide notes in a document
- Move backward or forward through the notes in a document
- See a visible marker where a note exists
- View date, time, and author information with each note entry.

Getting Started

Press Cmd - 2 or click the right arrow on the Horizontal scroll bar to find out how to use this document. As you move, the chapter indicator in the lower lefthand corner of the screen will tell you where you are.

Use the Vertical scroll bar to see more information. If there is nothing more to read in a chapter, the vertical scroll bar will not be available.

Installing Notes XTension

Quit QuarkXPress™. Then, drag-copy the Notes XTension file into the same folder as QuarkXPress. When you launch QuarkXPress, you’ll have access to all the Notes XTension’s features.

NOTE: If you open a QuarkXPress document that contains notes but do not have the XTension loaded, you will see a message that says, “This document was created with a QuarkXTension that is no longer available. It may be reflowed.”
# Using This Document

## Table of Contents and Chapters

NOTE: The Horizontal scroll bar doesn't actually scroll; use it to jump forward to the next chapter or jump backward to the previous chapter.

<table>
<thead>
<tr>
<th>Task</th>
<th>choose an option (one per line)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Table of Contents</td>
<td>Choose Contents from Menu bar</td>
</tr>
<tr>
<td></td>
<td>Cmd - K</td>
</tr>
<tr>
<td>Go to chapter</td>
<td>Cmd - 2: Using This Document</td>
</tr>
<tr>
<td></td>
<td>Cmd - 3: Reading Notes</td>
</tr>
<tr>
<td></td>
<td>Cmd - 4: Writing Notes</td>
</tr>
<tr>
<td></td>
<td>Cmd - 5: Editing and Deleting Notes</td>
</tr>
<tr>
<td></td>
<td>Click chapter indicator then choose from list.</td>
</tr>
<tr>
<td>Go to topic (bullet items)</td>
<td>Double-click on choice from Table of Contents</td>
</tr>
<tr>
<td>Move from chapter to chapter</td>
<td>Click Horizontal scroll bar</td>
</tr>
<tr>
<td></td>
<td>Right/Left Arrows</td>
</tr>
</tbody>
</table>

## Moving around Inside Chapters

<table>
<thead>
<tr>
<th>To move ...</th>
<th>press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line by line</td>
<td>Down/Up Arrow</td>
</tr>
<tr>
<td></td>
<td>Vertical scroll bar</td>
</tr>
<tr>
<td>Up one window</td>
<td>Page Up</td>
</tr>
<tr>
<td>Down one window</td>
<td>Page Down</td>
</tr>
<tr>
<td>Beginning of a chapter</td>
<td>Home</td>
</tr>
<tr>
<td>End of a chapter</td>
<td>End</td>
</tr>
</tbody>
</table>
Reading Notes

When you have installed the Notes XTension, the Show/Hide Notes Information command is available under the View menu. Use the "Test these notes" document, included with this XTension.

1. Open a QuarkXPress document.

2. Choose Show Notes Information from the View menu to display the Notes palette. The Notes window is the area where the text will appear. Hold the mouse button down over the menu bar to move the Notes palette.

NOTE: If a text box is active and the Content tool is selected, you'll see buttons for viewing and creating/deleting notes in a document. If anything other than a text box is active (a line or a picture box) and no items are active, you'll see a reduced version of the palette.
3. Click **Forward>>** or **<<Backward** to move from note to note in the Notes window. In the document, the Text Insertion bar will automatically jump to where a note has been inserted in the text. If there are no more notes to go to, you will hear a “beep.”

**NOTE:** Choose **Show Invisibles** to see the notes marker, indicating where a note has been inserted.

4. Use the arrow keys to move the Text Insertion bar through the text. When the bar moves directly over a notes marker, the note will appear in the Notes window.

**NOTE:** The Notes palette will stay the same size regardless of what view your document is in.

5. Choose **Hide Notes Information** from the View menu to close the Notes palette. Or, click the close box on the Notes palette.
Writing Notes

You can write a note of up to 255 characters in the Notes window. The Notes window displays only 255 characters; any text beyond the limit will be deleted.

1. Activate a text box and choose the Content tool to display the full Notes palette.

2. Click the Text Insertion bar in an empty Notes window to begin inserting text. The middle button on the Notes palette is no longer dimmed.

3. Enter new text or cut/copy text from a document and paste it into the note. Press Return for a new line.

4. Click New Notes or press Enter to save the note. The Date, Time, and By information will automatically appear.
Editing and Deleting Notes

Moving text between the Notes window and a document works the same way as moving text between QuarkXPress documents. Notes are only visible onscreen; they will not print with the document.

To modify a note:
1. Make sure the note you want to edit is visible in the Notes window.
2. Copy/Cut text from document and paste it into the Notes window. Or, copy/cut text from the Notes window and paste it into a document. The text will assume the style of the text at that place in the document.

As soon as you add a character to an existing note, the middle button on the Notes palette will change to Edit Note.

3. When you are finished typing, click Edit Note and the new note will be saved along with new By, Time, and Date information.

NOTE: You can also move/insert notes by moving the Text Insertion bar directly over the notes marker in the document. Then, choose Cut/Copy. Move the Text Insertion bar to another part of the document and choose Paste. You'll be able to view this note when you come to this section of the text. Be sure to check Show Invisibles (View menu) before you try this!
Stars and Stripes™ XTension

Quick Look

Stars and Stripes adds a custom underline feature for creating unique colour underlines and a starburst feature with a new tool for drawing a polygon picture box in the shape of a starburst. You can:

• Select the colour, width, shade and offset of an underline
• Save and name underline styles so they do not have to be recreated
• Use styles in other documents
• Wrap text around a polygon picture box shaped like a starburst
• Determine the shape of the starburst by setting the amount and depth of its spikes
• Import graphics into the starburst.

Getting Started

Press Cmd - 2 or click the right arrow on the Horizontal scroll bar to find out how to use this document. As you move, the chapter indicator in the lower lefthand corner of the screen will tell you where you are.

Use the Vertical scroll bar to see more information. If there is nothing more to read in a chapter, the vertical scroll bar will not be available.

Installing Stars and Stripes XTension

Quit QuarkXPress™. Then, drag-copy the Stars and Stripes XTension file into the same folder as QuarkXPress. When you launch QuarkXPress, you’ll have access to all the Stars and Stripes features.

This XTension will work with QuarkXPress 3.1 and above.
Using This Document

Table of Contents and Chapters

NOTE: The Horizontal scroll bar doesn’t actually scroll; use it to jump forward to the next chapter or jump backward to the previous chapter.

<table>
<thead>
<tr>
<th>Task</th>
<th>choose an option (one per line)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Table of Contents</td>
<td>Choose Contents from Menu bar</td>
</tr>
<tr>
<td></td>
<td>Cmd - K</td>
</tr>
<tr>
<td>Go to chapter</td>
<td>Cmd - 2: Using This Document</td>
</tr>
<tr>
<td></td>
<td>Cmd - 3: Custom Underline</td>
</tr>
<tr>
<td></td>
<td>Cmd - 4: Starburst Tool</td>
</tr>
<tr>
<td></td>
<td>Click chapter indicator then choose from list.</td>
</tr>
<tr>
<td>Go to topic (bullet items)</td>
<td>Double-click on choice from Table of Contents</td>
</tr>
<tr>
<td>Move from chapter to chapter</td>
<td>Click Horizontal scroll bar</td>
</tr>
<tr>
<td></td>
<td>Right/Left Arrows</td>
</tr>
</tbody>
</table>

Moving around Inside Chapters

<table>
<thead>
<tr>
<th>To move ...</th>
<th>press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line by line</td>
<td>Down/Up Arrow</td>
</tr>
<tr>
<td></td>
<td>Vertical scroll bar</td>
</tr>
<tr>
<td>Up one window</td>
<td>Page Up</td>
</tr>
<tr>
<td>Down one window</td>
<td>Page Down</td>
</tr>
<tr>
<td>Beginning of a chapter</td>
<td>Home</td>
</tr>
<tr>
<td>End of a chapter</td>
<td>End</td>
</tr>
</tbody>
</table>
Custom Underline

Use Custom Underline to create unique underlines in color and save them for future use. They behave much like Type Style underlines but can be customised with more control over the underline attributes.

NOTE: Underline styles are saved with the document. To use them in other documents, you can export the underline styles to a file, then import them into any document you choose.

Creating a Unique Underline

1. Select the text you want underlined.

2. Choose Style -> Type Style -> Underline Styles -> Custom to see the Underline Attributes dialogue box:

   ![Underline Attributes Dialogue Box]

3. Choose the attributes you want applied to the highlighted text:

   Colour - choose from the popup menu. Create custom colours using Edit Colours dialogue box.
   Shade - choose 0-100% from the popup menu.
   Width - enter numbers in this field.
   Offset - enter numbers in this field. Offset gives you the option of absolute or relative values. The relative value is based on point size; the absolute value is based on any unit you want.

4. Click OK.
Creating Underline Style Sheets

1. Choose **Edit -> Underline Styles** to see the **Underline Styles** dialogue box:

   ![Underline Styles Dialogue Box]

   - **Underline Style Sheet:**
     - Default
     - main heads
     - callouts

   - **Colour:** Black
   - **Shade:** 100%
   - **Width:** 1 pt
   - **Offset:** 0 pt

2. Click **New** to see the **Underline Attributes** dialogue box:

   ![Underline Attributes Dialogue Box]

   - **Colour:** Black
   - **Shade:** 100%
   - **Width:** 1 pt
   - **Offset:** 0 pt
   - **Name:** New set

   **OK** | **Cancel**
3. Enter the attributes to be saved in an underline style sheet:

**Colour** - choose from the popup menu. Create custom colours using **Edit Colours** dialogue box.

**Shade** - choose 0-100% from the popup menu.

**Width** - enter numbers in this field.

**Offset** - enter numbers in this field. Offset gives you the option of absolute or relative values. The relative value is based on point size; the absolute value is based on any unit you want.

**Name** - enter the name of the style sheet.

4. Click **OK**.

5. Click **Save**.

**Modifying Underline Styles**

1. Choose **Edit** -> **Underline Styles** to see the Underline Styles available for your document:

![Underline Styles for June's newsletter](image)

2. Click on an existing underline style sheet to work with. The existing attributes for the style sheet appear at the bottom of the window.

3. Click **Edit** to change an existing underline style sheet. Or, click **Duplicate** to make a copy of an existing underline style sheet (you may want to use some of the attributes already assigned to a style sheet).

4. Make changes to the style sheet using the **Underline Attributes** dialogue box. Click **OK**.

5. Click **Save**.
Starburst Tool

The Starburst Tool lets you draw a polygon picture box in the shape of a starburst. You can determine the appearance of the starburst by controlling the number of spikes and the spike depth.

To create a starburst
1. Click on the Starburst tool in the Tools palette.
2. Draw a box where you want the starburst to appear in your document. The starburst will appear in the box when you release the mouse button.
3. Add text to the document or a graphic to the box.

To change the look of the starburst
1. Double-click on the Starburst tool to see the Starburst Preferences dialogue box:

   ![Starburst Preferences](image)

   2. Change the appearance of your starburst by entering numbers in the Spikes and Spike depth fields and checking Random spikes:

   **Spikes** - add a number between 5 and 40.
   **Random Spikes** - check to have a random spike depth in your starburst.
   **Spike depth** - set the spike depth between 10 and 90% of the overall box size.

   3. Wrap text around the starburst and import graphics inside the starburst.
Thing-a-ma-bob™ XTension

Quick Look

Thing-a-ma-bob includes updated features from the FeaturesPlus™ XTension:

- Make Fraction/Make Price formats fractions and prices automatically.
- Value Converter palette converts values between six measurement systems.
- Remove Manual Kerning removes all manual kerning from selected text.
- Word Space Tracking applies tracking to word spaces only. (Tracking values are normally applied between both characters and words.)

Getting Started

Press Cmd - 2 or click the right arrow on the Horizontal scroll bar to find out how to use this document. The chapter indicator in the lower left-hand corner of the screen will tell you where you are.

Use the Vertical scroll bar to see more information. If there is nothing more to read in a chapter, the vertical scroll bar will not be available.

Installing Thing-a-ma-bob

Quit QuarkXPress™. Drag-copy the Thing-a-ma-bob file into the same folder as QuarkXPress. When you launch QuarkXPress, you’ll have access to all Thing-a-ma-bob’s features.
## Using This Document

### Table of Contents and Chapters

**NOTE:** The Horizontal scroll bar doesn’t actually scroll; use it to jump forward to the next chapter or jump backward to the previous chapter.

<table>
<thead>
<tr>
<th>Task</th>
<th>choose an option</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Table of Contents</td>
<td>Choose Contents from Menu bar</td>
</tr>
<tr>
<td></td>
<td>Or, press Cmd - K</td>
</tr>
<tr>
<td>Go to chapter</td>
<td>Click chapter indicator then choose from list</td>
</tr>
<tr>
<td>Go to topic (bullet items)</td>
<td>Double-click on choice from Table of Contents.</td>
</tr>
<tr>
<td>Move from chapter to chapter</td>
<td>Click Horizontal scroll bar</td>
</tr>
<tr>
<td></td>
<td>Or, use Right/Left Arrows</td>
</tr>
</tbody>
</table>

### Moving around Inside Chapters

<table>
<thead>
<tr>
<th>To move ...</th>
<th>press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line by line</td>
<td>Down/Up Arrow</td>
</tr>
<tr>
<td></td>
<td>Vertical scroll bar</td>
</tr>
<tr>
<td>Up one window</td>
<td>Page Up</td>
</tr>
<tr>
<td>Down one window</td>
<td>Page Down</td>
</tr>
<tr>
<td>Beginning of a chapter</td>
<td>Home</td>
</tr>
<tr>
<td>End of a chapter</td>
<td>End</td>
</tr>
</tbody>
</table>
Make Fraction

Make Fraction enables you to format fractions automatically. Make Fraction is only available when the text insertion point is to the immediate left, between or to the immediate right of characters that can be converted into a fraction (a/b, 1/2, 13/16, etc.) or when any or all of these characters are highlighted.

1. Highlight the characters you want to convert.

2. Choose Style -> Type Style -> Make Fraction.

The characters 1/2 are converted to 1/2

NOTE: When you highlight a range of characters and apply Make Fraction, only the highlighted characters are transformed. If you leave the cursor to the right of the value, the entire value will be transformed.

For instance: 11/16 will become 11/16
11/16 will become 1 1/16

The characters will be converted according to the formatting specified in the Fraction/Price Preferences (Edit -> Preferences -> Fraction/Price) dialogue box. Within the Fraction are of the dialogue box, the fields in the Numerator, Slash, and Denominator sections allow you to specify the size, spacing, and placement of the fraction components.

See the chapter, “Fraction/Price Preferences.”
Make Price

Make Price enables you to format prices automatically using superscript style. Make Price is only available when the text insertion point is between or to the immediate right of characters that can be converted into a price ($1.49, £20.00, $.99, etc.) or when any or all of these characters are highlighted.

1. Highlight the characters you want to convert. Be sure to highlight the decimal as well as the numbers.

   The price is $69.95.

2. Choose Style -> Type Style -> Make Price.

   The price is $69^s.

When you apply Make Price, QuarkXPress automatically applies the superior style to the cents characters (the characters that follow the radix — a decimal in the U.S., a comma in some other countries).

The Fraction/Price Preferences (Edit -> Preferences -> Fraction/Price) dialogue box contains two check boxes in the Price area that enable you to control the way QuarkXPress creates prices when you apply Make Price. Check Underline Cents to underline the cents characters when creating prices. Check Delete Radix to delete the radix (decimal point or comma) character when creating prices.

See the chapter, “Fraction/Price Preferences.”
Fraction/Price Preferences

The appearance of converted fractions and prices is determined by the values and selections entered in the Fraction/Price Preferences dialogue box (Edit -> Preferences -> Fraction/Price).

Fraction/Price Preferences

<table>
<thead>
<tr>
<th>Fraction</th>
<th>Slash</th>
<th>Denominator</th>
</tr>
</thead>
<tbody>
<tr>
<td>Numerator</td>
<td>Offset:</td>
<td>UScale:</td>
</tr>
<tr>
<td></td>
<td>35%</td>
<td>50%</td>
</tr>
<tr>
<td></td>
<td>0%</td>
<td>100%</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>☒ Underline Cents</td>
</tr>
<tr>
<td>☒ Delete Radix</td>
</tr>
</tbody>
</table>

Fraction Preferences

- Offset positions of the numerator, denominator, and slash in relation to the baseline.
- VScale determines the height of the numerator, denominator, and slash as a percentage of font size.
- HScale determines the width of the numerator, denominator, and slash as a percentage of normal character width.
- Kern adjusts the spacing between the characters and the slash.
- Virgule substitutes a typesetter’s slash (a thinner, more vertical slash) for a normal slash character.

Price Preferences

- Underline Cents places an underline beneath the cents characters.
- Delete radix removes the decimal or comma character from the price.
Value Converter palette

This floating palette automatically converts a value you enter in any measurement system and displays the equivalent value in six different measurement systems: Inches, Picas, Points, Millimetres, Centimetres, and Ciceros.

1. Choose View –> Show Value Converter to display the Value Converter palette.

2. Enter a number and measurement system abbreviation in the Value field. Its equivalents are immediately displayed in the six measurement system fields.

The value you enter in the Value field can contain signed quantities (+ and –) with values expressed in different measurement systems (e.g., 4p+3mm-.25").
Remove Manual Kerning

Remove Manual Kerning (Utilities menu) enables you to remove all manual kerning applied between characters in a highlighted range of text. Remove Manual Kerning is available when more than one character is highlighted.

1. Highlight the range of text from which you want to remove kerning.

Word Space Tracking

The word space tracking feature enables you to apply tracking to word spaces only. (Tracking values are normally applied between both characters and words.) This feature can be accessed through keyboard commands only.

1. Highlight the range of characters whose word spacing you want to modify.

2. Enter one of the following keyboard commands.

   Increase space by .05 em .................. Command-Control-Shift- }

   Increase space by .005 em .................. Command-Option-Control-Shift- }

   Decrease by .05 em .......................... Command-Control-Shift- { 

   Decrease space by .005 em .................. Command-Option-Control-Shift- {
An XTension named Bobzilla™

Quick Look

The Bobzilla XTension combines an enhanced step-and-repeat tool with three popular features from the Bob™ and Son of Bob™ XTensions:

- **Go-to-page** displays a pop-up of the pages in your document
- **Line Check** automatically searches for typographically undesirable lines
- **Super Step-and-Repeat** is a sophisticated method for repeating objects on a page
- **Full Resolution TIFF Output** tells QuarkXPress not to make an adjustment for a printer’s resolution when it outputs TIFF files.

Getting Started

Press **Cmd - 2** or click the right arrow on the **Horizontal scroll bar** to find out how to use this document. As you move, the chapter indicator in the lower lefthand corner of the screen will tell you where you are.

Use the **Vertical scroll bar** to see more information. If there is nothing more to read in a chapter, the vertical scroll bar will not be available.

Installing Bobzilla

Quit QuarkXPress™. Then, drag-copy the Bobzilla XTension file into the same folder as QuarkXPress. When you launch QuarkXPress, you’ll have access to all Bobzilla’s features.
Using This Document

Table of Contents and Chapters

NOTE: The Horizontal scroll bar doesn’t actually scroll; use it to jump forward to the next chapter or jump backward to the previous chapter.

<table>
<thead>
<tr>
<th>Task</th>
<th>choose an option (one per line)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Go to Table of Contents</td>
<td>Choose Contents from Menu bar</td>
</tr>
<tr>
<td></td>
<td>Cmd - K</td>
</tr>
<tr>
<td>Go to chapter</td>
<td>Cmd - 2: Using This Document</td>
</tr>
<tr>
<td></td>
<td>Cmd - 3: Go-to-page</td>
</tr>
<tr>
<td></td>
<td>Cmd - 4: Line Check</td>
</tr>
<tr>
<td></td>
<td>Cmd - 5: Super Step and Repeat</td>
</tr>
<tr>
<td></td>
<td>Cmd - 6: Full Resolution TIFF Output</td>
</tr>
<tr>
<td></td>
<td>Click chapter indicator then choose from list</td>
</tr>
<tr>
<td>Go to topic (bullet items)</td>
<td>Double-click on choice from Table of Contents</td>
</tr>
<tr>
<td>Move from chapter to chapter</td>
<td>Click Horizontal scroll bar</td>
</tr>
<tr>
<td></td>
<td>Right/Left Arrows</td>
</tr>
</tbody>
</table>

Moving around Inside Chapters

<table>
<thead>
<tr>
<th>To move ...</th>
<th>press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line by line</td>
<td>Down/Up Arrow</td>
</tr>
<tr>
<td></td>
<td>Vertical scroll bar</td>
</tr>
<tr>
<td>Up one window</td>
<td>Page Up</td>
</tr>
<tr>
<td>Down one window</td>
<td>Page Down</td>
</tr>
<tr>
<td>Beginning of a chapter</td>
<td>Home</td>
</tr>
<tr>
<td>End of a chapter</td>
<td>End</td>
</tr>
</tbody>
</table>
Go-to-page

Use Go-to-page to quickly move to any page in a QuarkXPress document (including master pages) or to get a page count for long documents.

To use Go-to-page:
1. Click and hold the mouse button on the page number indicator in the lower left corner of the document window. A thumbnail of each page in the document is displayed. Each icon has a page number corresponding to your specifications in the Section dialogue box (Page menu). Asterisks by the page numbers indicate the beginnings of sections.

2. Move the mouse horizontally through the pages until the page you want to go to is highlighted. Release the mouse button; the selected page will be displayed with its origin in the upper left corner of the document window.

NOTE: All the thumbnail icons for long documents cannot fit in the pop-up display window. To access a page outside the visible row of icons, hold down the mouse button, move the pointer to the right or left end of the row of icons, and the row will scroll accordingly.
Line Check

Use Line Check to find widows, orphans, loosely justified lines, lines that end with a hyphen, and text box overflow. Line Check moves through a document, highlighting the questionable lines, much as the Spell Check function highlights questionable words.

Specify search criteria

1. Choose Search Criteria from the Line Check submenu (Utilities menu) to open the Search Criteria dialogue box. Check the categories of undesirable typography you want to search for:

- **Loose Justification** is a justified line containing word or character spaces that exceed the maximum word and character space values in the H&J specifications applied to its paragraph.

- An **Auto Hyphenated** line ends with a hyphen placed by the automatic hyphenation function.

- A **Manual Hyphenated** line ends with a hyphen typed in by a user.

- A **Widow** is the last line of a paragraph, less than a full measure wide, that falls at the top of the following column or page.

- An **Orphan** is the first line of a paragraph that falls at the bottom of a column or page.
• **Text Box Overflow** occurs when text cannot be displayed within its text box. This condition is represented by an overflow symbol in the lower right corner of a text box. There must be at least one line of visible text in a text box for Line Check to find overflow. Also, text must cause the overflow; invisible characters such as paragraph returns and enter characters that generate overflow will not be found.

2. Click the **Count** to get a count of all typographically undesirable lines. The count for each category appears on the right side of the box.

3. Click **OK**.

**NOTE:** The Line Check search criteria you specify become application defaults, until you change them. The settings are not document specific.

**Implement a search**

1. To search the entire document, choose **First Line** (Utilities menu, Line Check). To search from the location of the Text Insertion bar to the end of the document, place the Text Insertion bar where you want to start the search and choose **Next Line** (Utilities menu, Line Check) or press **Cmd - ;**.

2. The first typographically undesirable line is highlighted. You can interrupt the search at any time to fix a line. Press **Cmd - ;** to continue the search.

3. An alert sounds when the search is complete.
Super Step and Repeat

Use Super Step and Repeat to perform a more sophisticated item duplication than the one provided by QuarkXPress.

To use Super Step and Repeat:

1. Select an item (picture box, text box, or line).

2. Choose Super Step and Repeat from the Item menu to display the Super Step and Repeat dialogue box.

3. Specify the placement of duplicated items:
• Enter a number from 1 to 100 in the **Repeat Count** field to specify how many times you want the item to be duplicated.

• Check **Linear Motion** to specify a horizontal and vertical offset for each duplicated item. Specify the offset values in the **Horizontal Offset** and **Vertical Offset** fields.

• Check **Rotational Motion** to specify a rotation value for each duplicated item. Specify the rotation value in degrees in the **Angle** field; the rotation is counterclockwise from the original item. For example, if you enter 10°, the first duplicated item will be placed 10° from the original item. The second duplicated item will be placed 20° from the original item.

• Choose options from the **Vert. origin** and **Horiz. origin** pop-up menus to specify the centrepoint of rotation. The vertical centre of rotation can be either Top, Centre, or Bottom; the horizontal centre of rotation can be either Left, Centre, or Right.

4. Specify the transformation of duplicated items:

• Enter a value from 1% to 1000% in the **End box scale** field to scale each duplicated item. For example, if you specify a Repeat count of 4, and an End box scale value of 200%, Super Step and Repeat produces 4 new boxes scaled at 125%, 150%, 175% and 200%.

• Enter a point value in the **End frame thickness** field to scale the frame of each duplicated item. End frame thickness works similar to End box scale — each intermediate items is framed with an increasingly thicker frame.

• Enter a value from 1% to 100% in the **End box shade** field to increase or decrease the shade of colour in duplicated items. No perceptible change will occur in white boxes.

• Check **Scale contents** to have the contents of picture boxes and text boxes scaled to fit duplicated boxes.

5. Check **Fast draw** to have QuarkXPress draw all the new items after the entire duplication is complete. If you uncheck **Fast draw**, each item is drawn as it is created.

**NOTE:** Fast draw significantly increases the speed of a Super Step and Repeat action only.
Full Resolution TIFF Output

Use **Full Resolution TIFF Output** to have QuarkXPress adjust the rendering of TIFFs for sharper printing. Full resolution TIFF Output tells QuarkXPress not to make an adjustment for a printer’s resolution when it outputs TIFF files.

**NOTE:** Without Full Resolution TIFF Output, QuarkXPress sets the resolution to the maximum the printer can produce. This can cause unwanted halftoning around flat values, such as solid black against solid white.)

**To use Full Resolution TIFF Output:**
1. Create a picture box and import a greyscale TIFF.

2. Select the picture box and choose **Full Resolution Output** from the Item menu.

**NOTE:** Full Resolution Output is specified on a picture-by-picture basis.
Welcome to ROpenXT 1.0.

Portions Copyrighted 1988-1995 Quark, Inc. All Rights Reserved.

ROpenXT is an XTension that is designed to improve operations over a network. The working document is copied onto the local disk, enabling more efficient working and quicker saving. Anyone else on the network attempting to access the documents you are working on will get told who has the document and where it is, instead of the File In Use message.

- Makes a working copy of document locally
- Reduces network activity
- Keeps track of who has got files
- Keeps track of where got files are
- Easy to set-up
- Can password protect set-up

Installing ROpenXT.

To install ROpenXT on your disk simply drag the ROpenXT file into the same folder as your QuarkXPress program file (or the XTension sub-folder with QuarkXPress 3.3 or later). ROpenXT is now installed and will be operative next time you launch QuarkXPress.

After installing this XTension, you will be requested to enter a key when you first launch QuarkXPress. You will also be asked to enter this key if you move the software to another computer or change your copy of QuarkXPress. Enter the key exactly as it appears on the label below and press OK. The key is case sensitive and you must include the dashes.

Demonstration Versions

If you have a demonstration version of the XTension, then running QuarkXPress with the XTension installed will place QuarkXPress into its demonstration mode. These include adding a background text to any printouts, and preventing any saved documents being opened in non-demo QuarkXPress®. Make sure that you do not accidentally save any important documents while QuarkXPress® is in demo mode.

Demonstration copies of the XTension are normally called ROpenXT Demo but may not be. After installation, when QuarkXPress is launched, if you get a warning screen
instead of being asked for a key, then this copy of the XTension is a demonstration version. Demonstration versions may be used to evaluate the suitability of the XTension for your needs. If you have a demonstration version and would like to purchase a full version, then contact Ferax.

Run Counts.

This XTension is licensed on a per user basis. If more copies are run than are licensed, you will get messages telling you. In this case, you can remove copies from machines that you do not currently require. If you need more copies, you can upgrade your license.

Removing ROpenXT.

To remove ROpenXT simply move the ROpenXT file from the same folder as your QuarkXPress program file (or the XTension sub-folder with QuarkXPress 3.3 or later).

General Operation

This XTension operates by providing five new functions located in the Utilities Menu:

- Utilities/Get File
- Utilities/Put File
- Utilities/Abandon File
- Edit/Preferences/ROpenXT
- File/New/Remote Document

Utilities/Get File...
The Utilities/Get File... menu command is used in place of the File/Open... command when you wish to get a file from a network server. This will bring up the Get File dialog as shown above. This is similar in operation to QuarkXPress's normal Open dialog except that it will also show if the file is already in use by you or any other operator. This can be seen on the bottom line. The check boxes Preview and Show Use Information can be used to suppress the display of the respective information. If you are operating over a network and you are not interested in this information, then displaying it will just slow down the speed of operation and add unnecessary network traffic.

If you get the file, it will be copied to your local disk and then this local version is opened. The file on the server will be amended to record the fact that you got the file. In addition, the name of the file will be added to the Utilities/Put File and the Utilities/Abandon File menus.

Utilities/Put File

When the file is finished, it must be put back on the server. Select the name of the file from the Utilities/Put File menu. This will close the window, if it is open, then copy the changed file back to the server, delete the local file and remove its name from the Utilities/Put File and the Utilities/Abandon File menus.

Utilities/Abandon File

To abandon changes to a file and release the original version on the server, select the
name of the file from the Utilities/Abandon File menu.

Edit/Preferences/ROpenXT

The set-up to operate this XTension is accessed from the Edit/Preferences/ROpenXT menu item. The dialog box is shown above.

Password Protect Prefs Check Box: Access to the preferences menu can be protected by password. When this box is checked, then selecting the Edit/Preferences/ROpenXT menu item will bring up a password dialog box where you must enter the correct password to proceed. On installation this password is set up to be “Ferax”.

Set Password Button: Selecting the Set Password button will bring up a dialog box which enables you to change the password. You must enter the password correctly in both boxes and press OK to change the password.

Folder for local storage of work in progress: Shown beneath this line is the current folder that is used for local storage. Use the Change button to select a different folder. You can only change this folder when you have not got any files in it locally.

Confirm Puts on closing windows Check Box: When this is checked you will get an alert message when a window which contains a got file is closed. This allows you to Put the file (default) or Cancel. Cancel will do nothing. Alternatively, you can select Abandon, which will abandon the local file. If this is not checked, then files will automatically be put back when the window is closed.
Keep Files Open Check Box: If this box is checked, then the original files on the server will be kept open. Only use this option if you have copies of QuarkXPress on your network not using this XTension or have other applications accessing your QuarkXPress documents.

Allow override of got files Check Box: If this option is checked then if a file is already got, you will get an option to override this if you try to get the file again.

File/Open... menu item.

The File/Open... dialog of QuarkXpress is replaced by one that will show the got status of files. This menu is similar in appearance to the Get File... dialog. It will not allow you to open a got file. If you hold down the option key as you click the Open button, then the XTension will attempt to open a file even if it has been got. Use this feature with care.

File/Quit menu item.

---

ATTENTION: The Singapore Copyright Act applies to the use of this document. Nanyang Technological University Library
When you quit QuarkXPress with got files, you will get this alert which allows you to put all the files back.

![Alert to put files back](image)

File/New/Remote Document... menu item.

Use the File/New/Remote Document... menu to create a new remote document and have the net performed automatically.

![Remote Document setup](image)

Contact Details:

If you have problems finding ROpenXT, or if your experience any problems running the
demo version, please contact

Mark Gollop
Ferax Software Engineering Limited
6 Goose Acre,
Cheddington,
Leighton Buzzard,
LU7 0SR, England
Telephone (+44) 01296 668953
Fax: (+44) 01296 661965
AppleLink: FERAX
Internet: mjg@ferax.demon.co.uk

Other XTensions by Ferax:

SpreadEPS:

- Enables saving of spreads as EPS
- Automates saving pages as EPS
- Adds bleed
- Adds crop marks

ROpenXT:

- Makes a working copy of document locally
- Reduces network activity
- Keeps track of who has got files
- Keeps track of where got files are
- Easy to set-up
- Can password protect set-up

CaseIT:

Ever left the caps lock key on? Well, CaseIT converts to and from upper case.
Sensitive to initial characters of paras and sentences.

Custom XTensions by Ferax:

Ferax Software Engineering Limited specialises in developing Custom XTensions to QuarkXPress. These range from solving particular problems for customers, aiding customers in the automation of manual error-prone operations and integrating Quark XPress within an overall production environment.
Important Notice

The following is required under the terms of Ferax Software Engineering Limited's Developer License Agreement.

XTENSIONS IS A TRADEMARK OF QUARK, INC. QUARK, QUARKXPRESS, QUARKXTENSIONS ARE TRADEMARKS OF QUARK, INC. WHICH HAVE BEEN REGISTERED IN THE U.S. PATENT AND TRADEMARK OFFICE AND IN MANY OTHER COUNTRIES WORLDWIDE.

THIS PROGRAM CONTAINS AN XTENSION WHICH ENABLES IT TO BE USED WITH QUARKXPRESS 3.2 and 3.3 — APPLE MACINTOSH VERSION.

ONLY VALID, REGISTERED COPIES OF QUARKXPRESS 3.2 OR 3.3 — APPLE MACINTOSH VERSION MAY BE USED WITH THIS PROGRAM.

QUARK, INC. MAKES NO WARRANTIES, EITHER EXPRESS OR IMPLIED REGARDING THE ENCLOSED COMPUTER SOFTWARE PACKAGE, ITS MERCHANTABILITY, OR ITS FITNESS FOR ANY PARTICULAR PURPOSE. QUARK, INC. DISCLAIMS ALL WARRANTIES INCLUDING, BUT NOT LIMITED TO THE WARRANTIES OF THE DISTRIBUTORS, RETAILERS AND DEVELOPERS OF THE ENCLOSED SOFTWARE.

WITHOUT LIMITING THE FOREGOING, IN NO EVENT SHALL QUARK, INC. BE LIABLE FOR ANY SPECIAL, INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAMAGES IN ANY WAY RELATED TO THE USE OR ARISING OUT OF THE USE OF THE ENCLOSED SOFTWARE. QUARK, INC.'S LIABILITY SHALL IN NO EVENT EXCEED FIFTY DOLLARS ($50.00).

THE EXCLUSION OF IMPLIED WARRANTIES AND/OR THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES IS NOT ALLOWED IN SOME AREAS, SO THESE EXCLUSIONS AND LIMITATIONS MAY NOT APPLY TO YOU.
FileHunter™ 1.0

FileHunter™ adds a quick search and import capability to QuarkXPress®. FileHunter will automatically pick up a previous text or picture file reference - so you can find the current version of the file for page re-assembly. Or you can use File Hunter’s searching abilities to make lists of files which can then be imported into one or more QuarkXPress documents with a simple double-click.

**FILE HUNTER FLOATING PALETTE**

**FILE REFERENCE OF CURRENTLY SELECTED QUARKXPRESS BOX**

**SEARCH CONTROLS:**

**FILE LIST – DOUBLE CLICK IMPORTS FILE INTO QUARKXPRESS PAGE**

**QUICK SEARCH CHOICES**

WHERE — CHOOSE ONE OR MORE DISKS FROM YOUR MACHINE OR FROM YOUR NETWORK

FILENAME — ENTER NAME EXACTLY, OR A STRING OF CHARACTERS WHICH ALL FILENAMES WILL CONTAIN OR LEAVE BLANK TO ACCEPT ANY NAMES.

MODIFIED — THE CHOICES ARE ANYTIME, LAST HOUR, LAST DAY, OR THE LAST WEEK

KIND — CAN BE SET TO SEARCH FOR ANY KIND OF FILE (WHICH QUARKXPRESS CAN IMPORT) OR SET TO FIND ONLY A SPECIFIC TYPE (I.E., TIFF OR WORD). THE CHOICES WILL VARY DEPENDING ON WHAT FILTERS ARE PRESENT.

Price: $95.00

Order From: North Atlantic Publishing Systems, Inc.
Suite 13, 9 Acton Rd.
Chelmsford, MA 01824

(508) 250 8080     fax (508) 250 8179
KitchenSink — demo version

This document briefly describes KitchenSink™ from a lowly apprentice production. As a demonstration version, it is exactly like the production version. However, note that while loaded, any demonstration XTension* alters QuarkXPress* such that saved documents cannot be opened by normal versions of QuarkXPress, and all printed pages include a “QuarkXPress Demo” banner.

Introduction
KitchenSink provides a large number of features, foremost of which is Command Pad, a floating palette allowing one-click access to almost all of the QuarkXPress dialog boxes and palettes. In addition, KitchenSink includes:
- Co-Pilot, a palette that provides one-click scrolling to any point in the current spread
- a nudge palette for quick, accurate movement of items
- a text scale/shift palette
- intelligent pasting
- fitting picture boxes to pictures, and vice versa
- the ability to convert text boxes to picture boxes, and vice versa
- alignment of elements relative to page edges
- document and page-management features
- spot-to-process-to-spot color transformation
- preferences dialog boxes that let you control various default units of measure, the display resolution of imported images, and the appearance of pages and dialog boxes.

Overview of KitchenSink
All four KitchenSink palettes can be opened by choosing the appropriate Show command from the View menu. In addition, Co-Pilot, NudgeIt and Scale/Shift (as well as all of the standard QuarkXPress palettes) can be opened by clicking buttons on the Command Pad.

When the Item tool is selected and you press the Control key while opening the Edit menu, CutIt, CopyIt and PasteIt replace the standard Cut, Copy and Paste commands.

Three document-control pop-up menus are available: an open-document selection menu (press Command and open the menu from anywhere in the active document title bar), a “go to page” menu (opened from the current-page display area in the lower left corner of the document window), and a document magnification menu (press Command and open from current-page display).

A Page Sets pop-up menu is added to the New Document dialog box, the Document Setup dialog box, and the Master Guides dialog box. These pop-up menus let you save and access sets of page-setup parameters, similarly to Style Sheets.

Command Pad
The buttons displayed on the Command Pad palette vary according to both the tool and type of QuarkXPress element(s) currently selected. Also, the buttons change when Option or Shift-Option is pressed (the QuarkXPress Tools palette is displayed when Shift is pressed). Command Pad can be configured horizontally as a single or double row of buttons, or vertically as a single or double column.

Command Pad, text box selected, no modifier key pressed.
Co-Pilot
A proxy of the current spread is displayed on the Co-Pilot palette: click anywhere in the proxy to instantly scroll to that area. A red flag in the proxy indicates where you clicked.

Picture and Text Box Features
KitchenSink adds four text/picture box manipulation commands to the Item menu: Change Text to Picture Box (or Change Picture to Text Box, depending on the type of box selected), Size Box to Picture, Text Box Insets, and Align Item to Page. When a picture box is selected, Fit Picture to Box and Picture Scale are available from the Style menu. All have corresponding buttons on the Command Pad.

Picture Scale lets you scale the selected picture by entering a single magnification value, rather than two.

Spot
This dialog box provides quick conversion of spot colors to process colors and vice versa.

Select the colors to be converted and click the To Spot button to convert the selected colors to spot colors, or click To Process to convert them to process colors.

Documents submenu
The commands in the Documents submenu of the View menu let you rapidly move the active document window back and forth between two locations, and hide and show open documents similarly to QuarkXPress palettes.

For More Information
To obtain more information about KitchenSink, or to purchase a copy, please contact:

XChange USA
724 Whalers Way
Boardwalk Bldg. H, Suite 101
Ft. Collins, Colorado, USA 80525
1-800-788-7557 (tel)
1-303-229-9773 (fax)

XChange International
1-2 Bromley Place
London W1P5HB, UK
44-71-637-2966 (tel)
44-71-637-2842 (fax)

Trademark Information
a lowly apprentice production, the lowly apprentice logo and KitchenSink are trademarks of a lowly apprentice production. Quark, QuarkXPress and XTensions are registered trademarks of Quark, Inc. Apple and Macintosh are registered trademarks of Apple Computer, Inc.

a lowly apprentice production
363 Winamar Avenue
La Jolla, CA 92037
619-459-7655 tel
619-459-3094 fax
AppleLink PSCHMITT
AOL PSCHMITT
Line Counter Configuration.

1) Prefs - Set up which is the Default Line Counter Style to use.
2) Line Counter... under Edit menu. Used to maintain Line Counter Styles.

**Counter Style Definitions**

<table>
<thead>
<tr>
<th>Counter Styles:</th>
<th>New</th>
<th>Import</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Edit</td>
<td>Export</td>
</tr>
<tr>
<td></td>
<td>Duplicate</td>
<td>Save</td>
</tr>
<tr>
<td></td>
<td>Delete</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

New - Create a new Line Counter Style.
Edit - Edits an existing Line Counter Style.
Duplicate - Duplicates an existing Line Counter Style.
Delete - Delete an existing Line Counter Style.
Save - Saves changes made during this session.
Cancel - Cancel changes made during this session.
Export - Exports the Selected Line Counter Style or all Line Counter Styles to a file for later importation.
Import - Imports previously exported Line Counter Style.
The Edit Line Counter Style Dialog enables you to set up the parameters used for counting and estimating.

The Slug Setup allows you to select what will be displayed in slugs in the stories.

The Palette Setup allows you to select what items are counted and shown in the Line Counter Palette.

**Edit Line Count Style**

<table>
<thead>
<tr>
<th>Line Count Style Name:</th>
<th>Slug Setup</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default</td>
<td>Palette Setup</td>
<td>Dummy File</td>
</tr>
<tr>
<td></td>
<td>Style Sheet</td>
<td>Cancel</td>
</tr>
</tbody>
</table>

The Style Sheet allows you to select the style sheet to be used in estimating.

The Dummy File allows you to select the file used for estimating.

The Options Allows you to select how the estimation will occur.
Current Story only - will limit counting and estimation to the current story in the current document only.

Import Options.

Convert Quotes and Include Style Sheets are the normal QXP text Filter Options. Report Errors and Hide Document are extra XTags options.

Append File - This option is used to select whether the dummy text used for estimating story depth and underset is appended to the end of any text currently placed in the story, or whether any text in the story should be removed first, and the dummy text used over the whole area.

Style Sheet Options.

Use current style - Uses the currently selected style in the current box.

Set Style Sheet - uses the style sheet set up in Edit Line Counter Style Menu.

Dummy File Import Type.

Use ASCII Text Only - treats the dummy file as ascii text. It does not pass it through any filters. It just inserts the text from the file as straight characters.

Use Get Text Filter - Flows the dummy file in via Get Text, which selects the appropriate filter depending on the file type.

Use XTags - This option will use the XTags XTension to flow the dummy text in.
**Line Counter Palette Setup**

<table>
<thead>
<tr>
<th>Line Count</th>
<th>Total</th>
<th>OverSet</th>
<th>UnderSet</th>
<th>Estimate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Depth</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Word</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Atex Line Counter**

```
<table>
<thead>
<tr>
<th>Count</th>
<th>Counter Style</th>
<th>Total</th>
<th>UnderSet</th>
<th>Estimate</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Default</td>
<td>3</td>
<td>3</td>
<td>6</td>
</tr>
<tr>
<td>Line Count</td>
<td>Depth</td>
<td>14.303 mm</td>
<td>15.24 mm</td>
<td>29.543 mm</td>
</tr>
</tbody>
</table>
```
Press2Go Line Count V1.0.6 Release Notes

1) Edit/Preferences/Line Count - can now use the following precedence codes to produce Return, Shift Return and Tab characters in the default string.

```
\r Return
\n Shift Return
\t Tab
```

2) Use Style Sheets option in Area Mode.

When you use the Use Style Sheet Option, a Style sheet is set up which is used to count the text. Things to note are:

- The style sheet must be selected using the Edit/Counter Styles/Edit/Style Sheet Option.

![Line Count Options](image)

- If you change a style used in a counter style, then you must reselect the style sheet in all the counter styles that you want to use the changes style sheet using the Edit/Counter Styles/Edit/Style Sheet Option. If a style exists in a document, Line counter will temporarily update it with its own version while it counts!

![Select Style Sheet](image)

- If you want to see the current style sheets used in a counter style, then if you delete the style sheet from the current document and then use the counter style, then Line count will create the style in the current document.
3) Pallet Setup for Area Mode.

Area Counts are returned as Depth values, so to select area values, you must select the depth options in the palette setup.

(n.b.) If you are not interested in underset values, Turn off under set counting as it will slow down counting process in area mode.

4) Area Counting Option.

Area counting option has been added.

a) Check Use Area Counting to activate area counting.

b) Area Label - this text will appear in the Line Count Palette in place of the Depth row.

Area Counting works by counting units. A unit is a number of Hyphens (-) applied in the selected style (See Section 2 above for selecting the Style).

c) The Dashes Per unit box contains the number of dashes per unit.

d) The Units per Area box contains the number of units per area. In the above example, there are 50 dashes per unit and 5 units per area. In the selected style this represents 1 Square Inch.

e) The area factor is used to say how many areas are in a Unit area. In the above example, we want a in it Area of 1 square inch and we are counting an area of 1 square inch, so the area factor is 1.
f) If we are wanting to count in column areas, rather than square areas, we need to set up a style for each column width that we want to count in. We can then use the Column Width (in Areas) value to specify how wide out column is. In the above example, we are counting areas of one square inch and are wanting to count column inches on a 13p3 Measure. We there the column width in areas is 2.08.

A Warning about Fonts. The styles shipped with the sample count in Geneva. That is because all systems should have a geneva font on them. However, different results may be obtained with different types of fonts. For example, True Type Fonts and Postscript Fonts may not count the same. It is therefore imperative, that before using the standard measures and styles, you test the basic areas. This can be achieved by setting a 1 Inch Square box and applying the appropriate style and then inserting Hyphens. Try boxes of different sizes.
Press2Go Jump Documents

Reflows stories across QuarkXPress documents.

Press2Go Jump Documents is an XTension for QuarkXPress that allows an operator to open automatically all pages associated with jumps and re-flow the story.

Why you need Jump Documents.

In QuarkXPress you can link text boxes over a number of pages within one document. As text is edited and flowed, the copy flows and re-flows appropriately.

But a problem arises when you want to flow a story between different QuarkXPress documents: you have to adopt a cut- and- paste approach.

This produces stories that are broken across documents and cannot be satisfactorily kept up- to- date.

Such an inability to link pages means either most of the publication has to be kept in one document, which is unproductive, or you have to make links through cut- and- paste that cannot easily be edited on the page.

Jump Documents solves this problem by letting you link story areas in different documents. The links allow stories to be flowed across and among any number of story containers and pages.

If stories are edited, you can update the changes automatically across the text areas and pages involved. A chaining tool is used; and you can make and break links at will.

Using Jump Documents.

First save the pages that are to be linked together. If you try to link to a page that has not been saved, the software will ask you to save the document before proceeding.

You open the Jump Documents tool through the View menu in Quark. Simply select 'Show Jump Documents'. At this point you should have all the pages you wish to link on your desktop.

1. Draw the text areas to be linked using the QuarkXPress text- box tool.
2. Open Jump Documents.

You will see the moveable toolbox. It has three buttons:

The top button links documents.
The middle button breaks these links
The bottom button lets you update the text chain if the shape or content of any of the boxes has changed.

Select the top button.

3. Click on the first box in the chain.

4. Click on the window of the second document to select the page, then click on the second box in the chain. This forms the link. You will see a linking arrow head off the left-hand side of the first box and enter the right-hand side of the second

5. Now you can link subsequent pages in the same way by going from second to third, and so on.

Flowing text between documents.

To open text onto flowed text areas created by Jump Documents simply use the Get Text command as you would in QuarkXPress. This opens the text file and flows in the copy.

If the story is linked to other pages which are not yet open on your desktop, the program will open these pages and flow in the text. This happens provided such pages are not being worked on by other users on your network.

Once the text areas are available, they can be opened manually and text update button used to update the link.

Editing linked stories.

You can resize, change or delete any text area and maintain the integrity of the links.

All you need do once the copy edit or text container shape change has been made, is click on the bottom ‘Text Update’ button. This re-flows the story throughout the relevant pages.

How to install Jump Documents.
1. Insert the install disk into the floppy drive of your Macintosh. You must unlock the disk to install; thereafter you can lock the disk to prevent accidental erasure.

2. Drag the Jump Documents icon into the QuarkXPress folder.

3. Start QuarkXPress. Jump Documents will load. You can then quit QuarkXPress and remove the floppy disk.

This is now your master disk; we strongly recommend you copy it and safely store the copy and original, preferably with your QuarkXPress master disks.

If your copy of QuarkXPress becomes corrupted and you need to re-install, simply copy Jump Documents back into your QuarkXPress folder.

The Press2Go range.

Jump Documents is part of the Press2Go range designed to simplify newspaper and magazine production for users of QuarkXPress.

Each product solves a specific production problem, and is the result of Atex's long experience in newspapers.

As a recognized XTension for QuarkXPress, Jump Documents works with any copy of QuarkXPress 3.1 or later.

Atex is a trademark of Atex Publishing Systems Corp. Press2Go is a trademark of Atex Publishing Systems Corp. QuarkXPress, XPress and XTensions are registered trademarks of Quark Inc. All company and product names are trademarks or registered trademarks of their respective owners.

If you have any questions please contact your local Atex office:

Australia: 61-3-690-7577  Netherlands: 31-1041-39050
Denmark: 45-4-343-0800  Norway: 47-289-7200
Germany: 49-6105-93  Sweden: 46-8-734-3500
Israel: 97-22-346-180  Spain: 34-332-30600
Italy: 39-2-824-2541  UK: 44-525-382-304
New Zealand: 64-93-098-034
MANAGING EDITOR SOFTWARE

Setting up the Ad and Page Director Demonstration Files

1. Make a new folder on your hard drive and name it "Managing Editor".

2. Open demonstration disk(s) and copy contents of disks into the newly created "Managing Editor" folder.

3. Eject the demonstration floppy disk(s) from your computer. (You will be working only with the files on your hard drive).

4. Double-click on the application icon "Ad Director 1.5 Demo.sea". Click the "Save" button to save the folder at the current location. (The application will unpack and create a folder called "Ad Director 1.5 Demo". SEA stands for self-extracting application).

5. Repeat this procedure on the other seas and unpack their files:
   • Ad Director Demo Files
   • Demonstration Files
   • PD 1.6 App/Dem Folder

6. Open this new folder "Ad Director 1.5 Demo" and move the folder "Ad Director Demo Files" onto it.

7. Open the folder called "PD 1.6 App/Dem Folder" and place the Page Director Demonstration files into it.

8. To avoid confusion you may wish to remove/trash the self-extracting applications (diamond shaped icons with the extension ".sea" in their names).

9. You are now ready to start working with the programs.

The Ad Director Demonstration

1. Open the folder "Ad Director 1.5 Demo" and double-click on the Ad Director icon (it looks like a director's chair). By the way, make sure the person who dummies your publications is by the computer. (Note: This is a set up.)

2. Cancel out of the issue specification window.

3. Go to the "Edit" menu and select "Change Prefs File..." from the "Preferences" hierarchial menu (near the bottom of the Edit menu).

4. Select the "Ad Director Demo Files" folder in the file dialog and click the "Open" button. Then, open the "Texas Star" folder. Select the preferences file named "AD Prefs Texas." (You will be asked to confirm the preferences change and told that the preference file will be copied. Click "OK" in both of the alerts).

5. From the File Menu select "Open".
6. In the file selection dialog box move back to your “Ad Director Demo Files” folder and into the folder named “Texas Star.” Open the file “Texas Star.issue”.

7. From File menu select the “Import Ads” function. A dialog box will appear on your screen. Select “ST First Map” from the “Import Map” pop-up menu located at the bottom of the dialog box, and open the file “Texas Star Ads.” A thermometer-type box will appear on your screen. As Ad Director reads the ad information, the total number of ads should increase. The runsheet window, which should be open on your screen, will fill with the 131 ads scheduled for this publication. You can scroll through the runsheet to see what ads will be placed in the issue.

You may drag the names from the list onto the pages one by one or... Get ready, this is the fun part... for now though, close the runsheet window by clicking in the upper left-hand corner of the window.

8. Locate the “Tools” palette (you will need this for the next function). First, though, hold down the “X” key and click anywhere on the layout. This should squeeze many pages onto your screen. Now, click on the black square with the “A” (Automatic layout) and see how fast we can place 131 ads on to 64 pages. If the “Tools” palette is not visible, select “Tools Palette” from the “Windows” menu.

9. Sit back and watch as Ad Director dummies and entire issue in a matter of seconds.

10. To view some of the ad layouts, locate the magnifying glass in the bottom left-hand corner of the window. Click on it and hold it, scroll up to 6.25%. You should be able to see how the ads have been placed throughout the issue.

11. From the “File” menu choose “Quit” to leave Ad Director.

For more information about Ad Director 1.5, call us at (215) 886-5662.
The Page Director Demonstration

1. Open the folder "PD 1.6 Folder" and Double-click on the Page Director icon (it looks like a director's chair). By the way, go grab one of your editors who just put in another 12-hour day. (Note: This is another set up.)

2. Cancel out of the issue specification window.

3. From the File Menu select "Open Issue."

4. In the file selection dialog box move back to your "Managing Editor" folder and into the folder "PD 1.6 App/Dem Folder". Open the file "PD News Demo".

5. Select "Done" if the window "Couldn't Find the Following Files" asks you to do so. We can show you how to link files later. For demonstration purposes, we have created some layouts without links.

6. The demo layout will appear. You should see a two-page spread, the front page of the section, as well as page 8. We have already paginated the front page with our own propaganda-like headlines and copy.

7. You can move through the issue by typing numbers in the Go Page box located in the lower left corner of the window. Since a flashing cursor already exists, just type in the page number you want to see and hit the return key. There are only eight pages in our demonstration section. (Note the empty columns on pages 3 and 4. We will be paginating them in this demonstration.)

8. Locate the tool box window and double-click on the "Items List" icon. The Items List window will appear. Many grayed-out items appear on the list. We have placed these items on pages. Now, scroll down the list using the scroll bar on the right side of the window. At the bottom of the list, six items should appear in black type. You will place those items on pages.

9. In the Go Page box, type "3" and hit the return key. This will bring you to page 3. Move the items list away from page 3.

10. From the Items List window, grab the item marked "Veggies p.3". As noted in the Items List, that item is a headline, with an "H" notation. Drag it anywhere on to page 3, and the page will turn black. Release the mouse and the headline will be placed on the page. Grab the headline on the page and force it to the top of the page. Page Director will automatically force it to the top guide.

11. Now, grab the item marked "Broccoli" in the Items List and repeat the "drag and place" procedure to page 3. Once on the page, grab our Broccoli picture and position it in the outside two columns, covering the Veggies headline. Note that Page Director positions the photo under the headline.

12. Well, now we're jumping, and so will you. Not literally, but from page 1 to page 3. Type "1" in the Go Page box and locate the story "Facts" on page 1. Click on the story and a tab noting jump length in inches will appear at the bottom of the story. Double click on that tab and your cursor will turn into a text block.

13. Type "3" into the Go Page box, and you will be transported along with your text box cursor to page 3. Find the first column on the upper right side of page 3 under the headline and click once. A text box will appear in the column. Note that it filled down to the next story. Click once on the box and it shows handles
(small, black boxes in corners) and tabs. Grab the upper right handle, and drag it over the next column and the headline. Page Director has created a two-column box for you.

14. Repeat the jumping procedure from the new text box to the columns underneath the Broccoli photo. You have just jumped your first Page Director story. The program can be modified to automatically insert “To” and “From” jumplines in your publication’s style.

15. Now, we know you’re having fun. So, let’s quickly assemble page 4. You’re starting to become a Page Director expert already, so you may anticipate the next instruction. That’s right, type “4” in the Go Page box. Oh no, an empty page and deadline is in 20 minutes.

16. Ready...move the Items List off page 4. Grab the item marked “Page 4 Graphic”, and place it on the page. Grab it and force it to the top of the page. Now, grab the item “Caption p.4” and place it on the Graphic. Page Director forces it underneath the Graphic. Repeat the procedures with the items “Headline p.4” and “Copy p.4”.

17. Page 4 is completed with plenty of time to spare.

18. You can explore some of the rest of the functions of Page Director, but some of the items which are make pagination easy are headline and caption styling and measuring functions. There is also the ability to view copy and graphics when items are linked to their original files. (Note: For demonstration purposes, the items are unlinked and unviewable.)

19. This demo, however, only begins to explore Page Director’s powerful features. After you have finished your Page Director layouts, they can be imported into Quark XPress, complete with photos, graphics and text in tact.

20. To quit this demonstration, from the “File” menu choose “Quit” to leave Page Director. But, if you want to test out Page Director Classified, keep the demo running and read the directions below.

The Page Director Classified Demonstration

1. Open the “PD Classified Demo” like you did in steps 3 and 4 of the PD demonstration. By the way, go get the classified worker who makes sure all the columns are justified and “filled” properly. (Note: This is yet another set up.)

2. Skip “Find Files” by repeating PD demo step 5. We could not include the Xtags files on this demo.

3. Under the “Edit” menu select “Clear From Pages”. A dialog box will appear; check off “Clear Advertising” by clicking on it; hit Okay and the classified ads on the page will be removed to the Items List.

4. Open “Items List” on the tool box by double clicking on the icon.

5. At the bottom of the window, click and hold “Kind” and select “Advertising.”

6. At the bottom of the “Items List” go to “Actions”; click and hold, and choose “Select All.”
7. With ads selected, go up to the “Page” menu and select “Flow Selected Items.” We’ve selected all the preferences, but one. Look for the check box “Vertically justify items”. Click it, then hit “OK.”

8. Sit back and watch Page Director Classified flow in the ads. Move to page 2 by typing “2” in the Go Page box. Note how the ads flowed around the display ad. Now move to page 3 by typing “3” in the Go Page box. Not again, there weren’t enough ads to fill the page. No Problem!

9. To square the items to the top of the page (justified) over three columns, select the page by depressing the command (or apple) key and clicking the page with your mouse pointer. Under the “Page” menu find “Square Page” fill in the columns over which you want items flowed between (1 & 3) in the appropriate boxes and choose Vertically Justify as before. Hit “Okay”.

10. The ads squared to the top of the page, and any spaces you may see can be filled with “Filler” items you program into Page Director Classified.

11. The demonstration is done, so choose “Quit” from under the “File” menu and the demonstration will quit.

Unless you didn’t call them to the computer, you should, by now, have an Advertising Manager, Editor and Classified Manager clamoring for more, and Managing Editor Software, Inc. wants you to know the real power of Ad Director 1.5 and Page Director 1.6, but it requires in-depth explanation (and, of course, our sales pitch). To learn more about our programs, call 215-886-5662.
Press2Go Editor is an XTension for Quark XPress that allows an operator to easily edit copy in Quark XPress.

Why you need Press2Go Editor.

As a Quark user you will frequently want to edit copy in Quark. You will know that process typically involves zooming into the page so that the text is large enough to edit in WYSIWYG (what you see is what you get). Editing like this can be difficult and time consuming typically you are zoomed in so close to the copy that it is impossible to see the impact you are making on the rest of the story. Press2Go Editor solves this problem. The editor window allows you to edit copy in a variety of ways using a comfortable typeface and size showing the line endings leg and box breaks etc. without you ever having to zoom onto the page to work WYSIWYG.

How to install Press2Go Editor.

Simply drag the XTension into your XTensions folder and restart Quark. You will be asked for a serial number. This number is on the original disc. Please enter it. You should now store the disc somewhere safe. If for any reason you need to re-deliver the Xextension you will need to enter the serial number again.

To remove the Editor XTension, drag it from the Quark XPress folder to the trash and restart XPress.
Using the Editor

The editor is easy to use

1. Click on the story you wish with the text cursor tool.

2. To open the edit window hit Apple Key and 5

3. This displays the edit window in which ever mode the window was last used.

4. Experiment with the three display modes.

Draft  No line endings or story breaks just copy in the edit font.
Edit  Line endings and story turns displayed but the copy is in the easy to read edit font
WYSIWYG  This displays the type in the type face and size it appears on in the page but with line endings and story turns etc.

Edit the copy by clicking in the edit window and typing, cutting and pasting deleting etc. As you make edits you will need to see what changes these edits have had on the Quark story. To do this simply select option H from the keyboard and this will Hyphenate and Justify (H&J) the copy so as to reflect the effect of your changes on the Quark page.

Alternately you can H&J by clicking on the double arrows key on the bottom right hand corner of the editor window.

5. Now experiment using the style change options on the tool bar at the bottom of the Editor window. You will see that these give you access to the normal Quark Xpress style tools and they let you change type face and font and size from the tool bar. They also give you access to the various Quark display and alignment modes such as underline, bold, ragged right, as well as typographic style sheets attached to the document.

6. If you want to keep the edits you have made simply click Apple Key 6 and the window will close saving the changes as it does it. Alternately click on the tick or check mark in the bottom right hand corner of the edit window and the same thing will happen.

7. If you do not want to save the changes close the window by clicking on the top left hand button of the window and select don't save changes. Alternately select the cross from the bottom right hand corner.
Setting Up the Editor

You will have noticed that in the Draft and Edit modes Press2Go Editor gives you on screen messages which tell you where the turns in columns box and obstruction breaks occur. You can control what these messages say through the Press2Go Preferences dialogue.

Setting the Preferences

1. Select P2G Editor from the Edit Preferences menu bar.

2. Choose what words or symbols you would like to insert at various points in the story. If you have a black and white or grey monitor you may find it easier to insert symbols of various kinds rather than words. For example you might want to use ********** as the column break and @@@@@@@@ for the end of the story. You decide.

3. If you have a colour monitor you will see that the messages appear in various colours. You may choose the colour of these messages by clicking on the colour boxes at the end of the messages in the preferences menu. Use the colour wheel to select the colour you require.

Selecting The Type View

Press2Go Editor comes delivered with three edit display modes. These are Draft, Edit and WYSIWYG. You will probably find these adequate for your needs. However you may choose what each of these modes display. For example you might not want the WYSIWYG display mode to show line endings. The left hand side of the preferences menu lets you control these parameters. It allows you to select the font face and size which is used in the edit window.

Press2Go Editor comes delivered with Courier as the edit font but you might prefer to use Helvetica or another font you have loaded on your system. You can also choose to show invisibles and or discretionary hyphens in the editor window.
Notes Mode

Selecting the Notes Mode Face

The editor lets you out type into 'notes mode'. These are inline notes which are visible in the editor but invisible on the Quark page. This feature allows you to cut copy to fit whilst keeping the original material in the file for future use. In the preferences window you will see a 'more' button. This button gives you another screen which lets you choose the colour and the display mode of copy in the notes mode face.

Using Notes Mode

Notes mode is very simple to use. In the Editor simply select over the text you would like to put into notes mode and click on the note pad icon at the bottom left corner of the window or the note pad icon in the bar which changes the text alignment. This copy is now in notes mode and will not appear on the Quark page. To take copy out of notes mode simply select the copy again and click the note pad icon again. The copy will once again be back on the page.

Press 2Go for Layout Preferences

You may also notice in the set up window which lets you choose the notes mode face references to a Press 2Go for Layout Preferences file. This option is only relevant to customers using Press2Go for Layout and this feature is documented in the release notes for that product. Other users may ignore this feature.

The Press2Go Family

Press2Go Editor is part of the Press2Go family designed to simplify newspaper and magazine production for users of Quark XPress.

Each product solves a specific production problem, and is the result of Atex's long experience in newspapers.

As a recognised XTension for Quark XPress, Editor works with any copy of Quark XPress 3.1 or later and only any Macintosh at a 68020 hardware level or higher.

Atex is a trademark of Atex Publishing Systems Corp. Press2Go is a trademark of Atex Publishing Systems Corp. Quark XPress, XPress and XTensions are registered trademarks of Quark Inc. All company and product names are trademarks or registered trademarks of their respective owners.
If you have any questions please contact your local Atex office:

Australia: 61-3-690-7577
Denmark: 45-4-343-0800
France: 33-14-774-7781
Germany: 49-6105-93 10
Israel: 97-22-346-180
Italy: 39-2-824-2541
Latin America: 305-733-1887
New Zealand: 64-93-098-034
Netherlands: 31-1041-39050
Norway: 47-289-7200
Singapore: 65-270-2800
Sweden: 46-8-734-3500
Spain: 34-332-30600
UK: 44-525-382-304
U.S.A.: 1-617-275-2323

Short Cuts in Press2Go Editor

Legend
(E) In Edit Window Assume this if not stated otherwise.
(Q) In Quark XPress
(Q&E) In Edit Window and Quark XPress
CMD- Command Key
SHIFT- Shift Key
CNTL- Control Key
OPT- Option Key

Keystroke Function

CMD-5 (Q) Edit Current Story
CMD-6 (E) Cancel
CMD-7 (E) Save
CMD-8 (E) H&J
CMD-H (E) H&J
CMD-9 (Q&E) Increment Display Type (EDIT->DRAFT->WISIWIG->EDIR...)
CMD-0 (Q&E) Dectrment Display Type (WISIWIG->DRAFT->EDIT->WISIWIG...)
CMD-- (E) Conditional Hyphen

INS(HELP)- (E) Toggle Insert/Overstrike Mode
HOME- (E) Top of story
END- (E) Bottom of story
PAGE UP- (E) Up one screen load
PAGE DOWN- (E) down one screen load

CMD-Z (Q&E) Undo
CMD-X (Q&E) Cut
CMD-C (Q&E) Copy
CMD-V (Q&E) Paste
Xtags

1. Overview

Xtags is an XTension for QuarkXPress providing an enhanced (input-only) version of the XPress Tags language. Xtags is currently invoked by selecting the “Get Text with Xtags...” item of the File menu in XPress.

Xtags adds several major language features to the basic XPress Tags language: the ability to create and fill an anchored text box in-line, the ability to create and fill an anchored graphic box in-line (with any picture type supported by XPress), the ability to apply simple string substitutions to its input, before tag interpretation, and the ability to apply a new master spread to the current spread (in two flavors).

2. XPress Tags Language

Xtags supports the full XPress Tags 3.0 and 3.1 language, as defined in the QuarkXPress 3.0 Reference Manual, Appendix C, and further defined by the XPress 3.1 release notes. (We won’t repeat that Appendix nor those release notes here, though the Xtags product manual may cover the entire language.) This section details a few language features not documented in Appendix C, but nonetheless part of the XPress Tags language and implemented by Xtags.

Incremental leading. In the Set paragraph formats tag, *p(...), incremental leading is indicated by a “+” or “-” prefixed to the leading (fourth) parameter. E.g., *p(0,0,0,+2,0,0,0,g) signals a paragraph format with no indents nor space around, with an incremental leading of 2 points (see the Reference Manual, page S.15, for a discussion of incremental leading).

Keep-together “none.” The undocumented tag *kt0 means “keep-together no lines of the current paragraph.”

Embedded line breaks. In a tag (inside the <...> brackets), the sequence “:<f>” (colon followed by a return) is ignored. This provides a way for long tag sequences (such as style definitions) to be broken into multiple lines for readability.

3. Language Enhancements

Xtags provides several enhancements to the base language, outside of the new tags that it supports.

Xtags treats printers quotes “ and ” the same as straight quotes " in tag sequences; e.g., <&m"Master A"> is entirely equivalent to <&m"Master A">, <&m"Master A">, <&m"Master A">, and <&m"Master A"> (look closely to see the differences).

Xtags is a little more forgiving about white space (tabs and spaces) in tag sequences than XPress Tags. E.g., <z 10> sets the current font size to 10 in Xtags, while causing an error in XPress Tags. Similarly, white space around elements in list-based tags is permitted in Xtags; e.g., <*p(35 , 0, 0)> works fine but causes an error in XPress Tags.

In Xtags, any numeric size or distance parameter may be given in any unit system supported by XPress (XPress Tags only supports unitless points). E.g., <*p(1",2p,3pt,0,6,6)> will create a paragraph with left indent of 1 inch, a first line indent of 2 picas, and a right
indent of 3 points. (The default units are still points, as in XPress Tags, so the space above and below will be 6 points.)

However, note that all style tags that take a single numeric parameter (e.g., \texttt{<zn>}) must still be given a unitless number \texttt{n} (in points), because of the ambiguity that would otherwise be involved (does \texttt{<3p>} mean 3p of point size, or 3 points, followed by the "p" tag? To take advantage of Xtags' unit flexibility, any tag that takes a single numeric parameter is extended to also accept a parenthesized parameter, with full unit specification permitted inside the parentheses. E.g., \texttt{<z(1")>, <z(72pt)>, <z(6p)>} are all the same as \texttt{<z72>}.

Xtags will treat any omitted parameters to the *p() tag by leaving the corresponding setting unchanged. Thus, \texttt{<*p(,,6)>>} will change the leading of the current paragraph to 6 points and leave all other settings unchanged. (This is particularly useful in translation target strings, where the translation needs to affect just one or a few of the many paragraph settings covered by *p().)

In Xtags, any omitted parameters to other tags, such as *ra(), *rb(), etc., will take on the default values given by the corresponding XPress setting dialog. E.g., \texttt{<*kt(2)>>} will default to \texttt{<*kt(2,,2)>>}, and \texttt{<*ra(3)>>} will make a rule above of three points' width, with the default style (single line), color (black), shade (100%), horizontal offset from left and right (0), and vertical offset (relative, 0% offset). (The one exception to this rule is that anchored text boxes' text inset will default to 0 points, instead of the XPress Item>Modify dialog default of 1 point.)

Xtags supports simple computations based on current settings, for those tags that make sense: \texttt{z} (size), \texttt{s} (shade), \texttt{h} (horizontal scale), \texttt{t} (track), and all *p (paragraph) numeric parameters. The computations are of the form \texttt{".+n", \".-n", \".*n", \"./n"}, for addition, subtraction, multiplication and division, respectively. In the multiplicative cases, \texttt{n} must be a simple factor, while in the other cases, \texttt{n} is whatever its context requires it to be (e.g., in the case of the \texttt{z} (size) tag, it's a unit-based value, while in the case of the \texttt{t} (tracking) tag, it's just a relative number, and in the case of the \texttt{h} (horizontal scale) tag, it's a percentage).

E.g., the tag fragment \texttt{<*p(.+0.5",".+0.5")>} increases the current paragraph margins by one-half inch on both sides, \texttt{<z(\* 8)>} decreases the current font size by 20% (sets it to 80% of its current value), \texttt{<h(-20)>} decreases the horizontal scale by 20%, \texttt{<z(+20)>} increases the current font size by 20 points, \texttt{<z(-3p)>} decreases the current font size by 36 points, etc.

4. Create/Start and End Anchored Text Box Tags (&tb and &te)

The Xtags-only tags \texttt{&tb(...)} and \texttt{&te} are used to create and fill anchored text boxes; \texttt{&tb ("text box begin")} defines the anchored box and implicitly starts the text flowing into the box, while \texttt{&te ("text box end")} ends the text flowing into the box. Any missing parameters are defaulted reasonably, so you only have to specify those of interest.

The parameters to the \texttt{&tb} tag are as follows:

\begin{verbatim}
&tb(width, height, textalign, framewidth, framecolor, frameshade, framestyle, 
bgcolor, bgshade, textoutset, 
columns, gutter, textinset, baseoff, basemin, vertalign, interparamax)
\end{verbatim}

where all dimensional (size) numbers are in points, percentages are numbers from 0 to 100 (fractional percentages are supported), the case of literal parameters doesn't matter.
(e.g., “A” and “a” are the same), and where the parameters have the following meanings, with the default setting (that used if the given parameter is omitted) in brackets:

- **width**
  - the width of the text box (from 10 to 3456) [72pt];

- **height**
  - the height of the text box (from 10 to 3456) [72pt];

- **textalign**
  - either “A” for ascent alignment or “B” for baseline alignment of the box: ascent alignment means that the top of the created text box is aligned with the ascender of the tallest character in its text line (if any), and subsequent lines wrap around it below; baseline alignment means that the bottom of the created text box aligns with the baseline of its line (as if it were just a text character) [B];

- **framewidth**
  - the outline width of the box’s frame (from 0 to 504; 0 means invisible) [0];

- **framecolor**
  - the color of the box’s frame (e.g., “White” or just one of the unquoted literals C, M, Y, K, or W for the four subtractive primary colors plus white) [K];

- **frameshade**
  - the shade of the box’s frame, as a percentage from 0 to 100 [100];

- **framestyle**
  - the style of the box’s frame, as a frame style index from 1 to the number of frames currently installed (see the Item>Frame... dialog for a sequential list of the current styles; note that this frame style index is dependent on the particular XPress Data (3.0) or XPress Preferences (3.1) currently in use; i.e., beyond the built-in 7 algorithmic frame styles, the other frame style indices may change as you add new bitmap frame styles with the Frame Editor) [1];

- **bgcolor**
  - the background color of the box, or the literal “N” for “none,” “no color” [K under 3.0, W under 3.1];

- **bgshade**
  - the shade of the background color of the box, as a percentage from 0 to 100 [0 under 3.0, 100 under 3.1];

- **textoutset**
  - the text runaround or outset, on all four sides (from -288 to 288) [0];

- **columns**
  - the number of columns in the text box (1 to 30) [1];

- **gutter**
  - the gutter width between columns (from 3 to 288; may be set to 0 if columns is 1) [3pt];

- **textinset**
  - the size of the text margin on the interior of the frame, on all four sides (from 0 to 288) [0pt, which is not quite the XPress default, but is a more suitable default for anchored boxes];

- **baseoff**
  - the offset of the first baseline in the text box (only used if it’s larger than both the type size and the textinset (see above); from 0 to 648) [0];

- **basemin**
  - where the top of the text is, if the textinset value is used for the first baseline: either the literal “C” to use the font’s capital height, or “A” to use the font’s ascent height, or “” (empty) to use the font’s ascent height (empty is a good default) ["”];

- **vertalign**
  - vertical alignment for text in the box: the literal “T” for top-aligned text, “B” for bottom-aligned, “C” for centered, and “J” for justified [T];

- **interparamax**
  - the maximum amount of interparagraph leading, used only when vertalign is “J” (justified) (from 0 to 1080) [0].
(Note that, in QuarkXPress 3.0, the baseoff and basemin parameters are ignored, due to a problem with the XPress XTensions interface. These are obeyed under 3.1.)

The \&te tag takes no parameters. The \&tb() tag can’t appear between a \&tb() and \&te pair (i.e., you can’t have anchored boxes in anchored boxes).

When the \&tb(...) tag is encountered, the box it describes is created and placed in-line ("anchored") immediately after any preceding text, and then text is diverted into the newly-created box until the matching \&te is encountered. The paragraph and character settings at the start of the anchored box are those in effect at the point the \&tb tag was encountered. The paragraph and character settings immediately after the \&te tag are also those in effect at the point the \&tb tag was encountered. For example, in the input fragment "...<*J>Pre-box text. \&tb(...)</*C>Box text.<&te>Post-box text... ", the pre- and post-box text will be justified, while the box text will be centered.

E.g., <&tb(72, 144, a, 1.3, k, 100, 1, n, 0, 1, 2, 3, 1, 0,, t, 0)>...<&te> creates a 1" wide and 2" high anchored text box, with text flowing down around it ("ascent" text alignment), a frame width of 1.3 points, of color black, 100% intensity, style 1 (simple single line), with no background color nor shade, a 1-point text outset from the box, 2 columns, a 3-point gutter (the minimum), a text inset of 1 point (leaving an interior margin of 1 point inside the box frame), a baseline offset of 0, computed on an "ascent" basis, with the text top-aligned vertically in the box, and no interparagraph leading (which is ignored anyway).

E.g., <&tb(144, 288, b, 3, "Magenta", 25, 11, W, 100, 0, 1, 0, 0, c, j, 10)>...<&te> creates a 2" wide, 4" high anchored text box, sitting bottom-aligned on its text baseline (i.e., acting like a large character), with a dashed (style 11) 25% magenta frame of 3 points width, with a background color of 100% white, with zero text outset (so surrounding text will abut its frame directly), 1 column (and thus no gutter width), a text inset of zero (so interior text will abut its frame directly), with a first baseline offset based on the capital height only (zero baseline offset), with the interior text being vertically justified, using an interparagraph maximum leading of 10 points.

5. Create Anchored Picture Box Tag (\&pb)

The Xtags-only anchored picture box tag \&pb has the following form:

\&pb(width, height, textalign, framewidth, framecolor, frameshade, framestyle, bgcolor, bgshade, textoutset, placement, scalex, scaley, offsetx, offsety, angle, skew, pathname)

where the first 10 parameters are the same as for the \&tb text box begin tag, and where the remaining parameters have the following meanings, with defaults in brackets:

- placement is the literal “C” for centered, “F” for expand-or-shrink-to-fit, “A” for expand-or-shrink-to-fit but maintaining original aspect ratio, and “M” for manual (no special placement); any placement but manual overrides some of the other parameters as needed to accomplish the requested placement (e.g., centering will set offsetx and offsety as needed to center the picture, fitting of either sort will set offsetx, offsety, scalex, and scaley as needed to make the picture fit the containing box, etc.) [M];

- scalex is the scaling percentage applied to the picture in the horizontal direction (from 10 to 1000, 100 being "unmodified scale") [100];
scaley is the scaling percentage applied to the picture in the vertical direction (from 10 to 1000, 100 being "unmodified scale") [100];
offsetx is the horizontal offset of the picture from the left edge of the picture box (0 making the left edge of the picture coincident with the left interior edge of the box) [0];
offsety is the vertical offset of the picture from the top edge of the picture box (0 making the top edge of the picture coincident with the top interior edge of the box) [0];
angle is the angle in degrees of the picture within its (unrotated) picture box (from -360 to 360, 0 meaning unrotated) [0];
skew is the picture skew in degrees (from -75 to 75, 0 meaning no skew) [0];
pathname is a quoted file system pathname denoting the picture file to be imported (either relative to the current document's directory, if a partial pathname—one which either contains no colons or begins with a colon—or absolute, if a full pathname—including the top-level volume, all directories between the volume and the file itself, and the filename, each separated by a colon from the next element) ["""]. If this pathname empty, then no picture is imported.

E.g., the tag `<&pb(144, 72, b, 3, k, 100, 1, n, 0, 0, c, 100, 100, 0, 0, 0, 0, "pg000099.tif")>` creates an anchored picture box of 2" width and 1" height, baseline-aligned, with a standard-style 100% black frame of 3 points, no background color (nor shade), a text outset of zero, with the TIFF file “pg000099.tif” (found in the document’s directory) placed centered in the box, at 100% scale in both dimensions, no offset (which would be overridden anyway by the centering placement), no angle and no skew.

E.g., the tag `<&pb(144, 72, b, 3, k, 100, 1, n, 0, 0, c, 100, 100, 0, 0, 0, 0,"hd 80:picture:pic1")>` does the same as the previous tag, except that it places the file “pic1” as found in the directory “pictures” on the volume (disk) named “hd 80”.

6. Invoke Translation Table Tag (&tt and &tt2)

The Xtags-only invoke translation table tag &tt has the following forms:

`&tt table`

`&tt2 table`

where `table` is a quoted string naming a translation table file in the directory Preferences:Xtags: in the System Folder directory on the boot volume. (The &tt2 variant allows some additional escape sequences in the source string, as documented below; it is a separate tag only for backwards compatibility with existing translation tables.)

The translation table file is an ordinary Macintosh ASCII text file—created with any editor capable of writing a plain text file—containing a series of translations, one per line (as separated by returns), each of the form:

`source target comments`

where each of these three elements is separated by one or more tabs. The optional `comments` field may be empty; any translation with an empty `source` field is ignored (since it makes no sense to replace the empty string with anything else).

Lexically, the first character of the first line of the translation table is taken as the comment character (if there is nothing on the first line, no comment character is defined,
which is sometimes desirable): any appearance of the comment character on subsequent
lines causes it—and anything after it on the same line—to be ignored.

The employment of tab and newline as special lexical quantities implies you can’t use
them directly in source strings, but you can use them in target strings by using their spe­
cial XPress Tag forms <\#9> and <\n>, respectively; however, in the &tt2 case, you can
use the escaped forms \, \t, \n, and \b to represent a backslash, carriage return, tab, new­
line, and backspace, respectively, in the source string (but not in the target).

Once a given table has been invoked with the &tt tag, then each appearance of each of
its source strings in the Xtags input is replaced by the target string corresponding to the
matched source. An exact, case-sensitive, longest-first match is always used, such that the
longest source string that matches the input will be replaced with its corresponding target.
Only one translation table may be in effect at one time—using a subsequent &tt tag will
completely replace the effect of the previous &tt tag.

Each source and target string may be no longer than 512 characters. If any string
exceeds this limit, the excess will be quietly ignored (which is probably not what you
expect). There is no limit on the number of translations per table, other than that imposed
by available memory.

For maximum efficiency (but not necessary for correctness), all translations should
start with some otherwise little-used character (an open bracket of some sort is common).

E.g., &tt"table1" starts using the translations from the file “System Folder:Preferences:
Xtags:table1”. If the file “table1" contains the following translations:

; Sample simple translation table.
<MDNM> <P> ; normal
<MDBU> <BU> ; bold underline

then the Xtags input fragment

<&tt"table1"... «MDBU»Some text here.<MDNM> ...

will result in Xtags processing the input fragment

... <BU>Some text here.<P> ...

and producing the actual XPress text

... Some text here ...

7. Apply Master Spread Tags (&m, &mf)

The Xtags-only apply master page or spread tags (depending on whether the document
is double-sided or not) take either the form

&m"masterspec"

or

&mfs"masterspec"

where masterspec is a master page/spread specifier—either a number (index, starting at 1
for master page A), or a full master page/spread name (e.g., "Master A", "Masthead
Master", etc., as viewed and edited in the text field of the document layout palette). (In the
text below, we’ll refer to “master spread” as covering both cases of just a single master
page for a single-sided document, and a double-paged spread for the double-sided docu­
moment case.)
The temporally last master spread applied with &m to the current spread overrides any others applied on the same spread; the temporally first master spread applied with &mf ("master spread, first") overrides any others applied on the same spread.

For example, the tag &m"Master B" would apply the named master spread to this and subsequent pages (until set again with the &m or &mf tags). As another example, &mf3 would apply the third master spread to the current spread, but only if this is the first time a master spread has been explicitly applied to it.

Because the XTensions interface to master spread assignment under XPress 3.0 doesn't really work, these tags only function under XPress 3.1, and are ignored under 3.0.

8. User Interface

Xtags presents a simple interface to its user: it is invoked by the “Get Text with Xtags...” menu item under the XPress “File” menu, and then presents a slightly custom “Get Text” dialog (entitled “Get Xtags Text”), with additional controls for controlling error reporting and document hiding during import, as well as the usual Get Text controls (include style sheets and convert quotes). Xtags also has a preferences dialog, for setting its custom control defaults on a permanent basis, and an “About Xtags” box that gives the program version information and credits.

Error reporting, when selected, will insert a terse error message in the text stream at the point of each error, for help in debugging tagged input.

Document hiding, when selected, will hide the document window during import, greatly speeding up import (particularly with a lot of anchored text and graphics boxes). This option is only available under XPress 3.1.

Xtags will forge ahead in the face of errors, while XPress Tags 3.1 will simply stop importing when it encounters an error. (Though perhaps it's wise to recall the time-tested maxim “Fools rush in where angels fear to tread.”)

9. XPress Tags for 3.0 vs. 3.1

XPress Tags for XPress 3.1 changed enough that it is no longer compatible with XPress Tags for 3.0. (In particular, things like the baseline shift sign changed in meaning.) In fact, Quark recommends that you use XPress Tags for 3.0 under 3.1 if you have to exchange tagged files between XPress 3.0 and 3.1. (One detail: the version of the Quark XPress Tags XTension for 3.0 was 1.0, and the version of XPress Tags for 3.1 is 1.5.)

However, Xtags works under both XPress 3.0 and 3.1, and also properly interprets both forms of XPress Tags (3.0 and 3.1), basing any XPress-Tags-version-dependent tag interpretation on the presence of the version tag in the tagged file; in particular, XPress Tags for 3.1 outputs a <vl.5> at the start of any tagged file that it generates, and Xtags treats any file with a <vl.5> (actually greater than 0.0) as coming from XPress Tags 1.5 (for 3.1), and as coming from XPress Tags 1.0 (for 3.0) otherwise.

If this seems murky, you’re right. The safest approach is probably to just include the <vl.5> tag at the start of your file and live in the newer world.

10. Calling Xtags from other XTensions

To invoke Xtags from another XTension you should contact Atex for details.
Xtags 1.0.3 Unanchored Box Facility

Xtags 1.0.3 now includes a new unanchored text & picture box facility as described in this document. This version of the Xtags program is available exclusively through Deadline Data Systems, Inc., of Topsfield, Massachusetts.

Unanchored Box Tags

\(<\&tbu(x, y, h, w, runaround, \ldots)\> \ldots \&te>\)

\(<\&pbu(x, y, h, w, runaround, \ldots)\>\)

These two new tags place unanchored text and graphics boxes in a document. (The &te tag remains the same.)

To understand the parameter structure, compare the existing &tb/&pb tag parameters: &tb(h, w, textalign, \ldots) and &pb(h, w, textalign, \ldots). i.e., the new tags take two new optional initial arguments, and also re-define the textalign parameter to be a runaround specification; otherwise, the arguments are the same. (And the height and width parameters have the same meaning as before; note that they may not be larger than the current page size in either dimension.)

The x, y parameters are optional; if present, then the box is placed with its top left corner at x, y on the current page (though “current page” is actually fraught with complexity; it’s best to use these position parameters only if you’re building one page); if x, y are absent, then the box is placed “more or less” where it would have been placed, if it had been anchored with an “ascent” alignment (i.e., the top of the box will be placed at the top left of the current insertion point at the time of this tag).

If either kind of placement causes the bottom of the box to protrude past the bottom of the page, then the box is moved up so its bottom coincides with the page bottom. Independently, if the right edge of the box protrudes past the right edge of the page, then the box is moved left so its right edge coincides with the right edge of the page.

The runaround specification is either “I” (for item runaround) or “N” for no runaround; these are case-insensitive, as with most of the single-character keys. The default runaround is item, which is usually what you’d want.

One caveat, due to an XPress limitation/quirk: if you’re going to use back-to-back unanchored box tags (which is normal if you’re flowing in a whole set of boxed ads, e.g.) with no intervening text, then you should first insert enough pages to hold all the boxes (taking care to link these pages into the main text flow) and then do the import. Otherwise, after two pages, XPress will overflow the automatic text box (even though it should keep
creating pages, logically speaking) and you'll get an Xtags error (Can't place box: text overflow) for each unanchored box from that point on.

(This quirk exists because XPress decides that if it can't display some text (even just the insertion point, if there's no text in the story) after two pages of auto text box creation, then it should just give up. Normally, it should, but in this case, it shouldn't. There are some possible workarounds available to Xtags, but some of them have already been attempted unsuccessfully; the remaining workarounds are fairly drastic and ugly.)

**Xtags 1.1 Configuration of file types**

Xtags 1.1 now includes a new facility for configuring other file types to be considered as "text" files in the "Get Text with Xtags..." dialog.

**Xtags 1.1 (Atex) Unanchored Box Facility with Relative placement**

Xtags 1.1 now includes a new text & picture box facility as described in this document. This version of the Xtags program is available exclusively through Atex Publishing Systems.

The Unanchored Box Tags have been extended to include placement relative to the current box.

```xml
<&tbur(x, y, h, w, runaround, ...)> ... &te>

<&pbur(x, y, h, w, runaround, ...)>
```

These two new tags place unanchored text and graphics boxes in a document. (The &te tag remains the same.) the x and y parameters (optional) are relative to the top left corner of the current box.

**Conversion Tables**

Finds the conversion file in the preferences folder of system in foreign languages now!

**Atex Headers**

XTags modified to work with Press2Go Atex Headers so that Atex Headers will be able to find headers placed by XTags.
Xtags 1.1.3 (Atex) Draw Line

Xtags 1.1.1 now includes a new Draw Line facility as described in this document. This version of the Xtags program is available exclusively through Atex Publishing Systems.

\langle dx,dy,wd,ht \rangle

or

\langle dx,dy,wd,ht,pl \rangle

\text{x:} \quad \text{X Position of Rule See Relative.}
\text{y:} \quad \text{Y Position of Rule See Relative.}
\text{width:} \quad \text{Width of rule}
\text{Height:} \quad \text{Height of rule}
\text{Placement:} \quad \text{B or P or C}
\text{B - Relative to top left of current box. (Default)}
\text{P - Relative to top left of page.}
\text{C - Relative to current position.}

The rule is drawn from the bottom left corner upwards and to the right. (i.e. \text{x,y} is 0,0).

Xtags 1.1.4 (Atex) Conversion Tables

Also, the source of \langle \texttt{2} \rangle Conversion tables now permit the specification of characters as follows. In the replacement string, use the Quark Tag \langle \#183 \rangle

Also handles:
\text{%ddd} where ddd is 0,1,2, or 3 octal digits
\text{%dd} where ddd is 1,2, or 3 decimal digits
\text{%dd} where ddd is 0, 1 or 2 Hexadecimal digits
\text{%Xdd} where ddd is 0, 1 or 2 Hexadecimal digits
\text{%Xdd} where ddd is 0, 1 or 2 Hexadecimal digits
\text{%Xdd} where ddd is 0, 1 or 2 Hexadecimal digits

Examples

\text{\%0xF,\%0377,\%9,\%29,\%0x1f,\%0xFF,\%0x40,\%f}
Xtags 1.1.5 (Atex) Notes Mode

Xtags 1.1.5 now includes a new Notes Mode facility as described in this document. This version of the Xtags program is available exclusively through Atex Publishing Systems.

The notes are invisible to normal Quark Xpress. To view and manipulate notes you need Press2Go Editor.

<&bn> Begin Note
<&en> End Note

Any text between these will be stored in Notes Mode.

Xtags 1.1.6 (Atex) XTLoad Installation

Xtags 1.1.6 now uses XTLoad technology for production and installation. 1.1.6 will only run on QXP 3.2 or later.

Xtags 1.1.6 (Atex) New Xt2Xt Calling sequence.

Xtags 1.1.6 now uses a new XT2Xt calling sequence. This has been done to:

1) Change the XTID to facilitate using XTLoad technology.
2) Change calling sequence to conform to Quark recommended protocols.
3) To facilitate additional XT2XT calls which will be available later (1.1.7 probably).

A header file and c file has been produced which both documents the new calling sequence and provides an example. These files are called P2GXtagsXt2Xt.c and P2GXtagsXt2Xt.h. To obtain copies, contact Atex.

Xtags 1.1.7 (Atex) Tag and Group.

Xtags 1.1.7 now supports a tag and group feature. This can be useful in grouping all elements of a particular story together so that they can be moved/deleted in a single operation.

Tag and group is activated using the tagname field of in the element creation commands and/or the <&tn... command.
The Tag and group commands are:

\&tb(width, height, textalign, framewidth, framecolor, frameshade, framestyle, bgcolor, bgshade, textoutset, columns, gutter, textinset, baseoff, basemin, vertalign, interparamax, tagname)
\&tbu(x,y,width, height, textalign, framewidth, framecolor, frameshade, framestyle, bgcolor, bgshade, textoutset, columns, gutter, textinset, baseoff, basemin, vertalign, interparamax, tagname)
\&tbur(x,y,width, height, textalign, framewidth, framecolor, frameshade, framestyle, bgcolor, bgshade, textoutset, columns, gutter, textinset, baseoff, basemin, vertalign, interparamax, tagname)

\&pb(width, height, textalign, framewidth, framecolor, frameshade, framestyle, bgcolor, bgshade, textoutset, placement, scalex, scaley, offsetx, offsety, angle, skew, pathname, tagname)
\&pbu(x,y,width, height, textalign, framewidth, framecolor, frameshade, framestyle, bgcolor, bgshade, textoutset, placement, scalex, scaley, offsetx, offsety, angle, skew, pathname, tagname)
\&pbur(x,y,width, height, textalign, framewidth, framecolor, frameshade, framestyle, bgcolor, bgshade, textoutset, placement, scalex, scaley, offsetx, offsety, angle, skew, pathname, tagname)

\&xll(x,y,width, height, Placement,tagName)

\&ntagname

tagname: the tag name is a string that names the element. All elements with the same name will be grouped together.

If the tagname is missing, then the element will not be grouped. The &tn... command can be used to tag the current box.

Example: <tbur(0,10,13p9,20p,,,"Story 1")>
Xtags 1.1.7 (Atex) Auto Group.

The Auto Group commands are:

&ag  Turns on Auto Group
&xg  Cancels Auto Group

The autogroup feature allows you to group elements without giving them a name. When you turn on auto group, all elements created, including the current element will be grouped. The <&xg> command will selectively turn this feature off.
Press2Go MultiUser

Introducing Press2Go Multi-User ................................................................. 1
Split Pages ....................................................................................................... 1
Order Stories .................................................................................................... 1
Rebuild Page .................................................................................................... 1
Operating requirements .................................................................................... 1
Using this manual ............................................................................................. 3
Part two How Press2Go Multi-User works ....................................................... 4
Copy flow with Press2Go for Multi-user .......................................................... 4
  The copy “flow” ............................................................................................. 5
  What order does ........................................................................................... 5
Basic Press2Go Multi-User .................................................................................. 6
  Setting up your Production Environment ..................................................... 6
  The default Model environment ..................................................................... 6
Delivering Press2Go Multi-User ........................................................................ 7
  Setting the Paths .......................................................................................... 8
  Setting the Order Path ................................................................................ 8
  Setting the Story Names path ....................................................................... 8
  Setting the Graphics Input Baskets ............................................................... 8
  Setting the Split Paths ................................................................................ 9
  Setting the Import Paths .............................................................................. 9
  Setting the Archive Path ............................................................................. 10
Using Press2Go Multi-User ............................................................................... 10
  Your First Page ............................................................................................. 10
  Define The Page Basics ............................................................................... 10
Laying Out the Page .......................................................................................... 10
  Element ........................................................................................................ 11
  Format ........................................................................................................... 11
  The Department Pop-Up ............................................................................. 12
  The Assign Pop Up ....................................................................................... 12
  Ordering your stories .................................................................................... 12
  Splitting the Page ......................................................................................... 12
  Rebuilding the Page ..................................................................................... 14
Advanced Features ............................................................................................ 15
  Changing Page Components ....................................................................... 15
  Updating From the Master Page ................................................................. 15
  Updating from the Client ............................................................................. 15
  The ZAP Function ....................................................................................... 15
  Using Zap ...................................................................................................... 16
  Setting Your Own Preferences ..................................................................... 16
  The Element Preference ............................................................................. 18
  The Word Processor Preference ................................................................ 18
  Balloon Help Information .......................................................................... 18
Introducing Press2Go Multi-User

Press2Go Multi-User is an Atex Quark XTension which provides significant additional editorial and production capabilities to a Quark-based publishing operation.

One of the key problems associated with working on the Macintosh is that once a page is open on the network some where it is locked out and can not be shared by other users. This can cause problems where the page contains a number of components which need to be worked on at the same time, perhaps near a publication deadline. Press2Go Multi-User allows groups of Quark users to work on the same page at the same time.

Press2Go Multi-User does many other things but the key features you need to understand are as follows.

Split Pages
- This function allows the page manager to assign various pieces of the page to different operators. These operators in turn will then be responsible for the editing and, if required, the design of specified sections of pages;

Order Stories
- Typically in a small work group stories will be written on word processors where as the page is assembled in Quark XPress. In a small magazine there might be three Quark pagination terminals being fed stories by ten word processors. Copy might be supplied from the outside on floppy disc.

The 'Order' function lets the Quark operator reserve a space for a story on the page and then start a word processor story file with the same name somewhere on the network. This file contains useful information about the shape reserved can be used by a writer in a standard word processor some where on the network. If the story already exists the 'Order' function will update the existing story.

Rebuild Page
- Everyone who has used a desk top package to make up a page knows the frustration of looking for the right story for the right box. In Press2Go Multi-User all these problems are looked after automatically. Any story shape which has been 'Ordered' will get the right text for its shape automatically when it is ready. Similarly you can reserve a shape on the page for a graphic and when that graphic is available it can also be imported automatically.
OPERATING REQUIREMENTS

In order to use Press2Go Multi-User, you will need Quark XPress version 3.1 or later and Apple Macintosh at System 7.1. Provided Quark XPress 3.1 operates satisfactorily on the work stations, Press2Go Multi-User will be compatible. You will also need a networking application.

Since Press2Go Multi-User provides an environment for a number of users, some of whom may have differing functions, a work station must be designated as a server. This may be an Apple Macintosh which is also used for Quark XPress, or a single work station specifically set up as a server.

In an environment where networking is used to a number of work stations, only the work stations where Press2Go Multi-User is installed must be Apple Macintosh. The server itself, and any other smaller work stations, need not necessarily be Apple Macintosh, provided always that a file transfer application is used to convert text to Apple Macintosh format suitable for Quark XPress.

Installing Press2Go Multi-User, and setting up a server for use with this product, are described more fully in later sections of this guide.

What this manual is about

This manual tells you how to set up and tune Press2Go Multi-User on an Apple Macintosh work station.

It is not intended as:

• A user guide for Quark XPress.
• A user guide to Apple Macintosh applications such Resedit.
• A guide to any word processing software which may be used on an Apple Macintosh.
• A guide to using networking applications, including setting up a file server, on an Apple Macintosh.

In order to use Press2Go Multi-User, you must be fully familiar with using Quark XPress. You must also have a good working understanding of setting up and tuning applications on an Apple Macintosh system.
USING THIS MANUAL

This part of your Press2Go Multi-User manual provides a brief description of the application.

In Part Two, Sections 1, 2 and 3 there are more detailed descriptions of the ways in which pages can be split and text ordered, and how these functions work.

Part Three, Sections 1, 2 and 3 provide detailed instructions for installing and tuning Press2Go Multi-User.

In Part Four, there are examples of how you can use Press2Go Multi-User in publishing environments.

Still more functions

Press2Go Multi-User provides three two facilities described above: splitting a page into sections, ordering text files and using the Atex palette and rebuilding the page automatically. You can add more functions by including any number of other Atex Quark XTension.

You should note, however, that the applications described below are not provided automatically with the standard Press2Go Multi-User.

• Press2Go Multi-User Editor provides on-screen editing of text files in a without using typical Quark XPress commands. The Press2Go Multi-User Editor updates a page (or part of a page) with each save, giving instant information on the length and style of the item as it is edited.

• Press2Go Multi-User Smart Shapes allows you to resize objects in Quark XPress. Smart Shapes controls the size and shape of individual components of a group in a Quark page.

• Press2Go Multi-User Line Count provides an accurate estimate of the depth (length) of a Quark text box. Using Line Count, a layout editor can inform a writer of the required depth of an item.

• Press2Go Multi-User Jump Documents allows a layout editor to link story areas in different documents. This means that stories can be flowed across and among any number of story containers and documents.

• Press2Go Multi-User Oops removes fixed line endings and hyphens from text in a text box which requires editing.

• Press2Go Multi-User Atex Headers is for use with the Atex J11 front-end system. When this is installed, information from headers on Atex text or advertisement files can be displayed on the work station screen.
PART TWO HOW PRESS2GO MULTI-USER WORKS

Press2Go Multi-User provides a full range of options, from the simplest in which perhaps no more than two or three work stations are used, to more complex systems which may consist of several work stations for layout, a server and smaller work stations equipped with a suitable word processing package for writing text. These work stations may not even be in the same building.

The smaller work stations, and the server, may be either Apple Macintosh or PC-based.

In a simple operation, two work stations would have Press2Go Multi-User and a server application. The designers can create story shapes on the page then order stories for these shapes. These text items may already exist on the network.

The designer will then split the Quark page so that both users can design parts of the same page (or pages) and edit returning text for those pages.

In addition, by using the special Atex palette with Press2Go Multi-User, typographical requirements (headlines and body copy style) for text items can be entered, as well as details of the publication, date of issue, edition and section (desk) can be specified for text items.

In a more extended operation, designers and editors prepare pages design story shapes then order stories for network server. This server can be accessed by the journalists or contributors who enter copy into the word processor files generated by the order process. Once the writers are happy that the story is ready for publication they release the story by saving it to a nominated 'In Progress' copy basket.

Now the Quark XPress page editors take over. Working on just their assigned part of the page the editors rebuild their pages and edit the stories to fit the available space. As they edit the story it progresses automatically from the 'In Progress' to ready Basket.

As the Quark editors work and rebuild their pages so they can watch the progress of other components of the page. All editors are able to watch the progress of the other page components on the page. This allows the operators to judge their progress in the context of the current state of the entire page.
COPY FLOW WITH PRESS2GO FOR MULTI-USER

A critical element in setting up and using efficiently any application such as Press2Go Multi-User is determining which way text should "move" from work station to work station - i.e., the copy flow. Quark XPress principles are used in designing pages with Press2Go Multi-User.

However, by using the extremely powerful additional tools - order, split, rebuild and the Atex palette (all described in more detail below) - the flow of text (copy) with Press2Go Multi-User can be structured in an orderly way so that the design and production of pages becomes simpler, follows clearly defined paths and is speeded up significantly. This section of your manual describes in more detail the copy flow process, and outlines some options for setting up this flow.

The copy "flow"

As described briefly in the previous section, stories for pages with Press2Go Multi-User may be written in word processor packages such as Microsoft Word.

If an item of text is ordered by the layout editor, and it does not already exist, it will appear in the network copy basket for the particular desk or department that journalist works for.

The author can now open the word processor file and using the information in the order file as a guide he or she can write copy for the space. If the you are using Press2Go line Count this information will include story length information such as word count or story depth.

When the author has finished writing, the text is saved to the In Progress basket. Text in the In Progress basket is available to the Press2Go Multi-User Quark copy editors, who will edit this text to fit the shape allocated on a page. When this process is finished, the approve "hot key" is used, which means that the item is now ready.

The diagram below shows a simple path: from order, which creates a text file in the In Progress basket for the publication, to in progress and finally approved.

PICTURE OF COPY FLOW HERE

What order does

Order is activated from the Press2Go Multi-User menu. (P2GMU)

When an item for a page has been positioned, order will:

1. Create a text file with the story name assigned to it by the layout person (this is done with the Atex palette);
2. Show - in the text file - information on the publication (by name), the publication date, the edition (number or name), the desk (where required), the headline style and the depth multiplier (i.e., the number of lines required);

3. If the text file is already written, append updated information to show the story information.

In addition, if Press2Go Multi-User Line Count XTension is also used, then text files created will also show any of:
- The number of words allowed for the item,
- The number of lines (related to the body copy style of the publication);
- or
- The actual required depth (in picas and points, or inches, or any valid unit of measurement for Quark XPress).
BASIC PRESS2GO MULTI-USER

Setting up your Production Environment

Your Press2Go Multi-User Press2Go Multi-User software comes pre-set with a simple production environment pre-loaded. We suggest that before you set up your own version you do two things.

Set up the default environment using the defaults and get it to work on a few pages so that you can follow the copy flow through our model publication.

Think very hard about how you would like your copy flow to work and write it down as a map. Then agree it between the key people in that copy flow. There is nothing more irritating for those concerned than to change they way they work for no reason other than that the set ups were wrong from day one!

The default Model environment

In our model office we are publishing a magazine called Multi-User Monthly

You will find a template for that publication in the demo folder.

It has one Chief editor called Chief and (he or she) has their own folder called CHIEFS PAGES.

It has four work stations called ED1 ED2 ED3 ..ED4

And you will see five folders called
Pages for ED1
Pages for ED2
Pages for ED3
Pages for ED4
Pages for ANY

These are the folders where the split pages go.

Press2Go Multi-User Monthly has five departments; News, Features, Finance, Weekend and Sport.

Each of these departments has its own copy basket called

Stories for News
Stories for Features
Stories for Finance
Stories for Weekend
Stories for Sport
These are the folders where the stories generated by order go for the journalists work on.

You will also see

Raw Copy
Copy in Progress
Ready Copy
Archived stories

......One of each for each department

These are the copy baskets, The journalists must save their finished copy into the 'In Progress Copy' basket when they are happy with their stories.

And Finally there are two graphics baskets

Pictures
Advertisements
These are the baskets for pictures and graphics.

There is also a file called Default P2G MU Preferences

If you haven't got four workstations don't worry only work with as many editorial desks as you have. If you have more for the purposes of getting the hang of delivering Press2Go Multi-User just work with five workstations i.e. CHIEF plus ED1 through ED4.

Now you need to 'drag and drop' deliver the Multi-user server folder onto a network device which can be seen by all of the other Macintoshs on the network. Typically this will be a hard drive which has been shared over the network using system seven sharing.

IF POSSIBLE NOW NAME THIS DEVICE MACINTOSH HD.
If you are able to re-name this device it will make your life a lot easier in the early stages.

DELIVERING PRESS2GO MULTI-USER

The delivery disc must be unlocked On your delivery disc you will find two versions of Press2Go Multi-User. One is called Press2Go
Multi-User Chief the other Press2Go Multi-User Workstation. Decide which machines in your system will be the CHIEF and drag and drop the Appropriate copy to the Quark folder.

If you change your mind later and want to change the work station status you may deliver the other version. Use only one install disc per machine. You have to buy one copy of Press2Go Multi-User for each machine you want to use with Press2Go Multi-User. Now start Quark. The first time you run Press2Go Multi-User it will ask you to find the preferences file. To do this you simply locate the preferences file you copied across to the server then select open. Quark will now start happily.
Setting the Paths

If you named the shared device Mac1 and delivered the folder to the
top level of the server you probably don't need to go through this bit. If
you miss this piece out and go on to XXXXXXX and it isn't working
properly go back to this and follow the following stages.

This piece is quite tedious but once you have done it once it is set
until the next major change in the structure of the office.

Now start Quark and hit the F11 key on the keyboard. If you do not
have an F11 key access the edit Atex preferences menu through the
EDIT Preferences then select Atex Preferences.

You are now going to tell Press2Go Multi-User where to put files it
creates and where to look for files it needs to rebuild the page with.

Setting the Order Path.
First look for the 'Order' radio button. Select it and then at the bottom
of the window you will see a pop up window. Click on that and you
will now see a list of the departments in Multi-User Monthly next to
that pop up is a button which says 'Select Path'. When you select one
of the departments in the publication then press 'Select path' a
standard Apple window appears such as you might use to choose the
destination of a file when you save it.

Using this window navigate to the 'Multi-User Server' folder which you
placed on the shared volume on you network. In the 'Multi-User
Server' folder locate the folder called 'Stories for X' (where X is the
name of the department you are working with) and select the folder so
that it is highlighted. DO NOT OPEN THE FOLDER.

Now that you have found the right folder click the select folder button
at the bottom of the current window. Now repeat the procedure for the
other departments in Multi-User Monthly so that Press2Go Multi-User
knows where to place the stories it generates.

Setting the Story Names path
The Story Names basket lets you prevent people from creating stories
of the same name in the same department. Obviously if two people
are simultaneously working on different stories saved under the same
name the scope for confusion and trouble is considerable.
You will find five baskets labels Story Names for News through Sport in the Multi-User Server folder. As before select the radio button and set a path for each of the departments which pop up in the window.

Setting the Graphics Input Baskets
Press2Go Multi-User can be used to automatically import graphics from somewhere on the network to any given Quark Picture box.

As standard Press2Go Multi-User recognises two different kinds of graphic component Advertisements and Pictures this is an artificial distinction because these can be any kind of graphic file recognised by Quark XPress. The maximum number of different locations which can be imported from is fifteen. So it would be quite feasible to have separate picture baskets for each department in the publication. How these are organised is entirely up to you.

To begin with we recommend that you just use the two folders which Press2Go Multi-User is delivered with. Using the F11 preferences select the ‘Graphics (In)’ radio button and find the appropriate folder on the Multi-User Server for each of ‘Pictures’ and ‘Graphics’.

Setting the Split Paths
Press2Go Multi-User achieves the useful feature of multiple people working on the same page simultaneously by splitting up the original page into copies of the page which have only one active story on each. To do this Press2Go Multi-User places a copy of the page in the appropriate page editors basket.

These baskets are on the Multi-User Server. There is one per editor called Pages for ED1 through ED4 and Pages for Any. It is possible that your publication will be set up so that there is one editor per department in which case the page editors will have the same names as the departments. You might prefer to have your editors identified by name so you might have a group of folders called ‘Pages for Bob, Pages for Ted, Pages for Carol etc. To start with use the default set on the Multi-User Server and design your own later.

Using the same technique as before tell Press2Go Multi-User where to put the split pages.

Setting the Import Paths
Now we have to tell Press2Go Multi-User where to look for text files when it rebuilds pages.

Each department has two baskets which contain copy for their pages. These are In Progress and Ready. Again on the Multi-User Server
you will find one of each of these per department e.g. 'In Progress Stories for News' 'Ready Stories for News' etc.

In practice when working all you need to worry about is the In Progress' basket because it is into these baskets that stories written by contributors are saved.

However you do need to set the import paths for these baskets. So just as before choose each department in turn and set the paths for each of 'In Progress' In progress' and 'Ready '. 
Setting the Archive Path

Finally you need to set the path for the archive feature of Press2Go Multi-User. This will let you strip all of the copy from a document and place it in a safe place on the network. These stories can either be plain ASCII text or XPress Tagged text. The selection for format is in the top right hand of the F11 preferences panel.

This function is especially useful if you plan to make a permanent record of the stories published in your publication in a form which could be accessed by any computer user who simply wanted to read the stories rather than be worried about the style of the story.

Using the F11 preferences set the archive path of each department to the Library folder in the Multi-User Server. It is possible to set a different path for each department but that creates even more folders and we don't need that option in the demo environment.

Well done you have now broken the back of the set up task!

USING PRESS2GO MULTI-USER

If you are a competent Quark user this will seem very straight forward. If you are not very familiar with Quark then you should take time out here to practise with Quark. If you don't have that time then proceed with caution!

Your First Page

Start a Quark page using the template 'Multi-User Monthly'. This template uses only fonts found in the standard Apple System delivery so you should be able to work with it irrespective of the fonts you have loaded. Save the page and keep on saving it as you work. We recommend that you set Quarks auto save to about 5 minutes.

Define The Page Basics

The first task is to define the basics of the page such as the publication name date edition etc. You do this with the F10 page parameters control panel. Hit the "F10 key or select "Edit Page Parameters " item from the Press2Go Multi-user pull down menu. Use the arrows or the pop Ups to select that date publication name etc. from this palette by clicking on the arrows or choosing from the pop up menus. The information from this palette is now attached to the document you are working on. If the document is going to have stories on it from more than one department choose the department which you think will have the most stories and use that as the
document default. You can change the individual destination of the stories as you work through the page.

Having set the basic values for that document now close the palette.
LAYING OUT THE PAGE

In Progress some story shapes onto the page. These would typically have a headline and several story boxes. Lay these out as you would normally and then link them together with the Quark chaining tool. Where you have different objects together such as a strap headline over a standard headline make sure that you create two different elements one for each component.

After you have laid out some stories press F12 or use the 'VIEW' menu in Quark to display the Multi-User Palette. Click on the headline box of one of your stories and then click on the story name box in the Multi-User Palette. Now type a story name. There is a maximum length of twelve characters but keep it reasonably short.

After you have named the story click away or hit return and the name will appear in the middle of the box you first clicked on. You will notice several other boxes have appeared also.

Some of these give information about the publication edition as set in the F10 palette, and others refer to the type content. These break down into

Element
The kind of object Headline, Body Copy, Strap Headline etc. This is supplied with a default list of ten Elements but you can change this list and have up to sixteen if you wish. In reality usually a half dozen or so suffices for most uses.

Format
This pop-up gives access to the style sheets associated with the page you are working on.

Choose an Appropriate element type from the list and then select a style sheet to go with it. If there is no style sheet suitable you can enter the typographic values for the Point size, Lead value and Font from the three pop up menus below. In any event these entered values will override the values from the style sheet. They will not however be passed to the journalist in the order file. So if you would like to be able to pass information about the style of various page components to your writers make sure that you put style sheet information into the boxes.

Once you have chosen a element type and a style to go with it you can use the Depth multiplier box to size the box to the right size for you. This box will increase or decrease the size of the box to fit type
of the lead value specified in the Quark style sheet selected. In fact what it does is produce a box equivalent to the lead value of the style sheet plus 30% (Rounded) of that value for the last line of type.

So a 2 Deck 24 point headline style would have a box 56 point deep. (24 pt + 24 pt + 8pt). This extra amount of lead lets the majority of type fit the full face height of the face in clearing any descenders etc.

You can override this ability by dragging the box bigger or smaller width the object tool in Quark or by entering your own absolute values in the type boxes in the F12 Atex Palette.

Repeat the process with the other stories on the page. You will find that the sizes you estimated for objects such as Headlines will change as you select and link style sheets to them. This may mean that you will need to move some of the other components around to take account of that.

The Department Pop-Up
The F12 Atex Palette has a 'Department' Palette this palette shows you which department will receive your ordered story. It starts by showing the default department which you choose in the F10 Document Specifications palette. You may leave it as the default or select a different destination by selecting the appropriate department in this window.

The Assign Pop Up
The F12 Atex Palette lets you choose who to send the page to for finishing in Quark XPress and Press2Go Multi-user. This pop up contains a list of the page editors in Multi-user 'monthly' (ED1 through ED5 plus Any). Choose which page editor will receive which story by clicking on this pop up and selecting one of the editors. Where you are certain who will work on which story choose that person by name where it doesn't matter who works on it choose 'Any' from the pop up.

Ordering your stories
If you are using Press2Go Line Count now is the time to count the stories on the page. Use the instructions for Line Count to build counter styles based on the styles on the style sheet and count the stories on the page before you order them.

Now that you have designed the page you can 'Order' the stories off to the writers.

Do this by clicking on the story and selecting F5 from the keyboard or 'Order Story' from the Press2Go Multi-User pull down menu. Do this
for each story in turn. You can order them all at once if you wish by selecting the option key F5 or option before choosing the order feature from the pull down menu. This will give you an 'Order Document' function. This creates all of your story files in one go.

**Splitting the Page**

Now that you have created stories for the journalists to work with you can split the page. This process creates the clone pages for each of the editors to work with. Simply click on the FXX Keyboard button or choose Split Document from the Press2Go Multi-user pull down menu. There will be a brief pause as Press2Go Multi-user performs the task. If you wish to split just one story hold down the option key as you carry out the above process.

Once the page has been split check in the folders of the Quark Editors you sent the stories to. In each chosen editors folder you will see a folder with the publication date. That folder contains another folder with the publication name and edition and that contains a folder with the page number of the first page in the document. That folder contains a copy of the document named after the story. If you now open this story in Press2Go Multi-user you will see that most of the page has a grey tint except for the story or stories assigned to that editor. The rest of the page is locked but the editor can work on the assigned story.

Also check in the journalists baskets of the departments which you sent stories to. You will find story files waiting for you. These are Teach text files by default and can be opened by any Macintosh Word processor and any PC once an appropriate translation has been performed on them. If you open one of these files you will find the following information:

Multi-user Monthly, 23-3-94, Ed 01, Page3, News, 
@Head24:2lines 
@By1: 1 Deck 
@Body:

If you are using Press2Go Line Count you will also get a line count, word count and or total story depth next to the body copy value. This allows the journalist to write the story to approximately fit the allocated space.

Using a word processor for which you have the appropriate Quark import XTension write some copy into the story file. Write it to the right of the style markers and when you are finished with the story delete the top line of the file so that the file looks like this
Our Story is called Walrus and looks like this once it has been written.

@Head24:Walrus and Carpenter in Oyster Massacre Shock
@By1:By a Journalist
@Body: The time had come so the Walrus and the Carpenter set off along the beach and were followed by a large number of oysters etc..

Save the file either as an ASCII file or as the native format for the word processor you are using. In order for the text to work in Quark the copy for the story must either be in ASCII or in a word processor format for which the appropriate Quark XTension is loaded. If you save the text as ASCII the style commands indicated by the @ sign will be WYSIWYG on the page. If you save the story in the native form of the Word processor then the copy will come on to the page with the type values given to it by the Word processor. In this case you would not want to use the @ format commands at all. So our story would look like this on the Word processor page.

Walrus and Carpenter in Oyster Massacre Shock

By a Journalist
The time had come so the Walrus and the Carpenter set off along the beach and were followed by a large number of oysters etc..

Most writers would typically prefer to work in the first way rather than the second it is easier on the eye.

When you save the file it is important that you give the file the right name. The story eventually saved back to the In Progress basket has to have the same name as the original ordered story. If it doesn't it will not automatically rebuild. The story may change name and location as it progresses but the final name must be the same as the first e.g..

The file was ordered as Walrus to the 'Stories for News' Basket

It became
Walrus first draft"
Walrus edit one'
Walrus Edit two'
Walrus Complete?
Walrus OK by Tim' in various places on the network.

And Finally it was saved as ASCII to 'Raw News Copy' as Walrus

Now write the stories onto the ordered files and save them appropriately in the right In Progress Copy baskets from each department.
Using the Managing Editor XT Pro

step-by-step instructions in your new XTension’s use

Now that you’ve installed the Managing Editor XT Pro, go to your copy of QuarkXPress and double-click on its icon to launch that program.

If there have been any errors in the installation process, or if the serial number in Managing Editor XT Pro does not match that of the QuarkXPress you are opening, you’ll receive an appropriate message and should respond accordingly.

Opening Managing Editor XT Pro Palette

To display Managing Editor XT Pro, go to Quark’s View Menu and select “Show Managing Editor XT.” Managing Editor XT Pro Palette will appear, looking like the as shown below.

You may position the palette anywhere within your QuarkXPress workspace — its location and whether or not the palette is opened or closed are remembered each time you leave QuarkXPress and will be restored when you restart the program.

The palette window can be dragged and resized in standard Macintosh fashion. When it is open on screen, the XPress View Menu option changes to read “Hide Managing Editor XT Pro.” You can close the palette either by selecting this option or by clicking in the palette’s close box located in its title bar.

To quickly move Managing Editor XT Pro from one side of the QuarkXPress workspace to another, you can hold down your option key and click anywhere in Managing Editor XT Pro palette. The palette will be redisplayed on the opposite side of the screen at the same vertical height, collapsed to its smallest size. This
Palette elements

The top area of the palette is called the Control Bar and contains the controls you use to change Managing Editor XT Pro options and perform different actions.

Beneath the Control Bar is Managing Editor XT Pro’s Editing Bar, where you can rename different Managing Editor XT Pro Sets and obtain information about files and folders.

Below the Editing Bar is the Gather List which displays different lists of elements depending upon the current view. Beside the Gather List is a scroll bar that can be used to move up and down within the list if all its elements are not visible.

The control bar

The Control Bar includes several items:

- Current View Icon: At the far left is the Current View icon which changes depending on the view you have selected using Managing Editor XT Pro’s View Menu. Right now you should be looking at Sets View.

- Alerts Checkbox: The box marked Alerts is used to turn Managing Editor XT Pro’s alerting feature on and off. When the box is checked, as it should be now, you will receive warnings whenever you are about to undertake an action Managing Editor XT Pro wants you to think about first. As you become more accustomed to the XTension, you might want to turn this feature off.

- Keys Checkbox: The box marked Keys is used to turn Managing Editor XT Pro’s extended key set on and off. When checked, Managing Editor XT Pro will “intercept” your XPress keystrokes and determine whether they should be used by Managing Editor XT Pro or by XPress. For instance, when Keys are on and you press the cursor down key, Managing Editor XT Pro will scroll down one selection in any of its lists. With keys off, XPress will handle this keystroke instead. A full list of Managing Editor XT Pro’s extended key set is included at the end of this manual.

- Trash Can: The trash can is where you dispose of any items in any of Managing Editor XT Pro’s lists. If you no longer want to keep a Gather Set, Gather Folder or an item, you can drag it to the Trash, release the element and it will be permanently removed. When Alerts are turned on, Managing Editor XT Pro will always ask whether or not you want to delete the item.
Where are your page editors?

Now you need to establish who your Quark page editors are and what they do. These are the people who will cut the stories generated by the journalists to fit the spaces for them on the page. ask yourself questions such as:

1. Does one editor work exclusively on one publication or part of a publication.
2. Does the editor work across a wide range of publications.
3. Do you change editors frequently to the point where it would be pointless identifying them by name?

You should eventually end up with a structure of journalists and editors which gives a best fit to your office or publication. Remember as long as the people involved have access to the network they don't have to be in the same place.....they don't even need to be on the same continent.

Your list should be essentially a list of

Publications

Departments (these may be publications of sub sets of publications)

Editors (these might be peoples names, editorial desks or departments etc.)

Now that you know what your site should look like go to the 'Edit' menu in Quark select preferences and then 'Editors and Orders'.

This menu shows you a list of Publications, Departments, Editors, Element types and Word processor styles...

Simply type over the existing names with the names of your departments etc. To create more on the list simply copy one of the existing ones and paste it in the same window or click on the Create button in the preferences window and Press2Go Multi-user will add an 'untitled' entry to the currently selected window.

The Element Preference

Using the F11 preference tool select the more button which gives you access to the area which allows you to set up your publications and various user tunable preferences.
This gives a list of page element types and can be extended by adding others up to a total of 16. You may well prefer to keep these down to about 6.

**The Word Processor Preference**
This allows you to select the application to be used when creating the order files for your journalists to work with. The default for this is Teach Text.

You have to go through this exercise for each workstation as a part of the set up procedure.

This preference area also allows you to define variables such as the names of your publications editions editorial departments etc.

**Balloon Help Information**
The stories generated by the 'Order' process are placed in the appropriate Department basket. However it can be a bit difficult sometimes to recognise which story is which just from the story names. To help you do this the order information Publication date etc. is placed in the Balloon Help information balloon for each story. So if you have Balloon Help on the story information will be readily accessible to you without having to open the file.

**Working with Press2Go Line Count**
(If you don't have Line Counter skip this bit)

Press2Go Multi-user was designed to be used with Press2Go Line as one of its main options.

Install line count as described in the Line Count manual and set up appropriate counter styles based on the styles on the Multi-User Monthly. Lay the page out in the normal way but use line count to give estimates for story length on the page. It is probably best to select the 'Count from this box' feature to make sure that you are only generating information about the body copy rather than the entire story including headlines etc.

**Working with Press2Go Editor**
(If you don't have Editor skip this bit)

Press2Go Multi-user was designed to be used with Press2Go Editor.
Again install according to the instructions on the package. Once the copy from the journalists has been flowed back to your split page you will be able to edit the copy to fit the available space with comfort. Press2Go Editor lets you see the line endings column turns over set material in a mono spaced or wysiwyg mode. This lets you edit with speed without having to zoom into the page and scroll around to see what is happening on the page.
Rebuilding the Page
Open one of the clone pages and hit the F7 key or select 'Rebuild All Text' from the Press2Go Multi-user pull down menu. This will automatically import all of the stories which have been written and saved correctly in the correct baskets.

You should see that although the other stories on the page are visible they cannot be edited. However the assigned story can be edited and cut to fit the space reserved for it. The border colour of the stories changes as their status changes. A new story which has been ordered but not yet rebuilt has a magenta border. A story In progress has a blue border and a story which has been approved is green.

These borders can be turned on or off through the F13 key or by selecting the 'Show Story Status' feature from the Press2Go Multi-user Pull down menu with the option key selected.

If you are using Press2Go Editor you will be able to edit this copy in mono space or WYSIWYG (What You See Is What You Get).
As you work on the stories you should save your pages regularly. Not only will this prevent you having to re do work in the event of a system crash you will keep the other users up to date with your progress because as you save so the edits you have made to your story are available to other users if they in turn rebuild their pages.

Once you are happy with the story select the Approve Function from the Press2Go Multi-user Pull Down Menu (FXX). This will delete the cloned Quark page and gives the story a ready status. The story can now only be rebuilt from the master page.

**ADVANCED FEATURES**

Having got the hang of using Press2Go Multi-User lets look at some of the more advanced features of Press2Go Multi-User.

**Changing Page Components**

Inevitably there will be occasions when you would like to change various page components after the master page has been split. These changes are likely to be one of two specific kinds.

The Layout manager wishes to change one or more components on a split page.

The editor working on the split page may wish to make changes to the allocated space on the page. In either case these changes might involve the addition of other page components, graphic objects etc.

Clearly in either case it is important that the integrity of the master page is maintained and conversely it is important that people working in the split pages are working will the most recent version of the page. Press2Go Multi-User achieves this in two ways.

**Updating From the Master Page**

In this case a Master version of Press2Go Multi-User is used to open a split master page and the layout manager makes changes to the page. He or she then selects Apple key Option and Update Split from the Press2Go Multi-User pull down menu. This will regenerate the split files and replace the old ones with the new. If one of the editors has a split page open at the item he or she will get a message which tells him or her that the page they are working on is about to be rebuilt inviting them to save their current edits before the page is updated.

**Up dating from the Client**
In this scenario one of the editors wishes to transmit the changes in story shape to the master page. To do this once the changes have been made the editor selects FXX Apple Option 'Send Changes' from the Multi-user menu. This will send the changes made back to the master page. These changes may then in turn be sent out to the other editors by the Layout Manager to keep all the other editors up to date.

The ZAP Function

The Zap function lets the person who laid the page out change the shape of the story on the page and then re-order the story to the journalist so that he or she has an up dated value for word count and any other changed story parameters.

Using Zap

Only the master page can Zap files.

Open the master page and click onto the story you wish to change. Select 'Zap Story' from the P2GMU pull down menu. It will ask you if you are sure that you would like to Zap the story...click OK. This will remove the border colour and change the story status to normal. Make the changes and count the story again if you are using Press2Go Line count. Now you may re-order the story in the normal way. The Zap process does one of two things.

If the story is not in use it opens the story and re places the old information about the story with the new. If the story has been moved from the original location. Zap will create another file for the story as if the original had never existed.

If the file is open and in use ZAP will message the layout operator that the file is in use and can not be changed until it is released.

Setting Your Own Preferences

So far we have worked with the Multi-user Monthly preferences and hopefully these have given you and your colleagues an good idea of how every thing works. Now we need to set up your own office.

First map out your publications.

The most important thing you need to decide first is at which level do you break into departments. If you are publishing one publication
that's pretty easy because typically the departments will be divisions of one publication.

If you have lots of small publications then perhaps these publications are each one department. Remember the departments are the destinations for the story files ordered by the page layout person. The departments are copy baskets and contain stories in the process of being written only.

Here are some possible options
A Newspaper with three different Publications

<table>
<thead>
<tr>
<th>Publication</th>
<th>Department</th>
</tr>
</thead>
<tbody>
<tr>
<td>Morning News</td>
<td>Morning News News</td>
</tr>
<tr>
<td></td>
<td>Morning News Features</td>
</tr>
<tr>
<td></td>
<td>Morning News Finance</td>
</tr>
<tr>
<td></td>
<td>Morning News Sport</td>
</tr>
<tr>
<td></td>
<td>Morning News Special</td>
</tr>
<tr>
<td>Evening News</td>
<td>Evening News News</td>
</tr>
<tr>
<td></td>
<td>Evening News Features</td>
</tr>
<tr>
<td></td>
<td>Evening News Finance</td>
</tr>
<tr>
<td></td>
<td>Evening News Sport</td>
</tr>
<tr>
<td></td>
<td>Evening News Special</td>
</tr>
<tr>
<td>Sunday News</td>
<td>Sunday News News</td>
</tr>
<tr>
<td></td>
<td>Sunday News Features</td>
</tr>
<tr>
<td></td>
<td>Sunday News Finance</td>
</tr>
<tr>
<td></td>
<td>Sunday News Sport</td>
</tr>
<tr>
<td></td>
<td>Sunday News Special</td>
</tr>
</tbody>
</table>

You might prefer to use the Publication / Department division to distinguish between different sites. Here is a magazine company with various titles published at different locations. In this case the publications are small and do not naturally divide up into obvious areas such as news and sport.

<table>
<thead>
<tr>
<th>Publication Group</th>
<th>Department</th>
</tr>
</thead>
<tbody>
<tr>
<td>North Town Group</td>
<td>Fish Breeders News</td>
</tr>
<tr>
<td></td>
<td>Fancy Fish</td>
</tr>
<tr>
<td></td>
<td>Guppy Monthly</td>
</tr>
<tr>
<td>Mid Town Group</td>
<td>Goldfish Gazette</td>
</tr>
<tr>
<td></td>
<td>What Shark</td>
</tr>
<tr>
<td>South Town Group</td>
<td>Basic Trawler</td>
</tr>
<tr>
<td></td>
<td>Deep Sea Week</td>
</tr>
<tr>
<td></td>
<td>The Sea</td>
</tr>
<tr>
<td></td>
<td>Ocean Weekly</td>
</tr>
</tbody>
</table>
TABLEWORKS PLUS QUICK START

If you are fairly familiar with QuarkXPress, and you'd like to put off reading the manual as much as possible, then this section is for you! We will quickly run through the basic Tableworks Plus operations, with just enough of a description so that you can try them on your own and get a general idea of how things work. We will avoid discussing many "advanced" features here. We will also assume that you are starting with the initial default Tableworks Plus settings, as it comes out of the box. If you have changed any of these settings, they can be restored by removing (to the Trash) the Tableworks® Plus Data file from your QuarkXPress folder, and re-starting XPress.

When the operation is on an existing (already created) table, we assume that the table is activated; that is, you've clicked in some table cell and the selection buttons have appeared at the left and top table edges.

CREATE A TABLE

† Click the Table Tool, then drag out a box at the desired location in the document, and to approximately the desired size. When the Setup dialog appears, enter the desired number of rows and columns. Click OK, and an empty table is drawn.

TYPE IN TEXT

† Choose Edit » Preferences » Tableworks. Check Key through table, then click OK.

† Click in a table cell where you want to start entering text. Type in some text. Type Tab to move to the next cell to the right; type Return to move to the left-most cell of the next row down. To enter a new-line character (start a new paragraph) in a cell box, hold down Shift while typing Return.

RESIZE ROWS OR COLUMNS

† Click in the selection button (at left or top table edge) adjacent to a row or column you want to resize. To select a range, drag over the selection buttons with the mouse button down. Then, click again in any selection button; after the second click, grab handles will appear around the row/column perimeter. Now drag one of the handles at the perimeter of the selected area, then wait for everything to adjust to the change.

† Or, move the cursor over a row or column boundary while holding down the c key. When the cursor changes to ° or °, hold down the mouse button (with the c key still down), and drag the boundary one way or the other. This expands a row or column; hold down both c and Shift to shrink instead.

RESIZE ANY AREA

† While holding the Shift key and mouse button down, drag the cursor across the cells you want to select. A rectangular area of adjoining cells will be selected, as indicated by the outline that appears as you drag. After making the selection, click again in any selection button; after the second click, grab handles will appear around the selected area. Drag one of the handles to resize.
To select the entire table for resize, double-click in the corner selection button.

If you change your mind and want to de-select instead of resizing, type c-U. (This can be done after any selection.)

CUT AND PASTE A ROW OR COLUMN

Select a row or column of the active table, by clicking the adjacent selection button. Click the Item tool, then choose Edit = Cut, or Edit = Copy. Cut/Paste will not duplicate complex row/column structure (straddle or split cells); use Duplicate cells for this.

Only if you are pasting into a different table: activate the new table (click in any cell). The table you paste into can be in the same or a different document.

Select a new row or column by clicking the adjacent selection button; the cut/copied row/column will be pasted next to the selected row/column. Default is to paste below the selected row, or right of the selected column; hold down the Shift key (while pasting) to paste above/left instead.

Click the Item tool, then choose Edit = Paste.

You can also paste in groups of boxes that have have been copied to the clipboard (i.e. not from a table).

CUT AND PASTE ROW OR COLUMN TEXT

Cut/Copy any Tab and New-line delimited text to the clipboard; Tabs will determine column breaks, New-lines will determine row breaks. Or,

To Cut/Copy table text: select row(s) or column(s) of the active table, by clicking the adjacent selection button (drag across for a range); or select the whole table by clicking the corner selection button. Click the Content tool. Choose Edit = Cut or Edit = Copy to cut/copy: text will be copied to the clipboard with added Tabs between columns, New-lines between rows.

Make a selection in any active table, in the same or a different document: select row(s), column(s), or the entire table using the selection buttons. Choose Edit = Paste to paste current clipboard text; text will break to next column at each Tab, or to next row at each New-line.

You can paste any Tab and New-line delimited text into a row/column/table selection.

DUPLICATE OR DELETE ROWS OR COLUMNS

Select the row(s) or column(s) to be duplicated or deleted, by clicking the adjacent selection button (or drag across the selection buttons to select a range). Selection can be any structure containing straddle or split cells. Choose the appropriate operation from the Duplicate cells or Delete cells sub-menu (Table menu).

REARRANGE ROWS OR COLUMNS

Hold down the Option and Shift keys; click and hold down the selection button adjacent to the row/column to be moved. Drag the row/column outline over the table to its new position; it will "stick" as it crosses over other row/column positions. When the outline is over its new position, release the mouse button.

MERGE A GROUP OF CELLS

Method 1: While holding down the Shift key and the mouse button, drag across the cells you want to merge. An outline showing the selected cells will appear as you drag. Then choose Table = Merge cells = Merge
selected cells.

† Method 2: While holding down the Shift and Control keys, and the mouse button, drag across the cells you want to merge. After the mouse button is released, the cells will be merged to a single cell (all previous text will be lost). An alert will ask you to confirm the merge first.

MERGE INDIVIDUAL CELLS

† Click in the cell to be covered over by the new merged cell. Choose the direction of the cell which will expand from the Table ⇒ Merge cells menu.

FRAME CELLS

‡ Choose Table ⇒ Table Style. In the dialog, check Frame entire table.

§ Choose the frame width, shade, and color using the popup menus at the lower right. Click OK to apply.

CHANGE TYPE STYLE

Choose any new setting for Font, Size, Type Style, Color, or Shade from the Style menu. The setting will be applied immediately to the selected cells, and the cells will then be de-selected.

ADD LINES AND BOXES

† Click one of the Line tools in the Tools palette to add a line; or click the Text box or rectangular Picture box tool to add a box.

§ Start drawing the line or box approximately where you want it over the table. Hold down the Option key after you start drawing the box or line, and keep it down until you release the mouse button. (If you start holding down the Option key first, you won’t be able to draw the box or line.)

− When the mouse button is released, the box or line will be added to the table, and “snapped” to the nearest cell corners. (You can add boxes or lines without snapping to corners by using the Table ⇒ Objects menu.)

ADD ROW/COLUMN SHADING AND LINES

† Choose Table ⇒ Table Style. In the dialog, enable/disable shading or surround lines using the checkboxes at the upper left, and customize using the buttons and popup menus at the right.

‡ Click Line scripts. You can create up to 16 scripts, each of which is applied independently. Make the desired settings for a new script, then click Save to have the script applied to the table. To make a new script, click New. Use the popup menu at the top to bring up a previously created script. Click Done to go back to Table Style, then click OK.

§ To access the script for an existing row/column line, double-click the line. In the script, you can make any changes, then click Save, and Done to leave the dialog. You can go to any other script using the popup menu at the top.
**IMPORT DATA**

† The text to be imported should be delimited with Tabs to indicate column breaks, and Returns to indicate row breaks. If importing from another text box in the document, click in this box first.

† In the Setup dialog when either creating a new table or for an existing table, click Import. In the Import dialog, check Auto grow to have row/column counts calculated automatically. Click Import.

**SLANT A ROW OR COLUMN**

† Select a row or column by clicking in the adjacent selection button.

ı Choose Table ➔ Slant. Set the slant angle between -45° and 45°. Choose the text direction, up/down/normal, which is independent of the slant angle. Click OK.

† To undo a slant: select the row or column, then set the slant angle to 0° using Table ➔ Slant.

**EQUALIZE HORIZONTAL COLUMN TEXT SPACING**

† Resize the table if necessary, so there are no overwrite indicators in any cell.

ı Choose Table ➔ Justify spacing, click Justify Spacing. Space between the maximum column-wise text extents of all adjacent columns will be equalized across the table.

**EQUALIZE ROW OR COLUMN SIZES**

† Choose Table ➔ Show palette, to bring up the Tableworks palette.

† Select a range of rows or columns: choose Row direction or Column direction from the popup menu, then enter a number range, and type Return (or click Select). (You can also select the range by dragging across the selection buttons at the left or top table edges.)

† Method 1: To set all selected rows/columns to a given length/width: enter the value in the Length/Width box, hold down the Option key and click the Equalize button in the palette.

† Method 2: To equalize all selected rows/columns within the current length/width: just click the Equalize button in the palette.

**ADD BOXES INCREMENTALLY (ENTIRELY OPTIONAL)**

† When in the Setup dialog while creating a new table (see above), check Create boxes later. When you click OK, the cell outlines will be drawn but the cell boxes will not be created.

† To create a box for a given cell: click in the Item ➔ tool, then click over the cell.

† To create boxes as you type in text: move to the next cell by typing Tab (with Key through table enabled, as described above).

† To create boxes for selected rows/columns or the entire table: select a row or column by clicking in the adjacent selection button, or select a range by dragging across the selection buttons in the range, or select the whole table by clicking the upper-left corner selection button; then choose Table ➔ Boxes ➔ Create boxes.

† To delete any table box: choose Item ➔ Delete.
License Agreement

Vision's Edge, Inc. provides the computer software program and User Manual contained in the package (the "Program"), and licenses its use on the terms stated below:

a. You are granted a license to use the Program under the terms stated in this Agreement for personal use in your business or profession. Title and ownership of the program remains with Vision's Edge, Inc.;

b. The Program may be used by you on a computer or computers which you own or use for which the Program is designed to operate, except that the Program may be used only on one computer at any one time;

c. You may not make copies, translations or modifications of or to the Program, except you may copy the Program into machine-readable form for backup purposes in support of your use of the Program. (Any portion of this Program merged into or used in conjunction with another program will continue to be the property of Vision's Edge, Inc. and subject to the terms and conditions of this agreement.);

d. You may not assign, sell, distribute, lease, rent or transfer the Program or this license to any other person;

e. This license terminates if you fail to comply with any provision of this Agreement. You agree upon termination to destroy the Program, together with all copies, modifications and merged portions in any form.

Macintosh™ is a registered trademark of Apple Computer, Inc.

Disclaimer

Quark, Inc. makes no warranties, either expressed or implied, regarding the enclosed computer software package, its merchantability, or its fitness for any particular purpose. Quark, Inc. disclaims all warranties including, but not limited to, the warranties of the distributors, retailers and developers of the enclosed software.

Without limiting the foregoing, in no event shall Quark, Inc. be liable for any special, indirect, incidental, or consequential damages in any way relating to the use or arising out of the use of the enclosed software.

Quark, Inc.'s liability shall in no event exceed the total amount of the purchase price/license fee actually paid for the use of the enclosed software.

Some states do not allow the exclusion of implied warranties and/or the exclusion or limitation of incidental or consequential damages, so these exclusions and limitations may not apply to particular developers.
Vision Utilities

Introduction

Vision Utilities is an XTension for QuarkXPress\textsuperscript{a} version 3.1. Vision Utilities is a collection of utility functions which include a feature which draws grids of page guides, a utility which counts all of the words in the currently selected text, a function which fits a picture to its picture box so that it entirely fills the box, and a paragraph sorting utility which alphabetizes paragraphs. Additionally, Vision Utilities includes a utility which helps prevent imagesetter film waste by making sure all colors are process colors except for specified exceptions.

Minimum System Requirements

Vision Utilities is designed for QuarkXPress 3.1.

Vision Utilities is network protected and is fully compatible with floppy, RAM, or hard disks.

This manual assumes that you are familiar with standard Macintosh\textsuperscript{™} procedures such as basic use of the mouse, clicking, pulling down menus, copying files, and copying disks. If any of these procedures are new to you, please refer to your Macintosh\textsuperscript{™} user's manual.

Installing Vision Utilities

The Vision Utilities disk that you have purchased contains the file Vision Utilities. To install Vision Utilities, drag the file into the same folder that contains the QuarkXPress application. After this has been done, place the original Vision Utilities disk in a safe place.

The Vision Utilities Hierarchical Menu

Vision Utilities adds a hierarchical menu to the standard QuarkXPress Utilities menu. Use this menu to access all of the Vision Utilities functions.

Guide Grid Utility

One of the Vision Utilities is a grid-drawing function. It automatically subdivides the page into a symmetric grid structure using page guides. To create a grid of guides on the currently active page, select Create Grid Guides... from the Vision Utilities hierarchical menu. A dialog appears.
The Create Guide Grid dialog allows the user to specify how many divisions the page should be ruled into. There can be between 1 and 30 columns and rows. If 1 column or row is specified, no ruler lines are drawn in that direction.

The dialog also lets you choose whether the entire page should be divided with the guides or just the area within the page margins. When the dialog controls are set as desired, click the OK button to close the dialog.

The XTension draws its guide lines in red to differentiate them from guide lines the user has drawn on the page. Any page guides placed on the page by the user are left undisturbed when the grid is created. However, if the guide grid feature was previously used to section off the page, the old grid is replaced by the new one.

The guide grid function only places guide lines on the currently active page in the document. To create a grid of page guides which will appear on all pages of the document, create the grid on the master page.

**Count Selected Words Utility**

Vision Utilities provides an easy way to obtain an accurate word count on a portion of a story. To count the number of words found in any range of text, select the words to be counted. Next, select `Select Selected Words...` from the Vision Utilities hierarchical menu. A dialog appears:

The word count dialog reports how many words are contained in the selected text range. Click the OK button to close the dialog.
**Vision Utilities**

**Full Fit Picture Utility**

Another useful feature included in Vision Utilities is the full fit picture utility. This feature scales a picture while leaving its aspect ratio at 1:1 so that the shortest side of the picture exactly fills the graphic box while the longer side, which is then too large to fit in the box, is cropped by centering the picture in the box. This ensures that the graphic box is fully filled with no white space around the image.

The full fit picture function varies from the standard QuarkXPress fit picture to box while maintaining aspect ratio command (executed as `\$-option-shift-f`) because the standard command scales the longest side of the picture to fit the box, rather than the shortest. The full fit picture function is particularly useful when working with a large background graphic which must exactly fit a certain space.

To full fit a picture to its graphic box, select the graphic box while the content tool is selected. Then press `\$-option-shift-g` or choose **Full Fit Picture** from the **Vision Utilities** hierarchical menu. The picture is scaled so that it fills the entire graphic box.

**Sort Paragraphs Utility**

Vision Utilities also includes a utility which sorts a range of paragraphs into alphabetical order. To sort paragraphs, use the content tool to select a range of paragraphs to be sorted. Any paragraph which is entirely or partially included in the text range is considered by the sort paragraphs utility to be selected.

Once the desired paragraphs are highlighted, choose **Sort Paragraphs** from the **Vision Utilities** hierarchical menu. The XTension places all of the selected paragraphs into alphabetical order.

The paragraph sorting process can be slowed by text which contains a great deal of local formatting (text style, size, color, etc.) as well as by text which contains anchored boxes. Hidden text, which is placed in documents by some other XTensions, may also slow the sorting process.

If the local formatting found in the paragraphs is unimportant, one solution is to do a quick sort. Quick sorting alphabetizes the paragraphs but overwrites local text formatting with the text style which is applied to the last character in the range the use selects before sorting. To perform a quick sort, hold down the option key while selecting the **Sort** command from the **Vision Utilities** hierarchical menu.

**Caution:** It is not recommended that a quick sort be performed on text which contains anchored boxes or hidden text.

**Quick Text Utility**

The Quick Text feature is designed to allow the user to quickly copy a portion of text into its own text box while retaining all of the text attributes. To use the quick text feature, select the text which should appear in the new text box, then press `\$-c` to copy the text. Next, press `\$-option-shift-q`. The selected text is copied into a newly created text box. The new text box trims to accommodate the text.
Vision Utilities

Process Colors Utility

The process colors utility included in Vision Utilities is designed to help cut down on film waste which occurs when colors which should be set as process colors are not and vice versa.

To cut down on film waste due to this problem, the process colors utility automatically sets all colors to Process Separation On unless it conforms to the exception list set up in the Process Color Options dialog. The process separation setting is changed for documents which are printed with QuarkXPress as long as the process colors utility is activated. The change is made when the document is printed. To set the process color preferences, choose the Process Colors... dialog from the Vision Utilities hierarchical menu. A dialog appears.

![Process Color Options dialog]

The Process Color Options dialog

To activate the process color checking, check the Make All Colors check box. Then enter the color name prefix which appears before colors which are not to be set to Process Separation On (that means they will print without separating as spot colors). The prefix can be something made up (such as "Spot" in the previous example), or it can be something commonly used, such as Pantone or PMS. Any color whose name begins with a designated prefix is set to Process Separation Off, while all other colors are set to Process Separation On. The prefixes are not case sensitive.

The Process Color Options also provides a convenient way to set the process screen angles for every output. To change the screen angles of cyan, magenta, yellow or black, enter a new value in the appropriate field on the right side of the Process Color Options dialog. The black angle only applies when making separations. When a page is printed without the Separations check box checked in the QuarkXPress Print dialog, the halftone screen angle is always 45°.

Caution: Be sure to turn off the process colors utility by unchecking the Make All Colors check box whenever it is not in use. If the process colors utility remains activated, each time a document is printed, its colors’ separation settings are scanned and reset. This may lead to accidental changing of the color settings.
This document briefly describes ScaleIt™ from a lowly apprentice production. As a demonstration version, it is exactly like the production version. However, note that while loaded, any demonstration XTension® alters QuarkXPress® such that saved documents cannot be opened by normal versions of QuarkXPress, and all printed pages include a “QuarkXPress Demo” banner.

Introduction

ScaleIt provides the means to easily scale QuarkXPress lines, text and picture boxes, and their contents, similarly to the way drawing programs scale objects. These items can be scaled horizontally, vertically, or both. While there are other methods of scaling items in QuarkXPress, none are as fast and easy as ScaleIt. For example, a complex group of items can be reduced to 62% of original size in seconds. ScaleIt can simplify headline creation, logo development, copy fitting, picture and caption adjustments, and many other common tasks.

Using ScaleIt

When ScaleIt is loaded with QuarkXPress, the command Scale is appended to the Item menu, and the command ScaleIt is added to the Preferences submenu of the Edit menu. The Scale command opens the Scale dialog box, letting you scale the selected item or group of items by specifying a new width, a new height, or both. Scaling can be specified in terms of percentages, or as new dimensions.

ScaleIt Tool

ScaleIt also adds a tool to the QuarkXPress Tool palette. This tool lets you drag to resize an item or group of items, visually.

The ScaleIt command opens the ScaleIt Options dialog box, containing numerous options that define how text, graphics, frames, and lines are to be scaled.

To access the Flexographic Scale dialog hold down the option key while clicking OK in the QuarkXPress Print dialog. Note you may also need to hold down the option key when clicking OK on any dialogs that follow the Print dialog. Clicking the Cancel button from the Flexographic Scale dialog does not abort printing rather it only dismisses the dialog and printing continues without applying a scale.

For More Information

To obtain more information about ScaleIt, or to purchase a copy, please contact:

XChange USA
724 Whalers Way
Boardwalk Bldg. H, Suite 101
Ft. Collins, Colorado, USA 80525
1-800-788-7557 (tel)
1-303-229-9773 (fax)

XChange International
1-2 Bromley Place
London W1P5HB, UK
44-71-637-2966 (tel)
44-71-637-2842 (fax)

Trademark Information

a lowly apprentice production, the lowly apprentice logo and ScaleIt are trademarks of a lowly apprentice production. Quark, QuarkXPress and XTensions are registered trademarks of Quark, Inc. Apple and Macintosh are registered trademarks of Apple Computer, Inc.
Press2Go Smart Shapes

What Are Smart Shapes

Press2Go Smart Shapes is one of the range of Press2Go pagination Xtensions from Atex which are designed to make the Quark user more productive by solving specific production problems associated with the operation of Quark Xpress, especially in the high volume newspaper or magazine production markets.

Smart Shapes is a Quark Xtension which will work with any copy of Quark Xpress for the Macintosh.

How do I Install Smart Shapes

Smart Shapes is very simple to install. All you need to do is insert your install disc into the floppy drive of your Macintosh. The disc has to be unlocked to install, although subsequently you can lock the disc to secure the contents against accidental erasure. Simply drag the icon of the Xtension into the Quark folder on your Macintosh.

Then start your copy of Quark. The Xtension will load up and once Quark has loaded you can quit Quark and remove the floppy disc.

What does Smart Shapes do?

Smart shapes lets the operator create groups of text and picture boxes and lines which can be dynamically re-sized. Normally grouped objects can not be re-sized so to take an existing group and change the size of any of the components requires that the user un group the object and individually re-size each component. Doing this accurately is very difficult. Smart shapes solves this for you.

Using Smart Shapes

Unlike many Quark Xtensions Smart shapes will take you a little time to master. The ideas behind it are powerful and the results are remarkable. It will give you enormous savings in productivity, but to get the most out of you will have to work with it and familiarise your self with it's operation.

Group Behaviour
Smart Shapes is based on controlling how the individual components of a group behave. In a grouped object the component parts can move within or in relation to the group or they can scale as the group scales. Let's look at the various controls available to us.

**Summary of Commands**

Access the Command palette through the View menu in Quark.

**Stretch Proportionally**

"As the containing group gets bigger, get bigger in proportion" That means that large objects will stretch more than smaller ones. This is not widely used except where it is used to control the stretch behaviour of sub units of complex shapes, this is a specialist function which should not worry the beginner and will become evident through experimentation as the skilled operator builds shapes.

**Stretch Equally**

"As the whole shape gets bigger or smaller, get bigger or smaller to the same extent" This is a widely used feature which allows a series of objects to get bigger or smaller equally. For example the headline box on one of the story shapes stretches equally with the body text boxes thus keeping it the same width as the body copy.

**Move Proportionally**

"In this case the object will not change shape but will stay in the same relative position in the group". Typically this function is used to keep an object such as a logo centred on a line or in a box.

**Move With Left or top**

"This will nail an object to the left or top so that if the group is pulled to the right or bottom the object will remain where it is." This is a widely used feature. Typically it is used to lock a logo at the top or left of a box. If used in conjunction with the Move proportionally tool, it could be used to produce an effect where a logo or text panel stayed in the centre top of an advertisement irrespective of how deep or wide the ad was.

**Move with Right or Bottom**
"This will nail an object to the Right or bottom so that if the group is pulled to the right or bottom the object will be pulled in the same relative position." This is the reverse of Move with left or top and has a similar function. In this case it can be used to fix

Divide Stretch with Others

"This maintains the relative spacing between objects in either dimension." This is most commonly used in the construction of complex and flexible story shapes.

For example

On a page with your standard gutter between columns (e.g. 1 Pica) draw a text box which fits one column. The default smart shape parameters will be "Divide stretch with others" horizontally. Leave it as that and duplicate the shape a few times. Now line these shapes up accurately across the page so that their tops align horizontally and they are all the standard gutter apart. Now group them. They will behave just like a normal patch or Quark text which has been divided into several legs using the Modify command. However unlike normal Quark text this shape can be un grouped and the component legs pulled to fit whichever shape the designer wishes. This makes drawing complex story shapes with differing leg lengths but constant gutters very easy.

Stretch Content with Box

"This allows the graphic content of a picture box to be stretched with its container". As the containing picture box stretches in either or both directions so the picture content can be scaled. If only one direction is selected the picture will stretch in that direction. If neither direction is checked the image will not stretch as its containing box stretches.

Examples

Let's look at a simple Smart Shape. (See enclosed Quark Library)

This feature slug is made up of two parts the black box which contains centred white out text and the double line underneath. I may want to use this slug across a variety of widths within my publication. Normally I would have to take the object out of the library and un group it. Then I would have to carefully re-size the object in the width taking care not to make it deeper or misplace the line. Otherwise I would have to build the object at a number of sizes and use them from the library, this is a time consuming and inefficient way of working. This is how Smart Shapes solves this for you.
Open the Smart shapes palette from the View menu. Now build the Feature slug and make sure that the components are correctly positioned. Now we need to tell the objects how to behave when the group is stretched or compressed.

Click on the text box with the pointer tool and look at the Smart shapes Palette. We need the box to stretch equally as the slug stretches horizontally, but the we don't want it to get any deeper vertically. In other words it should stretch equally horizontally and only move vertically with the top of the shape. The line underneath should stretch equally like the text box above it. But in this case we need the line to stay where it is relative to the box. In this case click on the line and select stretch equally horizontally and move with right or bottom vertically.

Now select the box and line and group them. If you click onto box with the pointer tool and pick up one of the handles. You will find that the grouped object will stretch evenly horizontally but will remain a constant depth.

Experiment with smart shapes library on the Xtension disc. Try dragging the objects onto the page and re-sizing them. You will notice that there are some story shapes which can be dragged to any size even though the have grouped headlines attached to them.

Try un grouping one of these shapes and selectively stretching or compressing the individual legs. Now regroup the shape and you will see that the shape with stretch maintaining the relationship between the various legs of the shape.

To find out the rules governing the behaviour of these components simply click on any of them with the I bar tool. You will see that these rules can be changed whilst the object is still grouped. Try experimenting with the rules and see what happens when you stretch the shape.

Building Shapes......"You Gota Practice!"

As you can see from the above list of functions Smart Shapes has a lot of functionality which will take some time to master. However once you have mastered the standard tools you will be able to build a library of basic shapes which can be simply and dynamically scaled to hugely speed your page layout process.

This is a sample Xtension which will give you an idea of how the tool works and what you can do with it. If you would more information about this or any Atex product please call your local Atex office or Agent.
<table>
<thead>
<tr>
<th>Country</th>
<th>Phone Number</th>
</tr>
</thead>
<tbody>
<tr>
<td>US</td>
<td>617-275-232</td>
</tr>
<tr>
<td>Latin America</td>
<td>305-733-1887</td>
</tr>
<tr>
<td>Australia</td>
<td>613-690-7577</td>
</tr>
<tr>
<td>France</td>
<td>3314-774-7781</td>
</tr>
<tr>
<td>Germany</td>
<td>4969-660-90</td>
</tr>
<tr>
<td>Netherlands</td>
<td>311-041-39050</td>
</tr>
<tr>
<td>New Zealand</td>
<td>6493-098-034</td>
</tr>
<tr>
<td>Singapore</td>
<td>6547-410-10</td>
</tr>
<tr>
<td>UK</td>
<td>44-525-382-304</td>
</tr>
<tr>
<td>Denmark</td>
<td>454-343-0800</td>
</tr>
<tr>
<td>Israel</td>
<td>9722-346-180</td>
</tr>
<tr>
<td>Italy</td>
<td>392-824-2541</td>
</tr>
<tr>
<td>Norway</td>
<td>47289-7200</td>
</tr>
<tr>
<td>Spain</td>
<td>34332-30600</td>
</tr>
<tr>
<td>Sweden</td>
<td>468-734-3500</td>
</tr>
</tbody>
</table>
Crop&RegIT

This document contains instructions for using the Crop&RegIT XTension* from a lowly apprentice production. You may want to print this document so that the instructions will be available when you need them. This document uses the following fonts: Helvetica, Times, and Zapf Dingbats.

Using this Document
This document covers all aspects of Crop&RegIT—please take a few moments to read it. This document assumes that you are already familiar with QuarkXPress and makes no attempt to guide you in use of the application.

Installing the Crop&RegIT XTension
Crop&RegIT is an XTension to QuarkXPress and like other XTensions, it operates only when located in the same folder as the QuarkXPress application. Before installation, quit QuarkXPress if it is running. To install Crop&RegIT, double-click the Installer icon and when asked where the XTension is to be placed, open your QuarkXPress folder and select the QuarkXPress application. (For more detailed information on XTensions and their general use, refer to Appendix B of the QuarkXPress Reference Manual.)

About the Crop&RegIT XTension
Crop&RegIT lets you select any element or group of elements on a QuarkXPress page and instantly draw crop marks, registration targets, color indicators, and gray-scale bars around that selection. You can set the trim-line weight and length, the mark size, and a mark offset used to keep the marks a safe distance from the elements being cropped. And the marks Crop&RegIT places on the page are completely editable QuarkXPress items, so you can easily modify them. Crop&RegIT is compatible with QuarkXPress version 3.11 or later.

Using the Crop&RegIT XTension
Crop&RegIT adds two commands to QuarkXPress, one in the Preferences submenu:

- (Edit → Preferences → Crop & RegIT...)

and one in the Item menu:

- (Item → Create Crop & Reg Marks)

Crop&RegIT Preferences

Choosing Crop & RegIT from the Preferences submenu of the Edit menu displays the Registration & Crop Mark Setup dialog box, in which you define the marks to be placed and their positioning around a selected item. (This dialog box also can be opened by choosing Create Crop & Reg Marks from the Item menu while the Option key is pressed.)

Select the marks you want created when Crop&RegIT is activated. The options are Crop, Targets, CMYK Tag, Color Bar, and Gray Bar. Checked items are included when creating the crop and registration marks.

The Line Weight value determines the thickness of the lines used for trim lines and targets. The Line Length value determines the length of the trim lines. The Mark Size value specifies how large the targets and the boxes used to build the color and gray-scale bars are to be. (For example, if you specify 12 pts., a gray-scale bar will be 120 pts. long by 12 pts. wide, since gray-scale bars contain ten boxes.) The Mark Offset value defines the gap between the edges of the item(s) being cropped and the marks and trim lines.

Create Crop & Reg Marks Command
Create Crop & Reg Marks is available from the Item menu when one or more items are selected. When you choose the command, Crop&RegIT places the marks specified in the Registration & Crop Mark Setup dialog box around the selected item(s). The marks created by Crop&RegIT are editable QuarkXPress elements. These items are initially grouped but they are easily ungrouped and altered.

Copyright © 1993 by a lowly apprentice production. All rights reserved.
Trademark Information
a lowly apprentice production, the lowly apprentice logo
and Crop&RegIT are trademarks of a lowly apprentice
production. Quark, QuarkXPress and XTensions are regis­
tered trademarks of Quark, Inc. Apple and Macintosh are
registered trademarks of Apple Computer, Inc.

a lowly apprentice Disclaimer
The software described in this manual is distributed under
license from a lowly apprentice production. The license
agreement specifies the permitted and prohibited uses of
this software. Any unauthorized duplication or use of
Crop&RegIT in whole or in part, in print, or in any other
storage or retrieval system is prohibited. Crop&RegIT
software is provided "as is" without warranty of any kind,
either express or implied, regarding the software package,
its merchantability, or its fitness for any particular purpose.

Quark Disclaimer
THIS PROGRAM CONTAINS AN XTENSION WHICH
ENABLES IT TO BE USED WITH QUARKXPRESS —
APPLE MACINTOSH COMPUTER VERSION.
QUARKXPRESS IS A REGISTERED TRADEMARK OF
QUARK, INC. ONLY VALID, REGISTERED COPIES OF
QUARKXPRESS —APPLE MACINTOSH COMPUTER
VERSION MAY BE USED WITH THIS PROGRAM.
QUARK, INC. MAKES NO WARRANTIES EITHER
EXPRESS OR IMPLIED, REGARDING THE ENCLOSED
COMPUTER SOFTWARE PACKAGE, ITS MERCHANT-
ABILITY, OR ITS FITNESS FOR ANY PARTICULAR
PURPOSE. QUARK, INC. DISCLAIMS ALL WARR-
ANTIES INCLUDING, BUT NOT LIMITED TO THE
WARRANTIES OF THE DISTRIBUTOR, RETAILERS,
AND DEVELOPERS OF THE ENCLOSED SOFTWARE.
WITHOUT LIMITING THE FOREGOING, IN NO EVENT
SHALL QUARK, INC. BE LIABLE FOR ANY SPECIAL,
INDIRECT, INCIDENTAL, OR CONSEQUENTIAL DAM-
AGE IN ANY WAY RELATING TO THE USE OR
 ARISING OUT OF THE USE OF THE ENCLOSED SOFT-
WARE. QUARK, INC.'S LIABILITY SHALL IN NO
EVENT EXCEED FIFTY DOLLARS ($50.00).
THE EXCLUSION OF IMPLIED WARRANTIES AND/OR
THE EXCLUSION OR LIMITATION OF INCIDENTAL
OR CONSEQUENTIAL DAMAGES IS NOT ALLOWED
IN SOME AREAS, SO THESE EXCLUSIONS AND
LIMITATIONS MAY NOT APPLY TO YOU.

About software copying
Remember: by using this software you have agreed to the
software license—please do not copy the product illegally.
If you have multiple copies of QuarkXPress and you
would like to use this software with them, a site license
can be arranged.

Thank you
We extend to you our thanks for your support of this
product. It is important that you understand that a lowly
apprentice production is a small software company
(nowhere near the size of Quark, Inc.). Therefore, it is
your comments and feedback that lead to improvements to
this product. Please feel free to call or write with any
suggestions you may have for future versions of this
XTension and we will put them on our "wish list.”
Also, if you encounter a problem with the software, please
let us know what you did and what the XTension did—
only the problems we know about can be fixed. And
finally, please be sure to send in your registration card so
we can keep you informed about what we are doing.

a lowly apprentice production
363 Winamar Avenue
La Jolla, CA 92037
619-459-7655 tel
619-459-3094 fax
AppleLink PSCHMITT
AOL PSCHMITT
Welcome!

You're about to test one of the best hyphenation algorithms available in publishing this moment...

This DiHyphXT demo package consists of two files:
- DiHyphXT Demo XTension
- English (Oxford) Demo language file
meant for QuarkXPress version 3.1 up to 3.31 and higher, Macintosh version.

Installation:
copy the DiHyphXT XTension and the language file into the folder that contains the QuarkXPress program, or, when using XPress 3.3 or higher, into the XTensions folder.

Demo limitations:
The demo runs for a maximum of 30 minutes.
Each time you quit and start XPress again you will have another 30 minutes to go. DiHyph-hyphens will be removed before printing or saving.

DiHyphXT - Highlights:
- Versions for QuarkXPress Mac and Windows, and QuarkCopyDesk Mac.
- Hyphenation "on-the-fly": no need to activate it manually (so you can't forget it).
- Very high accuracy certified by numerous tests.
- No word dictionaries but program algorithms supported by program tables.
- Thus high accuracy even on new word creations and foreign expressions.

Minimum storage requirements: algorithm, including basic exception dictionary <= 60 Kb / language.
- 26 natural languages available: Afrikaans, American, Bahasa Indonesia, Czecho-Slovak, Danish, Dutch, English (Oxford), Finnish, French, German, Hungarian, Italian, Latin, Lithuanian, New Greenlandic, Norwegian, Polish, Portuguese/Brazilian, Rumanian, Slovak, Slovenian, Spanish, Swahili, Swedish, Tagalog Philippine, Turkish.

Hyphenation language must be equal to XPress original language!
- Best references worldwide for more than 18 years now by many well known companies: ATEX a/o.
- Hyphenation rankings 1-5 by program algorithm and exception dictionary, e.g.: Auto-1mo-5bile Mid-1sum-4mer.

- 1 -
- Easy exception dictionary handling with word truncation, hyphenation rankings, automatic error checking, sorting, elimination of doubles, correction of incorrect hyphen setting.
- Network version available: exception dictionaries can be maintained on the server, so everyone uses the same exceptions always.

We hope you like this product!
Introduction

Welcome to Managing Editor Software Inc.'s Managing Editor XTension Pro manual. This manual will give you detailed information on how your MEXT Pro can be used to enhance your final pagination and design tool, QuarkXPress. This manual is also provided with the live version of MEXT Pro. This demonstration version of MEXT Pro will only gather two items in each gather set. Please note that any gather sets created with the demonstration version of this software will not be stored after exiting QuarkXPress.

Using This Manual

Your Managing Editor XTension manual is divided into chapters with each chapter containing topics and subtopics appropriate to the functions it describes. If you need to return to this section on how to use your manual, press Command (or Apple Key)-1 and you will be returned to the beginning of this chapter.

Chapter Navigation

There are five methods for moving between chapters in the manual. The fifth method utilizes the Table of Contents which is described in the section following this one.
Command key and pressing the chapter number.

**Contents Menu:** You can also select the appropriate chapter from the Contents menu.
**Chapter Indicator:** To use the chapter indicator at the bottom-left corner of the window, click and hold on the current chapter name and a pop-up menu will appear. Select the desired chapter and the program will take you there in the manual.

**Scroll Bars:** You can also use the horizontal scroll bar to move between chapters. To move back one chapter, click on the left horizontal scroll arrow; to move forward one chapter, click on the right horizontal scroll arrow.

**Table of Contents**

This manual contains a special Table of Contents that gives you access to the chapters and their respective topics. To open the Table of Contents, either press Command-K or choose the Table of Contents option from the Contents menu.

Once you've opened your Table of Contents, double-click on the topic or chapter heading you'd like to view and the program will open the chapter to the location you've chosen. You can also click on an entry in the Table of Contents and press Return to select a chapter or topic.

**Moving Within Chapters**

**Vertical Scroll Bars:** To move one line at a time within a chapter, click on either of the vertical scroll bars. Your screen will be slowly scrolled either up or down to reveal a different part of the document.

**Page Up Key:** The Page Up key on an extended keyboard moves you backward one screen in the current chapter.

**Page Down Key:** The Page Down key on an extended keyboard moves you forward one screen in the current chapter.

**Home Key:** On an extended keyboard, pressing the Home key takes you to the beginning of your currently active chapter.

**End Key:** Pressing the End key on an extended keyboard takes you to the end of your currently active chapter.
Introduction to MEXT Pro

An overview of Managing Editor XT Pro

Thank you for purchasing Managing Editor® XT Pro 2.0 from Managing Editor Software. With it, all your stories and pictures will appear in an easy-to-use runsheet palette right on your QuarkXPress® desktop.

You’ll be able to quickly place and replace text and graphics in your document by dragging them out of your MEXT Pro runsheet and dropping them on pages in your XPress document. You’ll no longer need to go through the time-consuming process of creating boxes and locating and importing their contents: MEXT Pro will do it all automatically.

And once placed in your document, MEXT Pro stories and graphics will be crossed off your runsheet so that you can easily keep track of which items have been placed and which have not.

Installing MEXT Pro

To install your copy of MEXT Pro, insert the master diskette and follow the directions in the chapter entitled XTension Installation. All the instructions necessary for installation are contained in that chapter. When you are finished installing MEXT Pro, come back here for instructions on its use.

MEXT Pro Copy Protection

MEXT Pro uses a non-intrusive copy protection scheme in which the XTension is serialized to your copy of QuarkXPress®. If you try and use the serialized XTension with a different copy of XPress, it will not work.

If you want to install MEXT Pro with a different copy of XPress, you must first remove the old MEXT Pro from its existing location and re-install it with the new copy of XPress.

Instructions for removing a previously-installed copy of MEXT Pro are contained in the chapter entitled Removing MEXT Pro 2.0. Once MEXT Pro is removed, you may reinstall it with the same or a different copy of QuarkXPress.

Should you receive an update for your QuarkXPress and find that MEXT Pro no longer works with the updated copy, first remove MEXT Pro XTension following the instructions in this manual, then re-install the package.
XTension Backup

During the installation process, the MEXT Pro Installer also creates a backup copy of your new MEXT Pro XTension and saves that copy on your master diskette. Should your original XTension become damaged, erased or removed, all you need do is drag the backup copy from your master diskette and drop it in the original XPress folder.

Do not, under any circumstances, erase this backup copy from the master diskette, place any additional files on the master diskette or in any way tamper with the master diskette. Should you do so, installation and removal may no longer work and Managing Editor Software, Inc., will not be liable for the consequences.

Instead, once installation is complete, place your master diskette in a safe location and return your registration card immediately to Managing Editor Software so that you will be eligible for XTension updates and other offerings from MES.

System Requirements

This version of MEXT Pro functions with QuarkXPress version 3.1 and later.

MEXT Pro Files

In addition to MEXT Pro XTension itself, a special file called MEXT Pro.PRF is created the first time you use MEXT Pro.

This file contains all the information MEXT Pro uses to locate files and directories on your hard drive or network. If you should accidentally delete this file from your hard disk, you will lose all the information you have created for your Gather Sets.

In this case, MEXT Pro will create a new preferences file, but it will contain none of the old information you have set up.
MEXT Pro file icons

Installer Icon: This icon represents MEXT Pro Installer.

Installer Data: This icon represents the file MEXT Pro Installer uses to create your XTension.

MEXT Pro XTension: This icon represents a Quark XTension and will show up in your Quark folder after installation.

Page Director Series Files

If you own copies of Managing Editor Software’s Page Director Series applications, files can be read into QuarkXPress using the Managing Editor XT Pro. Manuals documenting the proper use of the XTension to import Page Director Series files are bundled with the applications.
New Features to MEXT Pro 2.0:

• Import Fetch™ or Search™ file references and thumbnails.
• Receive Fetch™ or Search™ AppleEvent file references.
• Fetch™-like or Search™-like 'Light table' view of items as thumbnails.
• Menu launching of Fetch™ or Search™.
• Auto captioning (preference settable) of pictures if text resource is present.
• Cameo view of preview resources.
• Import of Page Director® Editorial, Classified and Advertising Layout System issues.
• Show text thumbnails (shows beginning of text block).
• Optional/selectable greeking of text and graphics thumbnails.
• Zoomable windows.
• Auto zoom-down when placing from thumbnail view.
• Optional/selectable grouping of caption/graphic.
• Display of keywords in thumbnail view
• "Find by keyword," and "Find again by keyword" functions.

All functions are explained in the following chapters of this MEXT Pro 2.0 manual.
Installing Your XTension

Your copy of the Managing Editor® XT Pro 2.0 must be installed from the master floppy diskette that came with your Managing Editor® XT Pro 2.0 XTension package when it was shipped to you — it cannot be installed from a hard drive or another diskette.

Each copy of the Managing Editor® XT Pro 2.0 is “serialized” against your copy of QuarkXPress® during the installation process and, thereafter, will only work with the copy of QuarkXPress that has that same serial number.

As back-up protection, the Installer creates a copy of the Managing Editor® XT Pro 2.0 XTension on your master floppy diskette. If at any time your Managing Editor® XT Pro 2.0 XTension becomes damaged or accidently erased, you can simply drag this copy to your QuarkXPress folder to restore the Managing Editor® XT Pro 2.0. Again, this copy will only work with the QuarkXPress whose serial number is the same as the one located during the installation process.

Whenever you receive a QuarkXPress update, or if you want to install the Managing Editor® XT Pro 2.0 with a different version of QuarkXPress, you must first use the Installer to remove the original Managing Editor XT or Managing Editor XT Pro. This is necessary because the Installer remembers how many times it has been used for installation and, depending on your licensing agreement, will only allow as many installations of the Managing Editor® XT Pro 2.0 as specified in that agreement.

These protections are built in to the Installer to protect as best as possible from unauthorized duplication of the Managing Editor XTension. They are designed to be non-intrusive for legitimate users of the Managing Editor® XT Pro 2.0.

Installing the MEXT Pro 2.0

To install the Managing Editor® XT Pro 2.0, follow these simple steps:

• Insert your Managing Editor® XT Pro 2.0 Installer diskette into the internal floppy disk drive and double-click on its disk icon to open the disk’s window. (Make sure the floppy diskette is not locked).

• Locate the file icon named “Managing Editor® XT Pro 2.0 Installer” and double-click the icon to launch the installer program.
Removing MEXT Pro 2.0

There may be a time when you want to remove your copy of the Managing Editor® XT Pro 2.0 from the QuarkXPress folder in which it is currently stored and use it with another copy of QuarkXPress whose serial number is different from the original.

To do so, follow these simple steps:

• Insert your Managing Editor® XT Pro 2.0 Installer diskette into the internal floppy disk drive and double-click on its disk icon to open the disk’s window. (Make sure the floppy diskette is not locked).

• Locate the file icon named Managing Editor® XT Pro 2.0 Installer and double-click the icon to launch the installer program.

• You will see a dialog asking whether you want to Install or Remove Managing Editor XT Pro. Right now, only the Remove button is active — the Install button is dimmed because you have previously installed a copy of the Managing Editor® XT Pro 2.0.

• Click the Remove button.

• The installer will ask you to locate your copy of the Managing Editor® XT Pro 2.0. Use the file dialog to navigate your hard disk until you find the Managing Editor® XT Pro 2.0 XTension you installed during the installation process. Double-click on its name in the file dialog list.

• The Managing Editor® XT Pro 2.0 will begin the removal process.

• When removal is complete, you will see an alert box that informs you of the removal success. You are now free to install the Managing Editor® XT Pro 2.0 with the same or a different copy of QuarkXPress.

Should you experience any errors during removal, follow the instructions displayed in the error alert messages. If you still experience problems, please call Managing Editor Software at (215) 886-5662.
Using the Managing Editor XT Pro

step-by-step instructions in your new XTension's use

Now that you've installed the Managing Editor XT Pro, go to your copy of QuarkXPress and double-click on its icon to launch that program.

If there have been any errors in the installation process, or if the serial number in Managing Editor XT Pro does not match that of the QuarkXPress you are opening, you'll receive an appropriate message and should respond accordingly.

Opening Managing Editor XT Pro Palette

To display Managing Editor XT Pro, go to Quark's View Menu and select “Show Managing Editor XT.” Managing Editor XT Pro Palette will appear, looking like the as shown below.

You may position the palette anywhere within your QuarkXPress workspace — its location and whether or not the palette is opened or closed are remembered each time you leave QuarkXPress and will be restored when you restart the program.

The palette window can be dragged and resized in standard Macintosh fashion. When it is open on screen, the XPress View Menu option changes to read “Hide Managing Editor XT Pro.” You can close the palette either by selecting this option or by clicking in the palette's close box located in its title bar.

To quickly move Managing Editor XT Pro from one side of the QuarkXPress workspace to another, you can hold down your option key and click anywhere in Managing Editor XT Pro palette. The palette will be redisplayed on the opposite side of the screen at the same vertical height, collapsed to its smallest size. This
Palette elements

The top area of the palette is called the Control Bar and contains the controls you use to change Managing Editor XT Pro options and perform different actions.

Beneath the Control Bar is Managing Editor XT Pro's Editing Bar, where you can rename different Managing Editor XT Pro Sets and obtain information about files and folders.

Below the Editing Bar is the Gather List which displays different lists of elements depending upon the current view. Beside the Gather List is a scroll bar that can be used to move up and down within the list if all its elements are not visible.

The control bar

The Control Bar includes several items:

• Current View Icon: At the far left is the Current View icon which changes depending on the view you have selected using Managing Editor XT Pro's View Menu. Right now you should be looking at Sets View.

• Alerts Checkbox: The box marked Alerts is used to turn Managing Editor XT Pro's alerting feature on and off. When the box is checked, as it should be now, you will receive warnings whenever you are about to undertake an action Managing Editor XT Pro wants you to think about first. As you become more accustomed to the XTension, you might want to turn this feature off.

• Keys Checkbox: The box marked Keys is used to turn Managing Editor XT Pro's extended key set on and off. When checked, Managing Editor XT Pro will "intercept" your XPress keystrokes and determine whether they should be used by Managing Editor XT Pro or by XPress. For instance, when Keys are on and you press the cursor down key, Managing Editor XT Pro will scroll down one selection in any of its lists. With keys off, XPress will handle this keystroke instead. A full list of Managing Editor XT Pro's extended key set is included at the end of this manual.

• Trash Can: The trash can is where you dispose of any items in any of Managing Editor XT Pro's lists. If you no longer want to keep a Gather Set, Gather Folder or an item, you can drag it to the Trash, release the element and it will be permanently removed. When Alerts are turned on, Managing Editor XT Pro will always ask whether or not you want to delete the item.